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Listed below are the system requirements for using Wasp Labeler.

	Computer/Processor
	 Pentium II 600 MHz or better



	Memory
	 512 MB of RAM

	Hard Disk


	50MB

	Drive
	 CD-ROM



	Mouse
	Required

	Keyboard 
	Required

	Operating Systems


	 Windows 2000 SP4, XP SP2, 2003 Server (32 bit only) and Vista (32 bit)
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· Wasp Technical Support, Knowledge Base and Downloads - This link will lead you to the online support center, where you can contact us.
·  Wasp Barcode Online Store - This link will lead you to the online store.
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Wasp Labeler is a professional label generation application designed to meet the most demanding bar code labeling and printing requirements. Create and print bar code labels to any local or network Windows printer. Import data directly from your corporate databases or create a new Microsoft Access database. Easily generate bar code labels, asset or inventory labels, address labels and envelopes with PostNet Zip Codes, ID badge labels, business checks, and date and time stamps for perishable goods. In addition, Wasp Labeler can generate compliance labels for practically every industry. The Wasp Labeler features include:

- Supports Code 39, Code 128 A, 128 B, 128 C, UCC 128, Code 93, Interleaved 2 of 5, UPC-A, UPC-E, EAN/JAN-8, EAN/JAN-13, Codabar, MSI Plessey, PostNet, ISBN, RSS, MicroPDF417 and ITF14 bar codes
- Prints the most popular 2D bar codes (PDF417, MaxiCode, and Data Matrix)*
- Supports any laser, dot matrix, thermal, or ink jet printer using a standard Windows printer driver

- Natively supports Zebra (ZPL) and Eltron (EPL) printer languages**

- Edit multiple labels concurrently
- Input data from the keyboard at print time
- Advanced graphic resizing and image rotation
- Import BMP, TIF, WMF, PCX, DCX, JPG, CMP, PCD, FPX, PSD, PNG, TGA, EPS, RAS, WPG, and PCT images
- Import any ODBC, Microsoft Access, Paradox, or dBase database***

- Import text files or Microsoft Excel worksheets***

- Import data from QuickBooks® (version 2002 and later)

- OCR-A and OCR-B TrueType Fonts included for use with Optical Character Recognition applications
- MICR TrueType Font included for printing business checks
- Auto increment/decrement numbers with serialization feature
- Includes over 100 label layout templates
* - Requires the 2D version of the product
** - Requires Thermal Printer Language version of the product

*** - Not available in the Wasp Labeler Special Edition for QuickBooks® Users version of the product

Wasp Labeler supports several drawing objects including text, lines, rectangles, ellipses, and bar codes. Each of these drawing objects has full edit capabilities. The draw style, size, position, and color are some of the edit properties. In addition, practically any picture can be imported onto the label design, linked to the original file, or retrieved from a database. An Object Properties box presents the properties of each object to the user and allows precision sizing and positioning of each object.
Wasp Labeler supports multiple Sources for Text and Bar Code Objects. The application supports Static, Serialization, Prompt at Print Time, External Data Source, Bind to Another Object, and Date/Time. The 'Prompt at Print Time' feature is used to interactively enter information onto the label at print time. The 'External Data Source' feature allows you to import, view, and edit information from the most common databases and allows your Text and Bar Code objects to retrieve their source value from an external file. In addition, Wasp Labeler provides the capability to quickly create your own Microsoft Access database. For additional information on creating your own Microsoft Access Database, see the External Data Source - Create New topic.
You can also start the Wasp Labeler application from the "Run Command" or Command Line. See the Command Line topic for further information.
 XE "Product Activation " \* MERGEFORMAT Product Activation

In addition to the installation key provided to you for product installation, Labeler also requires an activation key. Labeler must be activated within 30 days of installation. If Labeler has not been activated within 30days, the following message will display upon start-up:
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To obtain your activation key:

Step 1. Click the Register button or go to www.waspbarcode.com/register/register.asp.

The registration page displays in your browser.

Step 2. Complete the registration page that displays and click Submit.

Your registration key will be emailed to you. Simply copy and paste the key into the Enter Activated Key field and click OK. Labeler will be activated and the program will open. No further actions are required.
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This topic contains information to assist you with the easiest way to begin creating new labels.
Step 1. Open the Wasp Labeler application.
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The Labeler's Welcome screen appears.

You may choose to create a new label file in one of several ways:

· Use the Label Wizard option which will help you build and configure your new label using step-by-step instructions.

· Open a Label Example file as a starting point for your label design.

· Create a new Blank Label file and build your label manually.

· Open an existing label file from the Welcome screen.

Step 2. For the easiest way to create a new label, select the 'Label Wizard' option on the Welcome screen.

Note: If the Welcome screen is not open, you can open the Label Wizard by selecting the [image: image3.png]


 icon on Labeler's main window. You can also select 'File | Run Label Wizard’ or 'File | New'.

The Label Wizard will walk you through the label creation process. For information on how to use the Label Wizard, refer to the Label Wizard help topic.
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Wasp Labeler requires a Page Setup for every label. When a new label is created, Wasp Labeler will automatically prompt the user for the Page Setup. Page Setup can be accessed from the File/Page Setup pull down menu. Page Setup displays the 'Layout' and 'Printer Setup' information required for the label file that is open. The default printer will be selected if the 'Printer Setup' is not modified. Once the Page Setup has been specified, the user can create custom labels.
Menu Options
Listed below are pull down menus for Wasp Labeler. The pull-down menus identify the major divisions of the software and all the available options. The Standard, Alignment, Formatting, and Toolbox toolbars provide direct access to the menu items using buttons for the commands that are used most frequently.
File
Edit
View
Insert
Format
Tools
Data
Window
Help


Standard Toolbar
The Standard toolbar provides direct access to the most common menu items from the File, Edit, and View menu options. The Standard toolbar includes:
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 Lock (Edit/Lock)
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 Label Wizard (File/Run Label Wizard)
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 New (File/New)
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 Open (File/Open - Ctrl+O)
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 Save (File/Save - Ctrl+S)
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 Print (File/Print - Ctrl+P)
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 Print Preview (File/Print Preview)
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 Page Setup (File/Page Setup - F8)
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 Cut (Edit/Cut - Ctrl+X)
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 Copy (Edit/Copy - Ctrl+C)
[image: image14.png]


 Paste Object (Edit/Paste Object - Ctrl+V)
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 Undo (Edit/Undo - Ctrl+Z)
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 Redo (Edit/Redo - Ctrl+Y)
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 Help (Help/Contents)
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 Zoom In (View/Zoom)
[image: image19.png]


 Zoom Out (View/Zoom)
 Magnification Level (View/Zoom)


Alignment Toolbar
The Alignment toolbar provides direct access to the most common Edit menu items. The Alignment toolbar includes:
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 Bring to Front (Edit/Bring to Front - Ctrl+J)
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 Send to Back (Edit/Send to Back - Ctrl+K)
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 Align Top (Edit/Align)
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 Align Bottom (Edit/Align)
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 Align Left (Edit/Align)
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 Align Right (Edit/Align)
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 Center Horizontally (Edit/Center)
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 Center Vertically (Edit/Center)
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 Center Both (Edit/Center)
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 Space Across (Edit/Space)
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 Space Down (Edit/Space)
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 Rotate Clockwise (Edit/Rotate)
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 Rotate Counter-clockwise (Edit/Rotate)


Font Toolbar
The Font toolbar provides a convenient way of modifying a few of the most common properties for Text and Bar Code objects. Locate the 'Font' property for each of these objects for further information. In addition, the Font toolbar provides a way of modifying the 'Color' and 'Draw Width' properties for Text ('Color' only), Bar Code ('Color' only), Lines, Rectangles, and Ellipses. The Font toolbar includes:

 Font Style Property (see Text or Bar Code objects)
 Font Size Property (see Text or Bar Code objects)
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 Bold Property (see Text or Bar Code objects)
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 Italic Property (see Text or Bar Code objects)
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 Underline Property (see Text or Bar Code objects)
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 Left Justify Property - Ctrl+L (see Text or Bar Code objects)
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 Center Justify Property - Ctrl+E (see Text or Bar Code objects)
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 Right Justify Property - Ctrl+R (see Text or Bar Code objects)
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 Color Property (see Text, Bar Code, Lines, Rectangles, or Ellipse objects)
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 Draw Width Property (see Text, Bar Code, Lines, Rectangles, or Ellipse objects)


Toolbox Toolbar
The Toolbox toolbar provides direct access to the Insert and Format menu items. The pointer is used to select an object. The Toolbox includes:
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 Text (Insert/Text)
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 Bar Code (Insert/Bar Code)
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 Line (Insert/Line)
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 Rectangle (Insert/Rectangle)
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 Ellipse (Insert/Ellipse)
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 Picture (Insert/Picture)
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 Object Properties (Format/Properties - F4)
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 Object Source (Format/Source - F6)
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Step 1. To create a new label, select the 'Blank label' option on the Welcome screen, or select the 'File | New' menu on the Labeler's Main window.
Step 2. To choose the proper layout for the label and the proper printer, select the 'File | Page Setup' menu on the Labeler's Main window.
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Step 3. The Layout tab on the Page Setup window is used to choose or customize the layout and size of the label template. The most common layouts have been predefined for you using the 'Layout Template' feature. Use the 'Family' and 'Type' to specify the label template. To create a custom label template, select the 'New' button. You can use the existing layout template as a foundation for creating a new label layout. To modify an existing layout, unselect the 'Lock Edits' check box and answer the subsequent questions, then modify the appropriate settings while noting the changes in the Preview area on the right of the window.
Note: Notice that the dotted line shown along the edges of the Preview area denotes the unprintable margin for the currently selected printer.
Step 4. Select the 'Printer Setup' tab on the 'Page Setup' window to change the desired printer.
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Step 5. Choose the desired printer's name from the dropdown list, while also noting the other settings shown in the window. When any of these settings are changed, notice the visual changes in the Preview area so that you can ensure that the selected printer's Page Size works well with the Layout. For additional printer settings supported by the current printer's printer driver, select the 'Setup' button. When complete, select the 'OK' button on the Page Setup window. Now, you are ready to add Objects to your newly created label.
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Step 6. To add Objects to the label design, select one of the Object types from the ToolBox on the left side of the Main window.
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For this example, select the ToolBox button that looks like a bar code. Once the bar code button from the ToolBox has been selected, position your mouse over the label design area and click the left mouse button to create a new Object on the design area. At this point, you should see the newly added Object with the Object Name of 'BarCode1'.
Note: For lines, rectangles, ellipses, and pictures, click the left mouse button and drag to specify the height and width of the new Object.
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Step 7. Now that you have added the BarCode1 object, notice that the bar code is selected This is denoted by the dots that appear on the perimeter of the bar code object. After the initial insertion, you now may type in the entry field to change the value of the bar code. Once you have changed it to the desired value, hit the Escape key, the F2 key, or click the mouse anywhere over a blank area in the label for the changes to the object to take place.

Note: Objects can be moved around in the preview area using the keyboard's up, down, left, or right arrow keys. The Ctrl (Control) key can be used in conjunction with the arrow keys to move the object in larger increments.

Step 8. To edit the value for a BarCode or Text object, select the object with the left mouse button - notice that the selection dots will now appear to indicate that the object is selected. Keeping the mouse in position over the selected object, use the right mouse button to show a pop up menu for the selected object. Select the 'Edit Static Value' pop-up menu and you will be able to edit the static value of the object the same way it was accomplished in Step 8. (For faster Static Value editing, select the object, then hit the F2 key.) 
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Step 9. In addition, notice that by using the right mouse pop-up menu as noted in Step 9, you can also bring up the 'Properties' box and the 'Source' window for the selected object.
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Step 10. Bring up the 'Properties' box for an object by selecting the objects with the left mouse button and using the right mouse pop-up 'Properties' menu choice. (You may also use the 'Format | Properties' menu choice on the Main window to accomplish this as well, or use the F4 accelerator key.)
Step 11. For each object type, the 'Properties' box will contain most of the common attributes and settings for the given selected object. (The 'Properties' box serves as a floating window. You need not close it. If you wish, simply move it out of the way or to the side of your screen). Draw Style, size, position, and color are some of the edit properties. To edit any of the attributes, choose the appropriate 'Properties' tab, and then click the mouse in the text area of any one of the property fields. When changing the attributes within the Properties box, notice that you easily see your changes reflected in the label design area.
Step 12. For easy selection of any other object, notice that there is also a dropdown box at the top of the Properties box that allows you to select a given object by name.
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Step 13. For Text and BarCode objects, advance features exist for setting and/or getting the source value for the object. These features are accessible via the Object Source window. To bring up the 'Object Source' window for an object, select the object with the left mouse button and choose the right mouse pop-up 'Source' menu choice. (You may also use the 'Format | Source' menu choice on the Main window, or the F6 accelerator key).
Step 14. The 'Source' window for Text and BarCode objects allow great flexibility in determining what the value for the object is to be at print time. Text and BarCode objects support Static, Serialization, Prompt at print time, Date/Time, Bind to another Object, and External Data Source values for creating and placing specific information onto the label. As an exercise, select each one of the options for the source, and note the attributes of each in the area at the bottom of the Source window. Make your selections, then click the 'OK' button to save the changes to the object and to dismiss the Source window.
Step 15. You are now ready to run your first label print job.
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Step 16. To print your label or to review what it will look like, select either the 'File | Print' or the 'File | Print Preview' menu on the Labeler's main window.
Label Wizard
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The Label Wizard is the easiest way to quickly create and print labels! The Wizard provides step-by-step instructions on each of the major topics while it helps you to configure your label layout, choose a printer, design the objects that appear on the label, choose an external data source, and to also save, preview and print your label.
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To navigate to the next screen in the Wizard, click the Next button [image: image59.png]HNext >




at the bottom of the window. To go back to a previous Wizard screen, click the Back button. [image: image60.png]



The Label Wizard can assist you if you need help creating a new label design. To create a new label file, select the "File | New" menu choice on the main window’s menu and you will be prompted with the following question.
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For existing label files, the Label Wizard can also be launched at any time. If a label file is already open in the Labeler application, then select the "File | Run Label Wizard" menu choice from the main window to launch the Label Wizard for the currently open label file. If a label file is not already open, selecting the "File | Run Label Wizard" menu choice will create a new label and then launch the Label Wizard.
Please note that while the Label Wizard is running, the label is being built for you in the background on the Labeler’s main window workspace. To see this in action while the Label Wizard is running, drag the Label Wizard window aside to see what is going on in the white workspace on the Labeler’s main window.
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The tabs shown on the right side of the Label Wizard divide the steps in the label configuration process into six major sections. The tabs listed across the top of the Label Wizard serve as subdivisions for each major tab.
Clicking the Next button will cause the Label Wizard to automatically navigate to the next screen in the process. At any time, you may also click the Back button to return to the previous step.
To skip ahead or skip backwards in the configuration process without using the Next or the Back buttons, click directly on the desired tab. You may also exit the Label Wizard at any time by clicking the Exit Wizard button. Selecting the Exit Wizard button will return you to the Labeler’s main window where you can continue to manually configure your label design.
To return to the Label Wizard at a later time, select the "File | Run Label Wizard" menu choice from the Labeler’s main window.
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The Labeler application includes a set of example labels that come prepackaged as part of the installation. These examples serve as a quick demonstration of various Labeler features.

[image: image65.jpg]2% Brample Label Files
s

(AddressLAB
(Address1 LAB

(Address2 LA

AddSeni AR

(AddTab LAB

AIAG.LAB

Badge LAB

Coupon LiB

CTIALAE

Disks LAB

EIASSEA, LAB

EntyFim A8

HIRCLb LAE

ID_Badge A8

Item_ LbILAB

Nultion LA8

Postcad LB
DuickBooks®_Add3LAB
DuickBooks® CustomerBiladciess
uickBooks®_ CustomerShipadde
QuickBooks® Employeedddress. L.
uickBooks®_ID_Badge AR
QuickBooks®.InvaiceBillddress.L
QuickBooks®.InveiceShipacess
QuickBooks®.tem_LbLLAB

Preview:

John Doe

123 Mai
Metrop

Street
ST 999999999

ACME

AGHE Supply Company
1234 Tndagriel B,
Qereland, O 44101

Descipton for Addi3 LAB'

Contains an exsmpl to address US Mal It demonstates the use of Postnet bar «
ades, Binding an Obiscts vale o another Dbiect, static graphics. and the

use of SubStings and Eternal Data Sowice fes.

pen Cancel





Choosing an example label in the Label Wizard is a good starting point for your label design. Review the descriptions in the list of example labels and choose one that most demonstrates your given needs. If you don’t find an example that fits your needs, then simply skip this section and the Label Wizard will help you continue building your label.
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The Page Setup section in the Label Wizard allows you to select which printer to use for printing your labels, plus which label layout to use.
 

By definition, labels are printed on label stock. Commercial label stock of all types is readily available. Each type of label stock has its own set of sizing and spacing characteristics. For example, a given layout for a return address label might include 4 labels across and 20 labels down the page for a total of 80 labels per page. Label stock for some specialized bar code printers are usually on a continuous roll, fed one at a time. This type of label stock likely contains a Layout of 1 label across and 1 label down the page. A 1 by 1 Layout is also sometimes referred to as a "1-Up" Layout.
 

The Labeler application calls these sizing and spacing characteristics the label Layout. You may choose from a set of predefined label Layouts, or you may create a new custom label layout.
 

Click the Next button to go to the next page in the Label Wizard in order to select a printer and label Layout.
 

For more detailed information on Page Setup, see the Page Setup help topic.
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The settings for the currently selected printer and label Layout are shown on this page. The preview frame shows a sample of what the currently selected Layout looks like when superimposed on the currently selected printer’s page.
 

You may independently change the printer and/or change the Layout. However, the two settings are related in that the chosen Layout normally needs to fit properly on the selected printer’s page definition. The existence of dotted lines on the preview image represent the unprintable margin that exists for the current printer’s page. Normally, one chooses a Layout (or creates a custom Layout) that does not overlap any portion of the unprintable margin for the given printer. Such a condition will produce a warning message, but you are not precluded from being able to design and print labels under these conditions.
 

To change the selected printer or the selected Layout, click the Page Setup button.
 

For more detailed information on the Page Setup window, see the Page Setup help topic.
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The Labeler application includes the capability to extract data from external data sources. The extracted data then serves as the source data for Text and Bar Code objects appearing on the label. If you do not want to extract data from an external data source, then this section in the Label Wizard may be skipped.
For example, a given company might have inventory information stored in a database (Microsoft Access or Excel, any ODBC compliant data source, a delimited text file, or even in QuickBooks®) from which inventory labels with bar codes are produced. Another example might be that a company needs to print mailing labels for their customers where the customer address information is stored in an external data source. In either case, the Labeler application can easily access the data from the external data source and apply it to the label.

The External Data section in the Label Wizard will help you to configure the external data source so that the Labeler application knows how to access the data from the external source. Once this is accomplished, you can then add Text and Bar Code objects to the label design and map them to a given column from the data source so that the Text and/or Bar Code object will contain the external data at print time.
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Labeler for use with QuickBooks® Only Product
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The Type, File and Table settings are shown for the current External Data Source. To configure these settings for the first time, or to change these settings, click the Data Source button in order to display the External Data Source dialog window.
Labeler for use with QuickBooks® Only Product
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In the QuickBooks® only version of the product, the external data source is automatically configured for QuickBooks® and only requires that you select which table in QuickBooks® that you wish to extract data from.
For detailed information on each of the available QuickBooks® tables shown in the dropdown list, see the QuickBooks® Support help topic.
To view the QuickBooks® data from the selected table, click the View Data button to display the External Data Source - View and Edit dialog window.
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A key to building your label design is knowing how to add objects to the label. This section in the Label Wizard will assist you in adding Text and Bar Code objects to your label, and optionally mapping those objects to data from your external data source. Additionally, you can also add graphics (rectangles, ellipses, lines and pictures) to the label.
 

Once objects exist on the label design, you will also need to position them so that the label looks appropriate when printed.
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This section helps you add Text and Bar Code objects to the label.
 

Click the Add Bar Code or Add Text buttons to add new bar code and text objects to the label. You will be prompted to configure the source and/or value for the new object. See the Object Source dialog window for more information on all of the options associated with Text and Bar Code objects.
 

For existing objects, click the Edit button to change the object’s source and/or value. Click the Delete button to delete an object from the list.
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Besides Text and Bar Code objects, the Labeler application also supports graphics objects (rectangles, lines, ellipses and imported picture files).
 

Add graphics objects to the label using the Toolbox located in the Labeler’s main window. A sample of the Toolbox is shown above in the Wizard’s window.
 

To temporarily leave the Label Wizard in order to add graphics objects to the label at this time, click the Add Graphics Objects button. This action will cause the Label Wizard to be minimized. To return to the Label Wizard, click the Resume Label Wizard button on the minimized window.
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All object types support a list of properties that relate to the given object type. For example, Text objects have properties like font, font size, color, etc. Bar Code objects have properties like bar code symbology, bar code caption font, etc. In addition to these properties, each object has position properties that define where a given label object appears (i.e. properties like Top, Left and in some cases Width and Height).
The Label Preview frame shows a representation of the current label design including all of the currently existing objects and where they appear on the label design.
To temporarily leave the Label Wizard in order to set object properties and position objects on the label, click the Properties button. This will cause the Label Wizard to be minimized. To return to the Label Wizard, click the Resume Label Wizard button on the minimized window.
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To view the properties for a given object, click on the object to select it. (When an object is selected, small selection dots appear around the border of the object.) Then, select the "Format | Properties" menu choice from the Labeler’s main window and the Properties dialog window will appear for the selected object.
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This final section in the Label Wizard summarizes the progress for each of the major steps involved in configuring your label design. The list of four check boxes at the top of this page denote the completion of each individual step. If the box is checked, then that step is complete. You may jump directly to any step by clicking on one of the links.
 

To save your label design to disk, click the Save button. If the label design has never been saved before, you will be prompted to provide a folder and filename for where to store the label file.
 

To see what the label design will look like when printed, click the Print Preview button. You may also initiate a print job by clicking the Print button.
QuickBooks Support

 XE "Time " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Table " \* MERGEFORMAT 

 XE "State " \* MERGEFORMAT 

 XE "Source Types " \* MERGEFORMAT 

 XE "SalesTaxCode " \* MERGEFORMAT 

 XE "SalesRep " \* MERGEFORMAT 

 XE "SalesReceipt " \* MERGEFORMAT 

 XE "Representatives " \* MERGEFORMAT 

 XE "Quickbooks® " \* MERGEFORMAT 

 XE "PurchaseOrder " \* MERGEFORMAT 

 XE "PayrollItemWage " \* MERGEFORMAT 

 XE "PaymentMethods " \* MERGEFORMAT 

 XE "Master Card " \* MERGEFORMAT 

 XE "ItemService " \* MERGEFORMAT 

 XE "ItemSalesTaxGroup " \* MERGEFORMAT 

 XE "ItemSalesTax " \* MERGEFORMAT 

 XE "ItemPayment " \* MERGEFORMAT 

 XE "ItemOtherCharge " \* MERGEFORMAT 

 XE "ItemNonInventory " \* MERGEFORMAT 

 XE "ItemInventory " \* MERGEFORMAT 

 XE "Help " \* MERGEFORMAT 

 XE "F9 " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "Employee " \* MERGEFORMAT 

 XE "Databases " \* MERGEFORMAT 

 XE "CustomerType " \* MERGEFORMAT 

 XE "CustomerShipAddress " \* MERGEFORMAT 

 XE "Customers " \* MERGEFORMAT 

 XE "CustomerBillAddress " \* MERGEFORMAT 

 XE "Customer shipping address " \* MERGEFORMAT 

 XE "Customer represents " \* MERGEFORMAT 

 XE "Customer billing address " \* MERGEFORMAT 

 XE "CreditMemo " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Bar Codes " \* MERGEFORMAT QuickBooks® Support

The ability to access data stored in QuickBooks® is provided by the Wasp Labeler application only  for QuickBooks® 2002 and later versions. If you purchased the ‘Labeler for use with QuickBooks® Only’ product, then your version of the Labeler application only supports QuickBooks® as an available external data source. Full-featured versions of the Labeler application include QuickBooks® and also a long list of other possible data sources. To learn more about the external data sources available in the full-featured version of Labeler, see the External Data Source help topic. 

Note: For all data previews, a maximum of 200 records are fetched from QuickBooks®.  For View Data (F9), Print Preview and Print, all records are fetched.

The QuickBooks® application must be running with the desired company file open in order for the Wasp Labeler to connect to QuickBooks®. The procedure for retrieving QuickBooks® data is to create an External Data Source with a database type of QuickBooks®. (If your Labeler application is the ‘Labeler for use with QuickBooks® Only’ product version, then this step is automatically accomplished by the application and no additional action is required on the part of the user.) Select from the list of available QuickBooks’® tables to extract data for your label.
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As shown above, Wasp Barcode Labeler Special Edition for QuickBooks® Users as a fixed Source Type of QuickBooks® 2002/2003 within the External Data Source Wizard.
When you click Next to advance to Table selection, Labeler will present this popup to remind you to start QuickBooks® before proceeding further:

[image: image80.jpg]2 Connecting to QuickBooks® =3

The Labele i ready to extact data from QuickBooks®. Flease
ensure tha the QuickBooks® applcation i nstaled and i unning.

s soon s you dsmiss this window, QuickBooks® may prompt you
with a dialog windo thatlocks simiar o this:

b

] e -

You may have o select the QuickBooks® icon from the Windows.
taskbat inorder forthe GuickBooks® window to appear.

™ Danitshaw this eminder again





Click OK only if QuickBooks® is running.
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Select the Tables from which you intend to pull data for your label design, then click Next to advance to Data Column Selection.



Available QuickBooks® Tables

Account - The Account table contains a company’s list of accounts. 
Bill - The Bill table contains a company’s list of bills. A bill indicates that a QuickBooks® user owes money to a vendor.
Check - The Check table contains a company’s list of checks. The list includes all the types of checks you can create in QuickBooks®, including paychecks, bill payment checks, and payroll liability checks as well as the checks created with the Write Checks window.

CreditMemo - The CreditMemo table contains a company’s list of credit memos. A credit memo reduces a customer’s outstanding balance if, for example, the customer has returned something, cancelled a sale, or over paid.
Customer - The Customer table contains a company’s list of customers. Custom fields are supported for this table.

CustomerBillAddress - The CustomerBillAddress table contains non-duplicated customer billing address information. This is useful for creating address labels intended for a customer’s accounting department.
CustomerShipAddress - The CustomerShipAddress table contains non-duplicated customer shipping address information. This is useful for creating address labels intended for a customer’s warehouse.
CustomerType - The CustomerType table contains a list of a company’s customer types. Customer types allow the business owner to categorize customers in ways that are meaningful for their business. For example, customer types might indicate which industry a customer represents or a vendor’s geographical location.
Employee - The Employee table contains the list of the employees that work for the company.  Custom fields are supported for this table.

Estimate - The Estimate table contains a company’s list of estimates. A QuickBooks® estimate is a description of a sale that the QuickBooks® user proposes to make to a current or prospective customer.

Invoice - The Invoice table contains a company’s list of invoices. An invoice transaction records the amount owed by a customer who purchased goods or services but made no payment (or made only a partial payment) at the time of the sale.
ItemInventory - The ItemInventory table contains a company’s list of inventory items. An inventory item is any merchandise or part that a business purchases, tracks as inventory, and then resells. The ‘Name’ column from the ItemInventory table is the column where QuickBooks® stores the ‘Item Name/Number’ data. If you store unique item numbers in this QuickBooks® field, then the ‘Name’ column is the column you need to use in order to map Text and Bar Code objects’ source.  Custom fields are supported for this table.

ItemNonInventory - The ItemNonInventory table lists a company’s non-inventory items. A non-inventory item is any material or part that a business buys but does not keep on hand as inventory.  Custom fields are supported for this table.

ItemOtherCharge - The ItemOtherCharge table lists a company’s "Other charge" items. "Other charge" items are miscellaneous charges that do not fall into the categories of service, labor, materials, or parts. Examples include delivery charges, setup fees, and service charges.  Custom fields are supported for this table.

ItemPayment - The ItemPayment table lists a company’s payment items. A payment item is used when a partial payment is received at or before the time an invoice or statement is created. The payment item then reduces the amount owed on an invoice.  Custom fields are supported for this table.

ItemSalesTax - The ItemSalesTax table lists a company’s sales-tax items. A sales-tax item is used to calculate a single sales tax that is collected at a specified rate and paid to a single agency.  Custom fields are supported for this table.
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   The ItemSalesTax table is not used in the Canadian version of QuickBooks®.

ItemSalesTaxGroup - The ItemSalesTaxGroup table lists a company’s sales-tax groups. A sales-tax group item is used for calculating two or more sales taxes grouped together and applied to the same sale. For example, local and state taxes could be tracked separately but applied to a sale as one tax.  Custom fields are supported for this table.
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   The ItemSalesTaxGroup table is not used in the Canadian version of QuickBooks®.

ItemService - The ItemService table lists a company’s service items. A service item refers to services that a business sales or purchases.  Custom fields are supported for this table.

JobType - The JobType table lists all of a company’s valid job types. Job types can be used to separate jobs into categories that are meaningful to the business.
OtherName - The OtherName table lists a company’s "other names". In QuickBooks®, "other names" are those that do not appear in the customer list, vendor list, or employee list.

PaymentMethods - The PaymentMethods table lists all of the methods of payment that the company supports: for example, cash, check, or Master Card.
PayrollItemWage - The PayrollItemWage table lists all of a company’s payroll wage items. A payroll wage item can be used to determine what type of pay an employee will receive.
PurchaseOrder - The PurchaseOrder table lists all of a company’s purchase orders. 
SalesReceipt - The SalesReceipt table lists all of a company’s sales receipts. Sales receipts are used to record point-of-sale payments. Sales receipts include payments by cash, check, or credit card.
SalesRep - the SalesRep table lists all of the sales representatives for the company. 
SalesTaxCode - The SalesTaxCode table lists the company’s sales tax codes. Each item on a sales form is assigned a sales-tax code that indicates whether the item is taxable or non-taxable, and why.
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 The SalesTaxCode table is not used in the Canadian version of QuickBooks®.

Vendor - The Vendor table lists all of the company’s vendors. A vendor is any person or company from whom a small-business owner buys goods and services.  Custom fields are supported for this table.

VendorAddress - The VendorAddress query contains non-duplicated vendor address information. This query is useful for creating vendor address labels.



Labeler Options Specific to QuickBooks®

Click the links below for more information regarding these QuickBooks® specific options:

Show reminder when connecting to QuickBooks®
Show reminder to refresh QuickBooks® data
 XE "Quickbooks® " \* MERGEFORMAT Multi-Level Responses in Quickbooks®
Labeler provides you with the ability to link information between two tables in QuickBooks®. First level tables that may be used include Invoice, Credit Memo, Purchase Order and Sales Receipt.

Second level tables that may be used include Line Item and Line Item Group.

Note: QuickBooks® must be open on your computer when you perform this procedure.

Step 1. Select Data | Edit Source Data Wizard from Labeler's Main window. 

Step 2. Select QuickBooks® in the Source Type field, then click Next.
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Step 3. In the Available Tables field, select the Top Level  table you want - in this example, Invoice. Then scroll through the list to select the Second Level table you want - in this example, Line Item. Click Next.
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Step 4. To link the Top Level and Second Level tables, in the Data Link Creation screen, select the Advanced button.

Step 5. In this example, the  Top Level list is Invoice. The Second Level list is LineItem.
To link TxnID in the Invoice list  to TxnLineID in the LineItem list, click TxnID.  Holding down the right mouse button, drag it to TxnLineID in the LineItem list. A line displays indicating that the two tables have been linked.  Click OK, then click Next.
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Step 6. Select the columns you want from the Available Columns list (Columns for the Top Level table are listed first. Scroll down to see the Second Level columns). If you want to select all available columns, click the Select All button. Click Next.
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Step 7. The Data Fetching Filter displays. In this filter, you can narrow the criteria for the column you want to select.

· Select Top: This will fetch the first 10, 50, 100, 500, 5000 or all of the columns.
· Transaction Date: You can limit the fetch to only transactions that occurred during a certain time frame. Click the down arrow in the From and To fields to select the desired dates from the calendar.
· Modification Date:You can limit the fetch to only items that were modified during a certain time frame. Click the down arrow in the From and To fields to select the desired dates from the calendar.
· Ref Number: You can limit the fetch to only items that match certain reference number criteria, including reference numbers that start with a certain character or characters; those that contain certain characters; those that end with certain characters, or a sequence (e.g., From 100009 To 1000079).

If you want to apply one of these filters, select the one you want and provide the criteria you want, then click OK. If you do not want to use any of these filters, click Cancel.

Step 8. If you wish to set up filters or sort criteria, see Filtering External Data. Otherwise, click Exit Wizard.
 XE "Quickbooks® " \* MERGEFORMAT Refresh QuickBooks® Data

The menu command Data > Refresh QuickBooks® Data updates the User's previously selected data columns by reading them afresh from QuickBooks®.
A status screen will display while files are being read from QuickBooks®.

A refreshed grid view is presented when the update is complete:
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Click the link below for more information regarding a related QuickBooks® specific option:

Show reminder to refresh QuickBooks® data
Reference Guide

 XE "Wlab32.exe " \* MERGEFORMAT 

 XE "Welcome " \* MERGEFORMAT 

 XE "U " \* MERGEFORMAT 

 XE "Time " \* MERGEFORMAT 

 XE "Sleep.exe " \* MERGEFORMAT 

 XE "Run Command " \* MERGEFORMAT 

 XE "PW " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Parameters Description " \* MERGEFORMAT 

 XE "P " \* MERGEFORMAT 

 XE "Mode " \* MERGEFORMAT 

 XE "Me " \* MERGEFORMAT 

 XE "LAB file " \* MERGEFORMAT 

 XE "L n Prints " \* MERGEFORMAT 

 XE "L n " \* MERGEFORMAT 

 XE "L 10 " \* MERGEFORMAT 

 XE "Help " \* MERGEFORMAT 

 XE "H " \* MERGEFORMAT 

 XE "Command Line " \* MERGEFORMAT 

 XE "C m Prints " \* MERGEFORMAT 

 XE "C m " \* MERGEFORMAT 

 XE "C " \* MERGEFORMAT Command Line

Application Execution
Setting the password for Access Databases
Application Execution

The Wasp Labeler application can be executed from the command line (i.e. Run Command). You must specify the directory where the Wasp Labeler application was originally loaded and the appropriate directory and filename of the LAB file to be opened. Multiple files can be opened using a single command.

Syntax
Wlab32[.exe] [path/filename] [-p] [-l n] [-c m] [-q] [-h] [-?] [-help] [-pw password]

Parameters Description
-p Opens the specified LAB file and prints it. (Note: Only one file can be printed from the command line at a time.)
-l n Prints 'n' labels (optional, default=1). (Note: '-p' parameter required.)
-c m Prints 'm' copies (optional, default=1). (Note: '-p' parameter required.)
-q Launches the application in quiet mode (i.e. does not show the Welcome screen on startup, does not show ‘Objects outside label border’ warning message)
-h Displays a command line help window. (Same as "-?" and "-help".)
-? Displays a command line help window. (Same as "-h" and "-help".)
-help Displays a command line help window. (Same as "-?" and "-h".)
-u Unloads the running Wlab32.exe (i.e., closes the application)

-pw Provides the password for the Access database used by this label (Note: You must use your own password in place of "password")

Example:
C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -u
C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -c 6 -u
C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -l 10 -u
C:\...\Labeler\Wlab32.exe C:\temp\file1.lab C:\temp\file2.lab -u 
C:\...\Labeler\Wlab32.exe -?

C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -pw password

C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -pw password

Note:  In Windows 98 and Me, the command interpreter will not wait for Labeler to exit before executing the next command in a batch file.  A small utility called sleep.exe can be found in the .\Labeler folder which can be used to delay execution of statements following any call to wlab32.exe.  It uses one argument; a numeric value that specifies the number of seconds to wait.  For example:

C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -u
C:\...\Labeler\sleep 10
C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -c 6 -u

C:\...\Labeler\sleep 10
C:\...\Labeler\Wlab32.exe C:\temp\LABfilename.lab -p -l 10 -u

C:\...\Labeler\sleep 10
C:\...\Labeler\Wlab32.exe C:\temp\file1.lab C:\temp\file2.lab -u 

 XE "ITF14 " \* MERGEFORMAT 

 XE "Bearer Bars " \* MERGEFORMAT ITF14

The ITF-14 Traded Unit Case Code is used in the retail sector on outer cases and pallets (traded units). Based on Interleaved 2 of 5, the 14-digit code  is numeric and used to display the unique traded unit number. Bearer bars must be included  in horizontal form for codes printed on labels, and as a full box (with H gauges) when printed directly on corrugated surfaces.

 XE "ISBN " \* MERGEFORMAT ISBN

The International Standard Book Number (ISBN) is a unique machine-readable identification number used to identify books. ISBN is based on an ISO International Standard that was first published in 1972 as ISO 2108. ISO 2108 specifies the basic structure of an ISBN, the rules for its allocation, and the administration of the ISBN system.

EAN and ISBN

The EAN 13 article number is a 13-digit number allocated in the UK by the Article Number Association. It is the number encoded in the EAN 13 barcode and is used on most articles other than books and serials. The final digit of the EAN number is a check digit derived from a calculation of the previous 12 digits. Because the ISBN system was already in place internationally when the EAN 13 system was adopted, the book industry was allocated the prefix 978 as a generic code for use on books regardless of their country of origin. This three-digit prefix is followed by the first nine digits of the ISBN (omitting the final check digit).

 XE "MicroPDF417 " \* MERGEFORMAT MicroPDF417

MicroPDF417 is a multi-row symbology, derived from and closely based on PDF417. It is designed for applications that need improved area efficiency but without the requirement for PDF417's maximum data capacity. A limited set of symbols is available, together with a fixed level of error correction for each symbol size. Module dimensions are user-specified to enable symbol production and reading by a wide variety of techniques.

 XE "Properties " \* MERGEFORMAT 

 XE "Printer " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Optical Character Recognition " \* MERGEFORMAT 

 XE "OCR-B " \* MERGEFORMAT 

 XE "OCR-A " \* MERGEFORMAT 

 XE "OCR " \* MERGEFORMAT 

 XE "MICR " \* MERGEFORMAT 

 XE "Magnetic Ink Character Recognition " \* MERGEFORMAT 

 XE "Font " \* MERGEFORMAT 

 XE "E-13B " \* MERGEFORMAT 

 XE "Bar Codes " \* MERGEFORMAT OCR-A, OCR-B, and MICR Fonts

Wasp Labeler supports OCR-A, OCR-B, and MICR (E-13B) fonts. The fonts can be selected from the Font property of a Text object or the font property of a bar code caption. The font face names are "WASP OCR A", "WASP OCR B", and "WASP MICR" respectively.
 

OCR-A and OCR-B
 

OCR-A and OCR-B are human readable fonts and are used in Optical Character Recognition applications such as remittance processing, point of sale, library circulation/accounting, billing, etc. An OCR reader is required to optically decode the character string. When using OCR-A or OCR-B, we recommend selecting the font size to be 12 points. 
 

NOTE: Most printers do not print at the exact same point size nor do all OCR readers interpret the same way. Therefore, another point size (e.g. 11 pt or 11.5 pt) may be selected for your particular environment.
 

 

MICR (Magnetic Ink Character Recognition) 
 

MICR is commonly used to print checking account information at the bottom of bank checks. Magnetic ink toner (which is commonly available) is required to print the checks. An OCR or MICR reader is required to optically/magnetically decode the character string. When using MICR, we recommend selecting the font size to be 11 points.
 

NOTE: Most printers do not print at the exact same point size nor do all OCR readers interpret the same way. Therefore, another point size (e.g. 10 pt, 10.5 pt, or 11.5 pt) may be selected for your particular environment.
 XE "Symbology " \* MERGEFORMAT 

 XE "RSS " \* MERGEFORMAT 

 XE "EAN.UCC " \* MERGEFORMAT RSS

The EAN.UCC Reduced Space Symbology (RSS) family contains three linear symbologies to be used with the EAN.UCC system. The use of this symbology is intended to comply with the EAN International (EAN) and Uniform Code Council, Inc. (UCC) application guidelines.

EAN.UCC bar code symbols are intended for encoding identification numbers and data supplementary to the identification. The administration of the numbering system by EAN and UCC ensures that identification codes assigned to particular items are unique worldwide and they and the associated supplementary data are defined in a consistent way. The major benefit for the users of the EAN.UCC system is the availability of uniquely defined identification code and supplementary data formats for use in their trading transactions.

RSS-14 encodes the full 14-digit EAN.UCC item identification in a linear symbol that can be scanned omnidirectionally by suitably programmed point-of-sale scanners. 

RSS Limited encodes a 14-digit EAN.UCC item identification with indicator digits of zero or one in a linear symbol for use on small items that will not be scanned at the point-of-sale. 

RSS-14 Stacked is a variation of RSS-14 symbology that is stacked in two rows and is used when the normal symbol would be too wide for the application. It comes in two versions – a truncated version used for small item marking applications, and a taller omnidirectional version that is designed to be read by omnidirectional scanners.

RSS Expanded encodes EAN.UCC item identification plus supplementary AI element strings such as weight and "best before" date in a linear symbol that can be scanned omnidirectionally by suitably programmed point-of-sale scanners. RSS Expanded can also be printed in multiple rows as a stacked column.

RSS Stacked Omnidirectional allows the full height RSS-14 to be printed in two rows of two segments each, which reduces the overall length of the linear bar code so it can fit better on certain packaging configurations. The separator pattern between the two rows is designed to eliminate cross-row scanning errors.

Any member of the RSS family can be printed as a stand-alone linear symbol or as a composite symbol with an accompanying 2D Composite component printed directly above the RSS linear component.

Note: Labeler does not currently support composite barcodes.

 XE "UCC 128 " \* MERGEFORMAT UCC-128

 UCC/EAN-128 is a Serial Shipping Container Code with a secure bar code symbology. It allows all participants in the supply chain to use a common, standard solution for their individual tracking and tracing needs. 

The UCC/EAN-128 bar code symbology requires AIs to define the data architecture. AIs are prefixes which indicate the meaning and format of the data which follows. Among the things they  may be used for are  item identification, measurements, quantities, traceability, dates, transaction references and location numbers.

Menu Commands

 XE "Overview " \* MERGEFORMAT 

 XE "Menu Commands Overview " \* MERGEFORMAT Menu Commands Overview

File 
Edit 
View 
Insert 
Format 
Tools 
Data 
Window 
Help 
File

 XE "Thermal Printers " \* MERGEFORMAT 

 XE "Send " \* MERGEFORMAT 

 XE "Save As " \* MERGEFORMAT 

 XE "Save All " \* MERGEFORMAT 

 XE "Save " \* MERGEFORMAT 

 XE "Reset " \* MERGEFORMAT 

 XE "Printer " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Password " \* MERGEFORMAT 

 XE "Paper Size " \* MERGEFORMAT 

 XE "Page Layout " \* MERGEFORMAT 

 XE "Orientation " \* MERGEFORMAT 

 XE "Label Wizard " \* MERGEFORMAT 

 XE "LAB file " \* MERGEFORMAT 

 XE "F8 " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "Ctrl+S " \* MERGEFORMAT 

 XE "Ctrl+P " \* MERGEFORMAT 

 XE "Ctrl+O " \* MERGEFORMAT File
The File menu includes the options which allow the designer to open, save, and print labels. In addition, the External Data Source is defined under this menu choice. Page and Printer setups are also specified. The File menu options are summarized below:
New Starts a new label file. Resets label design to default settings.
Open (Ctrl+O) Opens an existing label and page layout.
Show examples Opens a form listing the example LAB files provided with Wasp Labeler. 
Run Label Wizard Creates a new label file and automatically runs the Label Wizard, or runs the Label Wizard on a currently open (active) label file. See Label Wizard Overview for more info. 
Setup Thermal Printers This option provides a capability for optimizing the label throughput using proprietary commands for certain printer manufacturers by sending the commands directly to the printer. This option is visible only when no LAB files are open. Use this option to setup your thermal printers first (i.e. before they will appear on your Page Setup form). See Thermal Printers topic for further information. (This topic only available in the Thermal Printer Language version of the product.)

Close Closes the active LAB file that is currently open.
Save (Ctrl+S) Saves the current label design.
Save As Saves the current label design to a specified file name.
Save All Saves all of the LAB files that are currently open.
Password This option provides the capability to password protect the Wasp Labeler file (*.LAB) that is currently open:
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Once the file is closed, Wasp Labeler will prompt the user for the password before opening the file again:
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Note: The file cannot be opened without the correct password. If no password is associated with the *.LAB file, then no prompt will appear.  

To remove the password protection, open the file, provide the current password, then do File> Password to access the following dialog.  Leaving the bottom two fields empty will clear the password protection:  
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Entering a new, non-blank value in the bottom two fields will change the password.

Page Setup (F8) Defines the dimensions and placement of the labels on the page as well as the printer, paper size, paper source, and orientation of the page.
Print Preview Provides the preview of the page layout before printing the labels.
Print (Ctrl+P) Specifies the number of labels and copies to print.
Exit Closes the Wasp Labeler application. When you exit the Wasp Labeler application, a form appears allowing you to select which Wasp Labeler files you want to save.
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 XE "Width " \* MERGEFORMAT 

 XE "Top " \* MERGEFORMAT 

 XE "Time " \* MERGEFORMAT 

 XE "Thermal Transfer " \* MERGEFORMAT 

 XE "Thermal Printers " \* MERGEFORMAT 

 XE "Template " \* MERGEFORMAT 

 XE "Space Between Labels " \* MERGEFORMAT 

 XE "Save " \* MERGEFORMAT 

 XE "Row " \* MERGEFORMAT 

 XE "Right " \* MERGEFORMAT 

 XE "Properties " \* MERGEFORMAT 

 XE "Printing " \* MERGEFORMAT 

 XE "Printer Setup " \* MERGEFORMAT 

 XE "Printer " \* MERGEFORMAT 

 XE "Print Setup " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Paper Size " \* MERGEFORMAT 

 XE "Page Size " \* MERGEFORMAT 

 XE "Page Setup " \* MERGEFORMAT 

 XE "Page Layout " \* MERGEFORMAT 

 XE "Orientation " \* MERGEFORMAT 

 XE "Margins " \* MERGEFORMAT 

 XE "Lock " \* MERGEFORMAT 

 XE "Line " \* MERGEFORMAT 

 XE "Label Size " \* MERGEFORMAT 

 XE "Graphics " \* MERGEFORMAT 

 XE "Font " \* MERGEFORMAT 

 XE "Family Name " \* MERGEFORMAT 

 XE "Family " \* MERGEFORMAT 

 XE "Driver " \* MERGEFORMAT 

 XE "Delete " \* MERGEFORMAT 

 XE "Databases " \* MERGEFORMAT 

 XE "Custom Paper Size " \* MERGEFORMAT 

 XE "Custom Label " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Avery " \* MERGEFORMAT Page Setup
The Page Setup menu option under the File menu accesses a dialog box containing the 'Page Layout' and 'Printer Setup' information. Wasp Labeler includes a predefined set of Avery label templates. The Page Setup controls the placement of the label on the page and the page size.
Layout Tab
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Wasp Labeler provides the capability to customize any label layout. 'Family' and 'Type' options are supported to group labels together. The 'Family' represents the parent group of the label and the 'Type' represents the subset.

Available Family Templates:

· Avery Dot Matrix

· Avery Ink Jet

· Avery Laser

· Custom

· One-Up

· Shadow Book 

· W-30x

· W-60x

A sample page layout  might be: 

Family Avery
Type 5161 - Address Labels
Number of Labels:
'Across' Specifies the number of labels across the page.
'Down' Specifies the number of labels down the page.
Label Size:
'Width' Specifies the horizontal width of the label.
'Height' Specifies the vertical height of the label.
Page Margins:
'Top' Specifies the distance between the top edge of the page and the top of the first row of labels.
'Left' Specifies the distance between the bottom of the page and the left edge of the first column of labels.
'Right' Not required. Only left margin required.
'Bottom' Not required. Only top margin required.
Space Between Labels:
'Horizontal' Specifies the distance between the labels across a page.
'Vertical' Specifies the distance between the labels down a page.

The Page Setup screen will show the non-printable areas as dotted lines (top, bottom, left, right). Any attempt to print in this area will yield nothing. This non-printable area is user-definable or fixed by your printer driver. Most laser printers, for example, have a 0.25 inch non-printable margin around the page.
When 'Lock Edits' is disabled (unchecked) for a particular page layout configuration, the layout parameters can be modified and the layout file can be overwritten. If, however, 'Lock Edits' is enabled (checked), then no updates can be made. The 'New' button in the upper right corner is used to create new, custom page layouts. A 'Family', 'Type', and 'Description' can be entered manually. The 'Save' and 'Delete' buttons are active when 'Lock Edits' is disabled. To create a new page layout, simply click New and enter the Family Name, Type, and Description. The options to customize the Page Setup are identified below.
Note: The page setup information is 'SavedFile' with each label file. This feature is provided so that each label file can be copied and reopened on different PCs with minimal reconfiguration to the 'Page Setup' form. If the 'Family' and 'Type' of the Wasp Labeler application do not match to the label file's 'Family' and 'Type', a form will appear allowing you to choose which settings you wish to use. Select the 'Choose these settings' button to determine whether the label file is to use the layout database or the settings saved with the file. The differences will be highlighted in bold.
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Printer Setup Tab
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The 'Printer Setup' provides a standard configuration screen to select the printer, paper size, page size, paper source, and orientation of the page. These parameters are derived from the Windows print drivers defined on your system in the PC printer configuration. The paper size, paper source, and orientation will vary according to the printer selected.
Printer
To configure the 'Printer Setup', select one of your available printers listed in the 'Name' drop down list. The printer can be directly attached to your PC or it can be network addressable. The selected printer will be displayed in the 'Printer' field. If the 'Setup' button is clicked, the properties for the selected printer will be displayed. The printer properties are usually specific for each printer allowing the user to customize how the printer will process the paper, graphics, fonts, device options, etc.
Note: See the Thermal Printers topic for further information regarding non-Windows printers. If you have the Thermal Printer option, please see the WPL Printer Setup, ZPL Printer Setup and EPL Printer Setup topics for further information. Thermal printing options are only available if you have the Thermal Printing Language version of the product.

Paper Size
The 'Paper Size' determines the dimensions of the label sheet and is a function of your printer driver. The available paper sizes of your printer are displayed in the drop down list box. Note: Custom or User-Defined paper sizes are generally available on printers where labels can be printed on demand (i.e. one at a time). Most dot matrix and thermal printers support custom paper sizes. Most laser printers, however, only support standard paper sizes since an entire sheet must be used. Accordingly, a custom paper size may not be supported by your printer. Custom or User-Defined paper sizes are usually found at the end of the drop down list in the 'Page Size' option.
IMPORTANT: If a Custom paper size is selected, for example with a Thermal Transfer printer, make sure that the correct paper size (label size) is configured. Otherwise, damage to the printhead is possible.

Orientation
The 'Orientation' option selects the direction of print relative to the paper path of the printer. Both Portrait and Landscape orientations are supported.
Page Size
The 'Page Size' only becomes active if a Custom or User-Defined paper size is selected. The user can then configure the Print Setup to (1) automatically derive the 'Page Size' from the Layout or (2) accept a user-defined custom Width and Height. In general, the Page Size Auto option should be the preferred choice if the Page Setup has been properly configured and the Page Size is to be custom.
Note: The printer setup information is 'SavedFile' with each label file. This feature is provided so that each label file can be copied and reopened on different PCs with minimal reconfiguration to the 'Page Setup' form. If the label file's printer is not present on the user's PC, a form will appear allowing the user to choose from a list of available printers.
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By using a Prompt filter, you can cause Labeler to search for and print only the data that matches the value you have selected. When you set up a Prompt value filter, a prompt displays when you select either Print or Print Preview. Once you have selected the input value, Labeler will print only the labels that match this value.

An example of when this option could be very useful: If you have a database of items with unique bar codes for each item, this option would enable you to scan the bar code of an item and print only the label for that item. Once the option was set up, you could select Print and Labeler would ask for the bar code. Next, you could scan the bar code and Labeler would print only the label for that item.

Setting up a Prompt Filter

Step 1. Select Data | Filter from Labeler's Main window.

Step 2. Click the Add button at the bottom of the Filter Criteria List screen.
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Step 3. From the drop-down list, select the table and column by which you want to filter the data at print time. In the Value drop-down list, select Prompt.

 Click OK.
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The Prompt filter now displays in the Filter Criteria List. Close the screen by clicking Close.

Note: Make sure that the Prompt filter is set as the Default.
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Step 4. When you are ready to print the labels, select Print or Print Preview.
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The Prompt displays.

Step 5. To enable the filtering process, indicate the value by which you want to filter the data by one of the following actions:

· Click the down arrow and select a value.

· Type the value you want in the field.

· Scan the desired bar code.
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Once you have entered the desired value, click OK.

Only the labels which fit the filter value will be printed.

Note: If you click OK without selecting a value, or if you click Ignore or Cancel, the filter will not be enabled and labels will be printed for all record in the selected external data source. 
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The Print Preview menu option under the File menu provides the "print-to-screen" option to display a label print job.

There are three types of Print Previews.  Options unique to each type are discussed at these links:

Print Preview for labels with no External Data Source objects and no Prompt at Print Time objects
Print Preview for labels with one or more Prompt at Print Time objects
Print Preview for labels with one or more External Data Source objects
Features common to all three Print Previews, including Select Beginning Label, are discussed below.
Print Preview for Labels with

No External Data Source Objects 

and No Prompt at Print Time Objects:
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The example above illustrates the available Print Preview options when a label has been designed without  mapping any objects to an External Data Source, nor using Prompt at Print Time.  The Number of Labels options allow you to preview One Full Page of labels (the count will vary with the Page Setup) or you can use Specify to enter some other value.   These options mimic those seen in the Print dialog.

Note:  Number of Labels states how many unique labels will be printed.  Number of Copies states how many copies you want of each unique label.   For example, if you used Numeric Serialization to produce a series of labels with a BarCode object encoding values from 1 through 500, a Specify Number of Labels value of 10 will print only the first ten serialized labels, but if you also enter a Number of Copies value of 2, instead of using the default value, 1, you will cause two of each of those 50 labels to be printed, for a total of 100 physical labels.
Number of Copies will always be Manual from User when no objects are mapped to an External Data Source.  (See Dynamic From Column in Data Source, below.)  When a value greater than 1 is specified for Number of Copies, the copies can optionally be printed As consecutive labels (two copies of the first label, two copies of the second label, etc.).  The default (option disabled) will print one complete set of  labels, then a second set, etc. until the Number of Copies value has been satisfied.  (See the example previews, below.)

Features common to all three Print Previews, including Select Beginning Label, are discussed below.


Print Preview for Labels with 

One or More Prompt at Print Time Objects:
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The example above illustrates the available Print Preview options when a label has been designed with one or more objects mapped for Prompt at Print Time, but without  mapping any objects to an External Data Source.   The Number of Labels to be printed is driven at the time of printing by the User.  Labels will be printed as long as the User continues to supply data when prompted.

Number of Copies states how many copies you want of each unique label.  If you answer the prompt(s)  five times having set Number of Copies to a value of 3, a total of 15 labels will be produced.
Number of Copies will always be Manual from User when no objects are mapped to an External Data Source.  (See Dynamic From Column in Data Source, below.)  When a value greater than 1 is specified for Number of Copies, the copies can optionally be printed As consecutive labels (two copies of the first label, two copies of the second label, etc.).  The default (option disabled) will print one complete set of  labels, then a second set, etc. until the Number of Copies value has been satisfied.  (See the example previews, below.)

Features common to all three Print Previews, including Select Beginning Label, are discussed below.


Print Preview for Labels with 

One or More External Data Source Objects:
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The example above illustrates the available Print Preview options when a label has been designed with one or more objects mapped to an External Data Source.   The Number of Labels frame mimics that seen in the Print dialog, but lacks the Select Records Now option because you can step through the Preview to see any label you wish.

Note: In a Print Preview of labels with one or more External Data Source objects,  Number of Labels  reports how many unique labels would be printed given any filter you might be using.  
Number of Copies can be specified as Manual from User or Dynamic From Column in Data Source.  
Manual from User allows the user to specify how many copies you want of each unique label.   (For example, if your External Data Source has 500 records, entering a Number of Copies value of 2, instead of using the default value, 1, you will cause two of each of those 500 labels to be printed, for a total of 1000 physical labels.)  When a value greater than 1 is specified for Number of Copies, the copies can optionally be printed As consecutive labels (two copies of the first label, two copies of the second label, etc.).  The default (option disabled) will print one complete set of  labels, then a second set, etc. until the Number of Copies value has been satisfied. 
Dynamic From Column in Data Source allows the user to control the number of copies to be printed, label-by-label, based on a numeric value found in a column within the External Data Source.  For example, a MS-Excel spreadsheet containing data columns mapped to multiple label objects could be modified to include an additional column in which the user specifies the number of copies Labeler is to print for each record.  Each record can have a different number of copies specified in this column.  A user might find that data already existing within an External Data Source is ideal for controlling the number of copies to print of each label - the quantity column of an inventory database could be used for printing item labels, for example.
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The Number of Copies from Data Source function allows the user to specify which column contains the numeric values that will control the number of copies to be printed of each label.   Above, the user has used the Column drop list to select the column [Sheet1$],[Copies] from those columns previously  defined via the External Data Source Data Column Selection function.  

Having selected a column, it appears in the External Data Source Preview pane on the right.  The selected column is indicated via a large checkmark.  The other column headers can be dragged left or right to reposition columns as desired to facilitate review of the number of labels that will print for each record.  

The Substitute the value with:  option specifies how many labels should be printed for those records where a non-numeric or blank value is found in the selected column.  The default is 0.

The  Zero Value  toggle allows you to specify what action is to take place when a value of 0 comes from the selected column.  You can choose between two possibilities:  

Print no copies for the record

or
Use the substitution value from above

Maximum number of copies allows you to limit printing of labels to a specified value.  The default is 999.   Disable the limit by removing the checkmark..         

Click OK to return to Print Preview.



Features Common to All Print Previews:

Position Order allows you to specify Down, then across or the default value, Across, then down, as the direction in which the labels will print on a multi-label sheet as the printing progresses from the upper-leftmost label to the lower-rightmost label.

To accommodate partially consumed sheets of label stock, click the Select button to choose a Beginning Row/Col other than the top left  label at (Row 1 /  Column  1):
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Here, the first sheet of label stock inserted into the printer is missing its first eleven labels from a prior print job, so the User has chosen to begin printing this job at Row 4, Column 3.    This can be done by clicking at the desired position (on label # 12  in the example, above) or by overwriting the default Row and Column values with the Row and Column of your choice.  

Click OK to return to the Print Preview dialog, then click the Print Preview to preview the first page of labels to be printed:
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From the example above, this illustrates the result of using the Select Beginning Label option, to start printing at Row 4, Column 3 (on the 12th label).

The following example previews the same labels, but this time with Number of Copies set to a value of 2 and with the As consecutive labels option enabled:
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Notice that the serialized part numbers, as seen above in the bar code captions, will be printed two at a time, As consecutive labels.  Compare this to the previous example, where a value of 2 or more for Number of Copies would print a complete set of labels before printing second and subsequent sets (when the As consecutive labels option was disabled).

If applicable, the Print Preview screen will show a non-printable area (top, bottom, left, right) which is between the edge of a page and a corresponding dotted line. The page is defined using the Page Setup. Any attempt to print in this area will yield nothing. This non-printable area is user-definable or fixed by your printer driver. Most laser printers, for example, have a 0.25 inch non-printable margin around the page.

Across the top of a Print Preview you will find these buttons (reproduced here at 50% of actual size):
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First         

Back up to the first page.
Previous 

 Step to the previous page.

Page #:

Allows selection of a specific page #.

Next         

Step to the next page.
Last         

Advance to the last page.
Zoom List Box 

Magnification Level. Whole Page (default), 100%, 150%, 200%

Print 

Print labels from Print Preview screen.

Close 

Close Print Preview screen.
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There are three types of Print dialog.   Options unique to each type are discussed at these links:

Print options for labels with no External Data Source objects and no Prompt at Print Time objects
Print options for labels with one or more Prompt at Print Time objects
Print options for labels with one or more External Data Source objects
Features common to all Print dialogs, including Select Beginning Label, are discussed below.
Print Options for Labels with

No External Data Source Objects 

and No Prompt at Print Time Objects:
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The example above illustrates the available Print options when a label has been designed without  mapping any objects to an External Data Source, nor using Prompt at Print Time.    The Number of Labels options allow you to print One Full Page of labels (the count will vary with the Page Setup) or you can use Specify to enter some other value.

Note:  Number of Labels states how many unique labels will be printed.  Number of Copies states how many copies you want of each unique label.   For example, if you used Numeric Serialization to produce a series of labels with a BarCode object encoding values from 1 through 500, a Specify Number of Labels value of 10 will print only the first ten serialized labels, but if you also enter a Number of Copies value of 2, instead of using the default value, 1, you will cause two of each of those 50 labels to be printed, for a total of 100 physical labels.
Number of Copies will always be Manual from User when no objects are mapped to an External Data Source.  (See Dynamic From Column in Data Source, below.)  When a value greater than 1 is specified for Number of Copies, the copies can optionally be printed As consecutive labels (two copies of the first label, two copies of the second label, etc.).  The default (option disabled) will print one complete set of  labels, then a second set, etc. until the Number of Copies value has been satisfied.  

Features common to all Print dialogs, including Select Beginning Label, are discussed below.


Print Options for Labels with 

One or More Prompt at Print Time Objects:

[image: image111.png]~Pinter
Name: \ACOMANCHENEM Infoprint 1125
Pot: NeD

[~ MNumber of Labels

The number of abels pinted il be
determined at Prompt tine.

[~ MNumber of copies-
& Manual fiom User

Numbe of copies:
1= s consecutive bl

) Byiatic o ol in Deta Goiee)

[cross, then down 4





The example above illustrates the available Print options when a label has been designed with one or more objects mapped for Prompt at Print Time, but without  mapping any objects to an External Data Source.   The Number of Labels to be printed is driven at the time of printing by the User.  Labels will be printed as long as the User continues to supply data when prompted.

Number of Copies states how many copies you want of each unique label.  If you answer the prompt(s)  five times having set Number of Copies to a value of 3, a total of 15 labels will be produced.
Number of Copies will always be Manual from User when no objects are mapped to an External Data Source.  (See Dynamic From Column in Data Source, below.)  When a value greater than 1 is specified for Number of Copies, the copies can optionally be printed As consecutive labels (two copies of the first label, two copies of the second label, etc.).  The default (option disabled) will print one complete set of  labels, then a second set, etc. until the Number of Copies value has been satisfied.  (See the example previews, below.)

Features common to all Print dialogs, including Select Beginning Label, are discussed below.


Print Options for Labels with 

One or More External Data Source Objects:
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The example above illustrates the available Print options when a label has been designed with one or more objects mapped to an External Data Source.   

Note:  In a Print of labels with one or more External Data Source objects,  Number of Labels  reports how many unique labels would be printed given any filter you might be using.  
Number of Copies can be specified as Manual from User or Dynamic From Column in Data Source.  
Manual from User allows the user to specify how many copies you want of each unique label.   (For example, if your External Data Source has 500 records, entering a Number of Copies value of 2, instead of using the default value, 1, you will cause two of each of those 500 labels to be printed, for a total of 1000 physical labels.)  When a value greater than 1 is specified for Number of Copies, the copies can optionally be printed As consecutive labels (two copies of the first label, two copies of the second label, etc.).  The default (option disabled) will print one complete set of  labels, then a second set, etc. until the Number of Copies value has been satisfied. 
The Number of Labels frame is mimicked by that seen in the Print Preview dialog, but here, the Select Records Now function is made available to manually select which records are printed.   The Select Records Now button will open the View and Edit grid form and allow you to filter and sort your database records before printing:
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 Note:  No more than 100 records can be selected at a time.
 To print the selected records, select File/Print or click the Printer button on the toolbar.

Dynamic From Column in Data Source allows the user to control the number of copies to be printed, label-by-label, based on a numeric value found in a column within the External Data Source.  For example, a MS-Excel spreadsheet containing data columns mapped to multiple label objects could be modified to include an additional column in which the user specifies the number of copies Labeler is to print for each record.  Each record can have a different number of copies specified in this column.  A user might find that data already existing within an External Data Source is ideal for controlling the number of copies to print of each label - the quantity column of an inventory database could be used for printing item labels, for example.
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The Number of Copies from Data Source function allows the user to specify which column contains the numeric values that will control the number of copies to be printed of each label.   Above, the user has used the Column drop list to select the column [Sheet1$],[Copies] from those columns previously  defined via the External Data Source Data Column Selection function.  

Having selected a column, it appears in the External Data Source Preview pane on the right.  The selected column is indicated via a large checkmark.  The other column headers can be dragged left or right to reposition columns as desired to facilitate review of the number of labels that will print for each record.  

The Substitute the value with:  option specifies how many labels should be printed for those records where a non-numeric or blank value is found in the selected column.  The default is 0.

The  Zero Value  toggle allows you to specify what action is to take place when a value of 0 comes from the selected column.  You can choose between two possibilities:  

Print no copies for the record

or
Use the substitution value from above

Maximum number of copies allows you to limit printing of labels to a specified value.  The default is 999.   Disable the limit by removing the checkmark..         

Click OK to return to the Print dialog.



Features Common to All Print Dialogs:

Position Order allows you to specify Down, then across or the default value, Across, then down, as the direction in which the labels will print on a multi-label sheet as the printing progresses from the upper-leftmost label to the lower-rightmost label.

To accommodate partially consumed sheets of label stock, click the Select button to choose a Beginning Row/Col other than the top left  label at (Row 1 /  Column  1):
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Here, the first sheet of label stock inserted into the printer is missing its first eleven labels from a prior print job, so the User has chosen to begin printing this job at Row 4, Column 3.    This can be done by clicking at the desired position (on label # 12  in the example, above) or by overwriting the default Row and Column values with the Row and Column of your choice.  

Click OK to return to the Print dialog.
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The Edit menu includes the options which allow the designer to perform actions on the label objects (i.e. cut, copy, paste, etc.). In addition, the label can be locked from this pull down menu. The Edit menu options are summarized below:

Undo Undo last action.
Redo Repeats last action that was Undone.
Cut (Ctrl+X) Removes and copies the object(s) to the clipboard. If the object is pasted into the current label design or into another Wasp label design by using File/Open or File/New, the object properties are also copied. If the object is pasted into another Windows application, the object is pasted as a bitmap.
Copy (Ctrl+C) Copies the object to the clipboard. See Cut above.

Paste Object (Ctrl+V) Places previously cut or copied object(s) onto the label design area.
Paste Picture (Ctrl+B) Places previously cut or copied picture(s) from the system clipboard onto the label design area. The picture must be a Bitmap (BMP) or Device Independent Bitmap (DIB). A Picture object must be created or selected before pasting the clipboard picture onto the label design (i.e. the picture object must first be initialized). If no Picture object is on the label design, simply select Picture from the Toolbox. Next, select a picture file and "drop" a picture onto the label. In addition, the 'Link to File' property must be set to False.
Delete (Del) Deletes the selected object(s).
Select All (Ctrl+A) Selects all objects on the design.
Select Next (Ctrl+N) Selects the next object in the Z-order on the design from back to front.
Rotate Rotates the selected object 0, 90, 180, or 270 degrees.
Bring to Front (Ctrl+J) Brings the selected object to the front of the selection order.
Send to Back (Ctrl+K) Sends the selected object to the back of the selection order.
Align Selected objects are aligned to the top most, bottom most, left most, or right most object selected.
Center Selected objects are centered horizontally or vertically to the label width and/or height.
Space Selected objects are evenly spaced across and/or down the label.
Lock Prevents (locks out) the user from making modifications to the label design. Objects cannot be selected, repositioned, or resized.
Export as Image File allows the user to save a selected bar code as a graphic file, at any resolution, in any one of the following formats: .BMP, .JPG, .PNG, .EPS, .TIF or .WMF

Show Barcode Error Displays the details of barcode errors.
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Edit > Export as Image File can be used to save any BarCode object you have created in a label design to an image file.
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The image file may be saved in any of the formats shown above.  Note that JPEG images are saved with a compression level of 30% with no visible loss in quality with these two-color files, but there is an enormous savings in storage space compared to the other formats - as high as 35-to-1.
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Resolutions as low as 72 dpi and as high as 1800 dpi may be specified.  If you intend to print the image file for subsequent decoding by bar code scanners, you should specify resolution values no lower than 200 dpi. The default  of 300 dpi is ideal for printing.  If you only intend to display the image on a monitor, 72 dpi is sufficient.

Click the Export button to create the image file.  The default folder is .\Labeler\Images\. but this can be changed if you wish to store the file elsewhere.
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The View menu includes the options which allow the designer to customize the display. The View menu options are summarized below:
ToolBars If selected, a form will be display outlining which toolbars you can customize to appear on the main design form: Standard Toolbar, Alignment Toolbar, Formatting Toolbar, Toolbox Toolbar, Status Bar, and Rulers.
Zoom  Zoom provides the magnification level of the label design. Zoom can also be accessed using the Zoom In or Zoom Out on the Toolbar. 25%, 50%, 75%, 100%, 150%, and 200% are the standard magnification levels. 200% is the maximum magnification level. You can also enter the magnification level.

Data Preview presents a dialog that allows you to see what your labels will look like while still in design mode.  This feature is available only when an External Data Source has been mapped to one or more objects in the label.  All the labels can be quickly examined by using the up or down arrows to scroll through the records shown. 
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Click Close to exit Data Preview.

Note:  When a User Defined List is selected as an Object Source, for either a Text or Bar Code object, the values in that list will be seen in the actual printed labels, but they will not be seen in a Data Preview.  The Data Preview will instead show a default static value.

Refresh (F5)  Unselects all objects and redraws the label.
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The Insert menu includes the options which allow the designer to add objects onto the label. These objects include text, bar codes, lines, rectangles, ellipses, and pictures. Each of these objects can be created from the Toolbox. The Insert menu options are summarized below:
 

Text Inserts various text information onto the label including Static, Serialization, Prompt at Print Time, External Data Source, Bind to Another Object, and Date/Time.
Bar Code Inserts bar code objects onto the label including Static, Serialization, Prompt at Print Time, External Data Source, Bind to Another Object, and Date/Time.
Line Inserts a line object onto the label.
Rectangle Inserts a rectangle (or square) object onto the label.
Ellipse Inserts an ellipse (or circle) object onto the label.
Picture Inserts an image onto the label.
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Text objects provide a means of placing textual information (i.e. alphanumeric characters) onto the label with the capability of entering the value of the Text object directly on the label design area. The Text object supports static information, serialization, Bind to Another Object, and date/time information from the PC clock. Prompt at Print Time or External Data Source values can also be configured for each Text object. The object can be moved from the keyboard using the Up, Down, Left, or Right Arrow Keys. The Ctrl (Control) Key can be used in conjunction with the Arrow Keys to move the object 5X. The Properties of Text objects are summarized below:
[image: image119.png]T T =

General | Ten |

Object Name Textt
Left 4166667
Top 1083333
Widh 2166687
Height 221666
Rotation 0Degress

Display On Pt True





General Tab
Object Name Specifies the unique reference name to identify an object. Maximum of 40 characters. A unique default name will appear when an Object is created.
Left Specifies the distance between the left edge of the label and the left edge of the object. The Left property is measured in the number of units configured from the Tools/Units menu option.
Top Specifies the distance between the top edge of the label and the top edge of the object. The Top property is measured in the number of units configured from the Tools/Units menu.
Width Specifies the horizontal dimensions of an object. The Width property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Height Specifies the vertical dimensions of an object. The Height property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Rotation Specifies the orientation of the object relative to orientation of the label. The object can be rotated 0, 90, 180, or 270 degrees counter-clockwise from the center point coordinate position.

Display on Print Specifies whether the object will appear on the label when the label file is printed. 



Text Tab
Text Value Specifies the text value. Multiple lines (carriage returns) can be entered on the Text Value definition form (See Object Source for additional information). If a carriage return is inserted into the text string, word wrapping is disabled. If no carriage return is inserted, word wrapping is enabled.
Prompt Order Specifies the prompt message order when the 'Prompt at Print Time' (see Prompt at Print Time) is activated in the text property. For example, if Prompt Order property is one (1), the prompt message will be displayed first on the Keyboard Input Screen. Note: The Prompt Order property is only visible when the 'Prompt at Print Time' is enabled in the Text property.
Justification Specifies the alignment of the text within an object. Center, left, and right alignment (justify) are supported.
Font Opens the common dialog box for the font, font style, size, font effects, underline, and color. All system fonts are supported. OCR-A, OCR-B, and MICR fonts are also supported.
Autosize Specifies whether the text is to autosize to the size of the rectangle or the rectangle is to autosize to the size of the text object. The default is Size Rectangle to Text. When this is selected, the line breaks (paragraph marks) are supplied by the user as, for example, in lines of an address. The width and height of the bounding rectangle autosize to fit the text. When Wrap Text to fit Rectangle is selected, the width of the bounding rectangle specified by the user controls the word wrapping (line breaks). If the height of the bounding rectangle is too small to accommodate the text, the height of the rectangle grows to fit the text while the width remains the same. The user should specify this option when it is not important where the line breaks occur as, for example, in long messages or paragraphs.
Prefix Text Value Specifies a text string to be appended to the beginning of the Text object. Maximum 256 characters. For additional information, see the Object Source topic.
Suffix Text Value Specifies a text string to be appended to the end of the Text object. Maximum 256 characters. For additional information, see the Object Source topic.
 XE "Bar Codes " \* MERGEFORMAT Bar Codes
Bar Code objects provide a means of placing bar codes onto the label.

Supported symbologies include:

	· Codabar
	· EAN/JAN-8
	· RSS14 Truncated

	· Code 39
	· Interleaved 2 of 5
	· RSS14 Limited

	· Code 93
	· ISBN 
	· RSS14 Stacked

	·  Code 128 
	· ITF14
	· RSS14 Stacked Omni-Directional

	·  Code 128 A
	· MicroPDF417s
	· RSS  Expanded

	· Code 128 B
	· MSI Plessey
	· UCC 128

	· Code 128 C
	· PostNet
	· UPC-A

	· EAN/JAN-13
	· RSS14
	·  UPC-E


Bar Codes that require the 2D option include:

· PDF417

· MaxiCode

· Data Matrix

· MicroPDF

To view and edit the bar code's properties, left-click on the bar code and select Properties.
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The Object Properties dialog box displays. 
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The Bar Code object supports Static information, Serialization, Bind to Another Object, and Date/Time information from the PC clock with the capability of entering the value of the Bar Code object directly on the label design area. (Note: If the symbology supports carriage returns, then the input box on the label design area will allow for multiple lines to be inserted.) Prompt at Print Time or External Data Source values can also be configured for each Bar Code object.

Wasp Labeler supports the most common features to completely customize any bar code. The Bar Width property varies the X dimension of the specified bar code symbology. The Ratio property varies the ratio (from 2.0 to 3.0) of the narrow and wide elements in a width-modulated bar code symbol. In addition, the height of the bar code can vary. All the properties of the Bar Code objects are summarized below.

General Tab
· Object Name Specifies the unique reference name to identify an object. Maximum of 255 characters. A unique default name will appear when an Object is created.
· Left Specifies the distance between the left edge of the label and the left edge of the object. The Left property is measured in the number of units configured from the Tools/Units menu option.
· Top Specifies the distance between the top edge of the label and the top edge of the object. The Top property is measured in the number of units configured from the Tools/Units menu option.
· Rotation Specifies the orientation of the object relative to orientation of the label. The object can be rotated 0, 90, 180, or 270 degrees counter-clockwise from the original coordinate position.

· Display on Print Specifies whether the object will appear on the label when the label file is printed.



Drawing Tab
· Fore Color Specifies the foreground color used to display text and graphics in an object. The software uses the standard Windows color palette.
· Back Color Specifies the background color of an object. The software uses the standard Windows color palette.



Caption Tab

· Align Specifies if the bar code caption is below centered, below left justified, below right justified, above centered, above left justified, or above right justified relative to the bar code.
· Font Opens the common dialog box for the font, font style, size, font effects, underline, and color of the bar code caption.



Bar Code Tab
Bar Code Value Specifies the bar code value. See Object Source for additional information.
· Prompt Order Specifies the prompt message order when Prompt at Print Time is activated in the bar code value property. For example, if Prompt Index is one (1), the prompt message will be displayed first on the Keyboard Input screen. Note: The Prompt Index property is only visible when 'Prompt at Print Time' is enabled in the Bar Code Value property.

· Symbology Specifies the bar code symbology: Code 39 Extended, Code 39 Standard, UPC-A, UPC-E, EAN/JAN-8, EAN/JAN-13, Interleaved 2 of 5, Code 128, Codabar, Code 93, MSI Plessey, PostNet. 2D option required for PDF417, MaxiCode, and Data Matrix symbols. 
· Bar Width Specifies the X dimension (narrowest element) of the specified bar code symbol and is directly related to the Characters per Unit property. The Bar Width is measured in the number of units configured from the Tools/Units menu option.
· Characters per Unit Specifies the number of Characters per Unit of Measure. This property is directly related to the Bar Width property and varies the X dimension to limit the number of characters per the unit of measure.
· % of Nominal Specifies the percentage from 80% - 200% of the nominal value (100%) for UPC-A, UPC-E, EAN/JAN-13, and EAN/JAN-8 symbologies.
· Bar Height Specifies the height of the bar code symbol. The Bar Height is measured in the number of units configured from the Tools/Units menu option. See the 'Specify Bar Height' property for UPC, EAN, and JAN symbologies.
· Check Digit Specifies the character of a bar code symbol used to perform a mathematical check to ensure the accuracy of the scanned data. If a Check Digit is not required for a particular symbology, then the Check Digit is optional and will be displayed in the properties box. The check digit for Code 39 and Interleaved 2 of 5 is optional. MSI Plessey requires at least one check digit (see '2 Check Digits' property).
· Show in Caption Specifies whether or not the Check Digit should be displayed in the bar code's caption along with the encoded data. When this is set to a value of True, the check digit will be shown for those symbologies that use check digits. The default value is False.
Note: The Check Digit option, above, must be enabled to use the Show in Caption option.

· Ratio Specifies the ratio of the narrow to wide elements in a width-modulated bar code symbol. The ratio ranges from 2.0:1 - 3.0:1 in increments of 0.1.

· Bearer Bars (Interleaved 2 of 5 and ITF-14 only) Specifies the position of the bearer bars, either top and bottom or top, bottom and sides.

· UCC/EAN-128 Specifies a special subset of the Code 128 symbology. Decoders will interpret the initial digits as Application Identifiers.
· Append Specifies that the bar code value is to be concatenated with the preceding (scanned) bar code value.
· Append Position Specifies that the concatenated bar code value is to be in the first, middle, or last position of the bar code string for the Codabar symbology.
· Start Character Specifies the start character for the Codabar symbology. "A", "B", "C", and "D" are valid start characters.
· Stop Character Specifies the stop character for the Codabar symbology. "A", "B", "C", and "D" are valid stop characters.
· Show Start/Stop Specifies that the start and stop characters are to be visible in the caption of the bar code. Code 39 and Codabar symbologies support this option.
· 2 Check Digits Specifies a second, optional check digit for the MSI Plessey symbology. The first check digit is required.
· Specify Bar Height Specifies the bar height for UPC, EAN, and JAN symbologies. This property is a True/False value that defaults to False. When False, the height of a UPC/EAN/JAN bar code is one inch times the percent of nominal (See '% of Nominal' property above). If this property is True, the 'Bar Height' property becomes visible and can be specified by the user. Note: Any modification of the Bar Height by the user will make the bar code deviate from the specification.

· Prefix BC Value Specifies a text string to be appended to the beginning of the Bar Code object. For additional information, see the Object Source topic.
· Suffix BC Value Specifies a text string to be appended to the end of the Bar Code object. For additional information, see the Object Source topic.
· Columns Specifies the number of columns of the PDF417 symbol. The valid range is 1 through 30. If <Auto>, then the number of columns and rows is calculated to best fit a 1 to 3 column to row ratio.
· Rows Specifies the number of rows of the PDF417 symbol. The valid range is 3 through 90. If <Auto>, then the number of rows is calculated given the number of columns. Also, if the number of columns is <Auto>, then this value is not used (i.e. Rows is calculated).
· Error Level Specifies the error correction level for the PDF417 symbol. The valid range is 0 through 8, where level 0 provides only error detection, and level 8 provides the maximum error detection and correction capacity. If <Auto>, then the error correction level is set to the recommended level for the given number of data codewords in the symbol, as shown in the following table.
· Number of Data Codewords Error Correction Level
 1 - 40 2
 41 - 160 3
 161 - 320 4
 321 - 863 5
· Truncate If TRUE, then omit the right row indicators and the stop pattern for the PDF417 symbol. Truncation reduces the non-data overhead for the symbol, but also reduces the decode performance and the ability of the symbol to withstand degradation. This value should be TRUE only in relatively “clean” environments where label damage is unlikely.
· Mode Specifies the data and error correction within the MaxiCode symbol. Valid values are 2, 3, 4, 5, and 6: Modes 2 and 3 are designed for use in the transport industry. They encode the destination postal code, country code and class of service as the primary message, and a secondary (low priority) message of up to 84 characters. In Mode 2, the postal code is numeric only with up to a 9 digits. In Mode 3, the postal code is alphanumeric with up to 6 characters. Modes 4 and 5 are for generic use. Mode 4 encodes up to 93 characters. Mode 5 is equivalent to Mode 4 except that it employs enhanced error correction and can encode up to 77 characters. Mode 6 encodes up to a 93 character message for reader configuration purposes only.
· Postal Code Specifies the postal code for the MaxiCode symbol. This property is only applicable for Modes 2 and 3. For Mode 2, this is up to a 9-digit postal code. For Mode 3, this is up to a 6 character postal code. Shorter codes are filled with trailing spaces. Longer codes are truncated 
· Country Code Specifies the 3-digit ISO 3166 country code. The code for the United States is “840”. 
· Class of Service Specifies the 3-digit class of service.



Bar Code Errors

If you input invalid data for a barcode, the barcode image will display with a red X and an error code and an error message will display at the bottom of your screen.
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To view the details of the error, either double-click on the barcode object or select Edit | Show Barcode Error.
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The details will display.
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Line objects provide a means of placing straight lines onto the label at any angle. You can hold down the Shift Key before dropping the Line Object onto the label design area and create vertical or horizontal lines. The object can be moved from the keyboard using the Up, Down, Left, or Right Arrow Keys. The Ctrl (Control) Key can be used in conjunction with the Arrow Keys to move the object 5X. Also, turning on Snap to Grid is useful when positioning Line objects. The Properties of Line objects are summarized below:
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General Tab
Object Name Specifies the unique reference name to identify an object. Maximum of 40 characters. A unique default name will appear when an Object is created.
X1 Specifies the horizontal coordinate of the first end point placed on the label design. The X1 property is measured in the number of units configured from the Tools/Units menu option. The Line object can easily be changed to a horizontal or vertical line by holding down the shift key and moving one end horizontally or vertically. The Line object will automatically snap into position.
Y1 Specifies the vertical coordinate of the first end point placed on the label design. The Y1 property is measured in the number of units configured from the Tools/Units menu option. The Line object can easily be changed to a horizontal or vertical line by holding down the shift key and moving one end horizontally or vertically. The Line object will automatically snap into position.
X2 Specifies the horizontal coordinate of the second end point placed on the label design. The X2 property is measured in the number of units configured from the Tools/Units menu option. The Line object can easily be changed to a horizontal or vertical line by holding down the shift key and moving one end horizontally or vertically. The Line object will automatically snap into position.
Y2 Specifies the vertical coordinate of the second end point placed on the label design. The Y1 property is measured in the number of units configured from the Tools/Units menu option. The Line object can easily be changed to a horizontal or vertical line by holding down the shift key and moving one end horizontally or vertically. The Line object will automatically snap into position.
Display on Print  Specifies whether the object will appear on the label when the label file is printed.



Drawing Tab
Fore Color Specifies the foreground color used to display text and graphics in an object. The software uses the standard Windows color palette.
Draw Mode Produces visual effects of the colors between two or more objects that overlap. The Draw Mode compares each pixel in the draw pattern to the corresponding pixel in the existing background. The settings for the Draw Mode are:
Blackness.
Not Merge Pen. Inverse of Merge Pen.
Mask Not Pen. Combination of the colors common to the background color and the inverse of the pen.
Not Copy Pen. Inverse of Copy Pen.
Mask Pen Not. Combination of the colors common to both the pen and the inverse of the display.
Invert. Inverse of the display color.
Xor Pen. Combination of the colors in the pen and in the display color, but not in both.
Not Mask Pen. Inverse of Mask Pen)
Mask Pen. Combination of the colors common to both the pen and the display.
Not Xor Pen. Inverse of Xor Pen.
Nop (No Operation). Output remain unchanged. In effect, this setting turns drawing off.
Merge Not Pen. Combination of the display color and the inverse of the pen color.
Copy Pen (Default). Color specified by the Fore Color property.
Merge Pen Not. Combination of the pen color and the inverse of the display color.
Merge Pen. Combination of the pen color and the display color.
Whiteness.
Draw Style Specifies the line style of the object when Draw Width is equal to one. The settings for the Draw Style are:
Solid (Default).
Dash
Dot
Dash-Dot
Dash-Dot-Dot
Transparent
Inside Solid
Draw Width Specifies the line width of the object. This value represents the width of the line in pixels. The default is 1.
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Rectangle objects provide a means of placing rectangle (or squares) onto the label. The object can be moved from the keyboard using the Up, Down, Left, or Right Arrow Keys. The Ctrl (Control) Key can be used in conjunction with the Arrow Keys to move the object 5X. The Properties of Rectangle objects are summarized below:
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General Tab
Object Name Specifies the unique reference name to identify an object. Maximum of 40 characters. A unique default name will appear when an Object is created.
Left Specifies the distance between the left edge of the label and the left edge of the object. The Left property is measured in the number of units configured from the Tools/Units menu option.
Top Specifies the distance between the top edge of the label and the top edge of the object. The Top property is measured in the number of units configured from the Tools/Units menu option.
Width Specifies the horizontal dimensions of an object. The Width property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Height Specifies the vertical dimensions of an object. The Height property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Rotation Specifies the orientation of the object relative to orientation of the label. The object can be rotated 0, 90, 180, or 270 degrees counter-clockwise from the original upper left hand coordinate position.

Display on Print Specifies whether the object will appear on the label when the label file is printed.



Drawing Tab
Fore Color Specifies the foreground color used to display text and graphics in an object. The software uses the standard Windows color palette.
Draw Mode Produces visual effects of the colors between two or more objects that overlap. The Draw Mode compares each pixel in the draw pattern to the corresponding pixel in the existing background. The settings for the Draw Mode are:
Blackness.
Not Merge Pen. Inverse of Merge Pen.
Mask Not Pen. Combination of the colors common to the background color and the inverse of the pen.
Not Copy Pen. Inverse of Copy Pen.
Mask Pen Not. Combination of the colors common to both the pen and the inverse of the display.
Invert. Inverse of the display color.
Xor Pen. Combination of the colors in the pen and in the display color, but not in both.
Not Mask Pen. Inverse of Mask Pen.
Mask Pen. Combination of the colors common to both the pen and the display.
Not Xor Pen. Inverse of Xor Pen.
Nop (No Operation). Output remain unchanged. In effect, this setting turns drawing off.
Merge Not Pen. Combination of the display color and the inverse of the pen color.
Copy Pen (Default). Color specified by the Fore Color property.
Merge Pen Not. Combination of the pen color and the inverse of the display color.
Merge Pen. Combination of the pen color and the display color.
Whiteness.
Draw Style Specifies the line style of the object when Draw Width is equal to one. The settings for the Draw Style are:
Solid (Default)
Dash
Dot
Dash-Dot
Dash-Dot-Dot
Transparent
Inside Solid
Draw Width Specifies the line width of the object. This value represents the width of the line in pixels and ranges from 1 (default) to no upper limit.
Fill Color Specifies the color used to fill in objects. The software uses the standard Windows color palette.
Fill Style Specifies the fill pattern of the object. Note: Some printer drivers do not support all Fill Styles. The settings for the Fill Style are:
Solid 
Transparent (Default)
Horizontal Line
Vertical Line
Upward Diagonal
Downward Diagonal
Cross
Diagonal Cross
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Ellipse objects provide a means of placing ellipses (or circles) onto the label. The object can be moved from the keyboard using the Up, Down, Left, or Right Arrow Keys. The Ctrl (Control) Key can be used in conjunction with the Arrow Keys to move the object 5X. The Properties of Ellipse objects are summarized below:
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General Tab

Object Name Specifies the unique reference name to identify an object. Maximum of 40 characters. A unique default name will appear when an Object is created.
Left Specifies the distance between the left edge of the label and the left edge of the object. The Left property is measured in the number of units configured from the Tools/Units menu option.
Top Specifies the distance between the top edge of the label and the top edge of the object. The Top property is measured in the number of units configured from the Tools/Units menu option.
Width Specifies the horizontal dimensions of an object. The Width property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Height Specifies the vertical dimensions of an object. The Height property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Rotation Specifies the orientation of the object relative to orientation of the label. The object can be rotated 0, 90, 180, or 270 degrees counter-clockwise from the original upper left hand coordinate position.

Display on Print Specifies whether the object will appear on the label when the label file is printed.


Drawing Tab

Fore Color Specifies the foreground color used to display text and graphics in an object. The software uses the standard Windows color palette.
Draw Mode Produces visual effects of the colors between two or more objects that overlap. The Draw Mode compares each pixel in the draw pattern to the corresponding pixel in the existing background. The settings for the Draw Mode are:
Blackness.
Not Merge Pen. Inverse of Merge Pen.
Mask Not Pen. Combination of the colors common to the background color and the inverse of the pen.
Not Copy Pen. Inverse of Copy Pen.
Mask Pen Not. Combination of the colors common to both the pen and the inverse of the display.
Invert. Inverse of the display color.
Xor Pen. Combination of the colors in the pen and in the display color, but not in both.
Not Mask Pen. Inverse of Mask Pen.
Mask Pen. Combination of the colors common to both the pen and the display.
Not Xor Pen. Inverse of Xor Pen.
Nop (No Operation). Output remain unchanged. In effect, this setting turns drawing off.
Merge Not Pen. Combination of the display color and the inverse of the pen color.
Copy Pen (Default). Color specified by the Fore Color property.
Merge Pen Not. Combination of the pen color and the inverse of the display color.
Merge Pen. Combination of the pen color and the display color.
Whiteness.
Draw Style Specifies the line style of the object when Draw Width is equal to one. The settings for the Draw Style are:
Solid (Default)
Dash
Dot
Dash-Dot
Dash-Dot-Dot
Transparent
Inside Solid
Draw Width Specifies the line width of the object. This value represents the width of the line in pixels and ranges from 1 (default) to no upper limit.
Fill Color Specifies the color used to fill in objects. The software uses the standard Windows color palette.
Fill Style Specifies the fill pattern of the object. Note: Some printer drivers do not support all Fill Styles. The settings for the Fill Style are:
Solid 
Transparent (Default)
Horizontal Line
Vertical Line
Upward Diagonal
Downward Diagonal
Cross
Diagonal Cross
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Picture objects provide a means of adding images onto the label. These pictures may be rotated at 90,180, or 270 degrees. The object can be moved from the keyboard using the Up, Down, Left, or Right Arrow Keys. The Ctrl (Control) Key can be used in conjunction with the Arrow Keys to move the object 5X. The Properties of Picture objects are summarized below:
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General Tab
Object Name Specifies the unique reference name to identify an object. Maximum of 40 characters. A unique default name will appear when an Object is created.
Left Specifies the distance between the left edge of the label and the left edge of the object. The Left property is measured in the number of units configured from the Tools/Units menu option.
Top Specifies the distance between the top edge of the label and the top edge of the object. The Top property is measured in the number of units configured from the Tools/Units menu option.
Width Specifies the horizontal dimensions of an object. The Width property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Height Specifies the vertical dimensions of an object. The Height property is measured in the number of units configured from the Tools/Units menu option. The Height and Width of the object can be proportionally sized by holding down the shift key and dragging one of the corners of the object. If the shift key is not held down, the object will be sized relative to the position of the mouse cursor.
Rotation Specifies the orientation of the object relative to orientation of the label. The object can be rotated 0, 90, 180, or 270 degrees counter-clockwise from the original upper left hand coordinate position.
Picture File Specifies the file reference for the image to import. The picture must be one of the following file formats with the appropriate file extension:
 BMP Bitmap Formats
 TIF TIFF Without LZW Compression
 WMF Windows Metafile Format
 PCX, DCX PCX Formats
 JPG, CMP JPEG and LEAD Compressed
 PSD PhotoShop 3.0 Format
 PNG Portable Network Graphics Format
 TGA Truevision TARGA Format
 EPS Encapsulated PostScript
 RAS SUN Raster Format
 WPG WordPerfect Format
 PCT Macintosh Pict Format

Stretch to Fit If TRUE, the picture can be proportionally resized on the label design by dragging one of the corners of the picture or changing the width/height properties. Holding the shift key down will maintain the aspect ratio. If FALSE, the picture cannot be resized and will be sized according to the original file dimensions.
Link To File If False, the picture will be saved in the current *.LAB configuration file. If True, the Picture File will not be saved in the *.LAB file and a reference (link) will be created to point to the Picture File name inserted. Note: If picture objects are "linked", then moving the LAB configuration file to another machine would require the picture files to also be moved appropriately, including the directory path name.
Display on Print Specifies whether the object will appear on the label when the label file is printed.
Format
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The Format menu includes features which allow the designer to modify the Properties and Source of the various objects placed on the label file. In addition, default templates for each object can be set under this menu option. The Format menu features are summarized below:
Properties (F4) The Properties menu option allows the designer to customize every object on the label. Text, bar code, line, rectangle, ellipse, and picture objects can be added to the label design from the View menu option or Toolbox. Properties detail the characteristics about the object that can be customized. The Properties are specific for each object.  ( See Text, BarCode, or Picture.)

Source (F6) Static, Serialization, Prompt at Print Time, External Data Source, Bind to Another Object, and Date/Time values are supported for Text and Bar Code objects. Static, Prompt at Print Time, and External Data Source are supported for Picture objects.
Character Formatting This feature formats an object's resultant value according to instructions contained in a format expression. You can create user-defined formats with standard characters that have special meaning when used in a format expression.
Object Style Template This feature will use the properties of an Object as the default for when the next object of a given type is inserted. Create an object, modify the properties, and then select this feature to set the new default template(s) for each object. Note: You can select more than one object to set the default templates for multiple object types at the same time. Use the left mouse button to select an object. Hold the 'Shift Key' down and click the left mouse button to select multiple objects.
 Save Selected Object Style(s) - Modify the Properties of an object. Select one or more objects to modify the object style(s). Choose this option to set the default properties when the next object of this type is inserted.  More than one object type can be selected when you do the Save Selected Object Style(s), but only one template will be saved for each type of object.  Once saved, every time you insert one of these types in a new label design, your custom template will be applied.  

 Restore Default for - Use this option to restore the factory default settings for the properties of 'All Object Types' or individual types.
Object Source
Wasp Labeler allows for several different methods of creating and placing information (i.e. serial numbers, descriptions, dates, item numbers, etc.) onto a label. Text and BarCode objects can each be mapped to one of eight possible Source Types. Picture objects support  three  Source Types. The 'Object Source' form for Picture objects allows the user to 'Stretch original image to fit a given size' and 'Link to File' on this form. These options only appear when a Picture object is selected. Static, Serialization, Bind to Another Object, and Date/Time are defined in the Text and Bar Code sections (see links below). Prompt at Print Time and External Data Source are described in separate topics. Substrings are also supported allowing the user to dynamically build a character string. 

Object Source - Bar Code
Object Source - Text
Object Source - Picture
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There are eight possible Source Types for Text objects:

Static
Date/Time
Bind to Another Object
External Data
Label Number N (eg N of M ) - Enumerated Labels
Serialization - Numeric
Serialization - Alphabetic
Serialization - User Defined List
Enumerated Labels
Prompt at Print time
Static
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This label has five text objects, one BarCode object and one Picture object.  Above, the Text1 object is being defined as Static - the text string supplied will be printed on every label.

Click Next to proceed to the Static Settings tab:
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A Static object source allows the user to input a fixed value (i.e. "1234", "Sample Description", etc.) onto the label. This is typed in the Static Value field, and the value is displayed on the label. 

For Text objects, you can insert any of the 128 ASCII characters into the static value, including special characters such as line feeds, form feeds, bells, etc. using the ellipse button [...] to the right of the text box:

[image: image131.png]Insert Character

Nomal Test CharacterSet





Select a character and click OK. It will be inserted at the cursor position.

Click Next to proceed to the Formatting tab:
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Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Date/Time
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Here the Text1 object is being defined to have a Date/Time object source.

Click Next to proceed to Date/Time Settings:
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The Date/Time data source extracts the current date and/or time from the PC when the label is printed. Any one of multiple date/time formats can be selected. This data source option is practical when the item that is labeled must have a date and/or time associated with it for tracking.

Use the Offset by feature to offset the Years, Months, or Days of the Text object from the date the label is printed.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Bind to Another Object

[image: image135.jpg]3% Object Source - LabelLLAB
Object Lit

[l BaCodet

Picure

Convertto Substings

Teu"-Souce Type | Bind Slings | Fomating | Placcholder

Select 3 soutce type for the object and press Next

General
© Static
" DatelTime
 Bind o another Ubieck
External Data

i)

Label Number N (sg. N of M)
Setaization
Numeric
Alghabetic
© User Defined List
Frompt a pint time
 Keyboard Enty

=
s

Datsbases, DDBL, Access, DuickBooks®, Deliited Text

Hep |

[ b Aoy

Erish





Here, the Text2 object is given the same source as another object, already defined to the label, by using Bind to another Object.
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The Bind to Another Object data source allows multiple Text or BarCode objects to be "linked" to other Text or BarCode objects without having to duplicate the value of the other object. For example, the value of a Text object can be "bound" to the value of a BarCode object.  If the value of the BarCode object changes, then the value of the Text object will change, too.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



External Data
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External Data can be selected as the source for a Text object - to extract data from a field within multiple database records.

Note:  As shown in the following screen, the Wasp Barcode Labeler Special Edition for QuickBooks® Users version can only make use of QuickBooks®  data as an External Data Source:
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See Quickbooks® Support for additional information regarding its use as an External Data Source.

Click Next to proceed to the Object-to-Column Mappings options:
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If you  have previously defined a source with the External Data Source Wizard, the columns you selected there will be displayed here in the Object-to-Column Mappings drop list.  Select the column you wish to map to this Text object.

[image: image140.png]Object Source - Label1.LAB:

Obiect it
[l Baodet o
I Bacoder.1

Text1' - Source Type. Dbjsctio-Column Mappings | Fomating | Placeholder

o Selct e ok o he et dts sace v i provide h sce koo
[ Pitue the object
A Text
(A Ten2
(A Tets Souee C:\My Documents\nverto!Customer s
(A Tetsn This Oject meps o Cokamn:
A Tena e —
A Tens2
A Teis

Selup

Convettto Substings

Help < Back Aoy Erish





If you  have not yet defined a source with the External Data Source Wizard, you will have to first click the Setup... button to launch the External Data Source Wizard.  Once the columns have been selected from your External Data Source, you can return here to map one of them to this label object.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Serialization - Numeric
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Here, Numeric Serialization has been selected for the object named Text2.  
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The default Serial Settings options will generate a series that begins with a value of 1 and increments by a value of 1 with every label.  Each time this .LAB file is printed, the series will start at a value of 1.  

The Start at seed value is the initial serial number and is limited to 14 numerical digits. The Step value allows the users to skip over numbers, and Every allows the serial number to be repeated. 

Examples:

Start at seed: 3 and Step: 2  Every: 1 label will generate the series:  3, 5, 7, 9, 11, etc.

Start at seed: 2 and Step: 1  Every: 3 labels will generate the series:  2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6, etc.

Start at seed: 1 and Step: 4  Every: 2 labels will generate the series:  1, 1, 5, 5, 9, 9, 13, 13, 17, 17, 21, 21, etc.
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If the Rollover after option is enabled, the serialization routine will restart counting from the beginning seed value.   If the Reset after rollover option is set, the serialization routine will restart counting at the reset value. 

Above, the series begins at 1, increments by 1 with each label printed, but when the value 10,000 is reached, the series rolls over to begin again at a value of 1.  The Last value as next print job's seed option will allow subsequent print jobs to print labels such that the series continues where it left off - it is not reset to the original seed value.
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In this example, a Decrementing series has been defined to begin at a value of 3, decrementing by a value of 1 with each printed label, rolling over at a value of 1.  

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Click the Preview button to see what these settings will produce:
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Click Refresh to update the preview or Close to return.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Serialization - Alphabetic
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Here, Alphabetic Serialization has been selected for a  Text object.  Click Next to proceed to the Serial Settings form:
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In this example, an incrementing series of Upper case alphabetic characters has been selected.
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The Upper case series will begin with the character "A", incrementing by one alphabetic character with each label printed as seen in the following Preview:
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Click Refresh to update the preview or Close to return.
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In the example above, an Upper Case alphabetic series will begin with "A", incrementing by one character with each label printed, but will rollover after printing  a value of "E", as shown in the Preview below:
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Click Refresh to update the preview or Close to return.
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Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.
In the example above, an Upper then Lower Case alphabetic series will begin with "A", incrementing by one character with each label printed, but will rollover after printing  a value of "E", as shown in the Preview below:

[image: image153.png]Ser

n - Text:

Seaizatio seltings prodce the sample seris shown below

Label 22
Label 23
Label 24
Label 25
Label 25
Label 27
Label 28
Label 23
Label 30
Label 31

A7
Aw
A
A
2z
A2
b
Ac
Ad
Ae

=
=

|

Number of samples ta displey [100 Refiesh





Click Refresh to update the preview or Close to return.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Serialization - User Defined List
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Here, a User Defined List will be used to populate this Text object in each label.
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The example shown above specifies the use of a  pre-defined list that is included with Labeler, but you can create your own lists, containing series that satisfy your needs.  

The Manage Lists... button opens Windows Explorer at the following path, allowing you to select or edit existing serial  lists:
       C:\Program Files\Wasp Technologies\Labeler5\UserDefinedLists

To create a new text file at this location:  After clicking Manage Lists..., just do a File > New > Text Document, rename it to a .txt filename of your choice, then double-click the file name to edit and eventually Save the file.
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Above, the selected User Defined List is just a text file containing the repeating sequence of  a blank record, followed by three records containing the characters A, B, and C, respectively.  These values will be printed sequentially within this Text3 object on each label.
Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.
Note:  When a User Defined List is selected as an Object Source, the values in that list will be seen in the actual printed labels, but they will not be seen in a Data Preview.  The Data Preview will instead show a default static value.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.
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There are eight possible Source Types for BarCode objects:

Static
Date/Time
Bind to Another Object
External Data
Serialization - Numeric
Serialization - Alphabetic
Serialization - User Defined List
Prompt at Print time
Static

[image: image157.jpg]2 Object Source - Label1LAB
Obict it

"BarCode"- Soutce Iype | Statc Settngs | Fomatting

Select 3 soutce type forthe object and press Next

General
@ state
€ Date/Tine
€ Bind to another Dbiect
Evtemal Data
" Databases, ODBE, Access, QuickBookse®, Delinited Text
2
Setaization
€ Numeic
€ Alghabetic
© User Defined List
Frompt a pint time

© Keyboad Enty
Convert to Substiings Keyboard Enty

Hep | |[_hen> Apply Eish





This label has five text objects, one BarCode object and one Picture object.  Above, the BarCode1 object has been given a Static source - the value supplied in Static Settings will be encoded within every label's bar code.

Click Next to proceed to the Static Settings tab:
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A Static object source allows the user to input a fixed value (i.e. "1234", "Sample Description", etc.) onto the label. This is typed in the Static Value field, and the value is displayed on the label. 

You can insert any of the ASCII characters permitted by the chosen Bar Code symbology into the static value, using the ellipse button [...] to the right of the text box.  The available characters vary with the symbology chosen.
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Select a character and click OK. It will be inserted at the cursor position.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.

Click Next to proceed to the Formatting  tab:
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You can enter separate format strings for the Bar Code and the Caption by clicking the appropriate tab next to the Format String field. If you want to include a prefix or suffix in the string, you may do so by selecting the Format Prefix or Format Suffix checkbox. For more information about character formatting in the Format String, see Character Formatting & Placeholder.

Note: The data you include in the Caption will not automatically be included in the Bar Code itself. The Caption provides you with a place to show the contents of the Bar Code in alpha-numeric characters.

Note: For UCC/EAN 128 bar codes, an ellipse button displays by the Format String field. Click this button for a list of Bar Code mask patterns.

As an example, you can use the Select Barcode Mask Pattern dialogue box if you  need to create a bar code with a serial shipping container code requiring a two-digit Application Identifier (AI).

Step 1. In the Formatting tab, select the ellipse button next to the Format String field.
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The Select Bar Code Mask Pattern dialog box displays.
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Note that the AI (00) displays to the left of the description in this box. When you select an AI from list, note that the number of characters for the selected AI, along with any other pertinent data about the formatting (such digits, alphanumeric, etc), displays in the Format of Encoded Data field. The mask pattern is displayed in the Mask Pattern field.

Step 2. Select Serial Shipping Container Code and then click Select.
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The Bar Code mask you selected displays in the Format String field.

Step 3. To ensure you have selected the appropriate mask for your Bar Code, in the Test Area, type the characters in your bar code in the test field. 
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The Test Results field shows how the characters will be formatted on the label.

If the formatting looks correct, click Apply and Finish.

The Bar Code displays with the formatted AI in the Preview area.
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For more information about formatting, see the Character Formatting and Placeholder section.



Date/Time

[image: image166.jpg]3% Object Source - LabelLLAB
Object Li:
[l BaCodet
Picure

Convertto Substings

"BarCode1"- Source Type | Date/Tine Setings |

Select 3 soutce type for the object and press Next

" Databases, ODBE, Access, QuickBookse®, Delinited Text

General
© state
& Die/ing
€ Bind o another Dbiect
Evtemal Data
2
Setaization
€ Numeic
€ Alghabetic

© User Defined List
Frompt a pint time
 Keyboard Enty

Hep |

[ b

Apply Erish





Here the BarCode1 object is being defined to have a Date/Time object source.

Click Next to proceed to Date/Time Settings:
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The Date/Time object source extracts the current date and/or time from the PC when the label is printed. Any one of multiple date/time formats can be selected. This data source option is practical when the item that is labeled must have a date and/or time associated with it for tracking.

Use the Offset by feature to offset the Years, Months, or Days of the BarCode object from the date the label is printed.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Bind to Another Object
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Here, the BarCode1 object is given the same source as another object, already defined to the label, by using Bind to another Object.

Click Next to proceed to Bind Settings:
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The Bind to Another Object data source allows multiple Text or BarCode objects to be "linked" to other Text or BarCode objects without having to duplicate the value of the other object. For example, the value of a BarCode object can be "bound" to the value of a Text object.  If the value of the Text object changes, then the value of the BarCode object will change, too.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



External Data
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External Data can be selected as the source for a BarCode object - to extract data from a field within multiple database records.

Note:  As shown in the following screen, the Wasp Barcode Labeler Special Edition for QuickBooks® Users  version can only make use of QuickBooks® data as an External Data Source:
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See Quickbooks® Support for additional information regarding its use as an External Data Source.

Click Next to proceed to the Object-to-Column Mappings form:
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If you  have previously defined a source with the External Data Source Wizard, the columns you selected there will be displayed here in the Object-to-Column Mappings drop list.  Select the column you wish to map to this BarCode object.
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If you  have not yet defined a source with the External Data Source Wizard, you will have to first click the Setup... button here to launch the External Data Source Wizard.  Once the columns have been selected from your External Data Source, you can return here to map one of them to this label object.

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Serialization - Numeric
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Here, Numeric Serialization has been selected for a  BarCode object.  
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The default Serial Settings options will generate a series that begins with a value of 1 and increments by a value of 1 with every label.  Each time this .LAB file is printed, the series will start at a value of 1.  

The Start at seed value is the initial serial number and is limited to 14 numerical digits. The Step value allows the users to skip over numbers, and Every allows the serial number to be repeated. 

Examples:

Start at seed: 3 and Step: 2  Every: 1 label will generate the series:  3, 5, 7, 9, 11, etc.

Start at seed: 2 and Step: 1  Every: 3 labels will generate the series:  2, 2, 2, 3, 3, 3, 4, 4, 4, 5, 5, 5, 6, 6, 6, etc.

Start at seed: 1 and Step: 4  Every: 2 labels will generate the series:  1, 1, 5, 5, 9, 9, 13, 13, 17, 17, 21, 21, etc.
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If the Rollover after option is enabled, the serialization routine will restart counting from the beginning seed value.   If the Reset after rollover option is set, the serialization routine will restart counting at the reset value. 

Above, the series begins at 1, increments by 1 with each label printed, but when the value 10,000 is reached, the series rolls over to begin again at a value of 1.  The Last value as next print job's seed option will allow subsequent print jobs to print labels such that the series continues where it left off - it is not reset to the original seed value.
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In this example, a Decrementing series has been defined to begin at a value of 3, decrementing by a value of 1 with each printed label, rolling over at a value of 1.  

Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Click the Preview button to see what these settings will produce:
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Click Refresh to update the preview or Close to return.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Serialization - Alphabetic
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Here, Alphabetic Serialization has been selected for a  BarCode object.  Click Next to proceed to the Serial Settings form:
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In this example, an incrementing series of Upper case alphabetic characters has been selected.
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The Upper case series will begin with the character "A", incrementing by one alphabetic character with each label printed as seen in the following Preview:
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Click Refresh to update the preview or Close to return.
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In the example above, an Upper Case alphabetic series will begin with "A", incrementing by one character with each label printed, but will rollover after printing  a value of "E", as shown in the Preview below:
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Click Refresh to update the preview or Close to return.
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Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.
In the example above, an Upper then Lower Case alphabetic series will begin with "A", incrementing by one character with each label printed, but will rollover after printing  a value of "E", as shown in the Preview below:
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Click Refresh to update the preview or Close to return.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Serialization - User Defined List
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Here, a User Defined List will be used to populate this BarCode object in each label.
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The example shown above specifies the use of a  pre-defined list that is included with Labeler, but you can create your own lists, containing series that satisfy your needs.  

The Manage Lists... button opens Windows Explorer at the following path, allowing you to select or edit existing serial  lists:
       C:\Program Files\Wasp Technologies\Labeler5\UserDefinedLists

To create a new text file at this location:  After clicking Manage Lists..., just do a File > New > Text Document, rename it to a .txt filename of your choice, then double-click the file name to edit and eventually Save the file.
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Above, the selected User Defined List is just a text file containing the repeating sequence of  a blank record, followed by three records containing the characters A, B, and C, respectively.  These values will be encoded sequentially within the BarCode1 object on each label.
Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  When a User Defined List is selected as an Object Source for a BarCode object, be aware that each value in that list must be compatible with the characters supported by the chosen symbology.  You can check for invalid character errors by doing a Print Preview prior to printing.

Note:  When a User Defined List is selected as an Object Source, the values in that list will be seen in the actual printed labels, but they will not be seen in a Data Preview.  The Data Preview will instead show a default static value.
Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.

 XE "Labels " \* MERGEFORMAT 

 XE "Enumerated labels " \* MERGEFORMAT Enumerated Labels
With enumerated labels,  the number of labels is set from an external data source. Labels are ordered to print X of X (example 1 of 8, 2 of 8, 3 of 8, etc.).

Note: This feature is only for Text objects.

The following illustration is an example of the output resulting from creating enumerated labels.
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Note: Before creating enumerated labels, you must first set up your external data source. See External Data Source Wizard for more information.

Step 1. In the Object Source dialog box, click Convert to Substrings.
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A confirmation  prompt displays:
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Click Yes.

Text1.001 displays.
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Step 2. Click Add New Substring again to add Text1.002.

Step 3. Select Text1.000, then in the Source Type tab, select Label Number N under External Data.

Note: Text1.000, Text1.002 and Text1.003 are default names. If you change the caption name for your text fields, the caption name you created will display in the Object List box. For more information about text object captions, see Text.
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Step 4. Highlight Text1.001, then in the Source Type tab, select Static under General.

[image: image195.png]“Text1.001" - Source Type | Static Settings | Substiing Details | Fomatting

Select 3 soutce type for the object and press Next

General
 stat
€ Date/Time.
 Bind to ancther Objsct




Step 5. With Text1.001 still selected, go to the Static Settings tab. In the text box, type "of".
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Note: Typing "of" in this field will set up the "X of X" format on the labels. For example., labels will print "1 of 8", "2 of 8", etc. Spaces are automatically inserted before and after the text (in this example, "of") provided in the static value field.

Step 6. Highlight Text1.002,  then in the Source Type tab, select Databases, ODBC,Access, QuickBooks®, Delimited Text under External Data.
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Step 7. Select the Object-to-Column Mappings tab.

Note: If you did not set up your external data source prior to beginning this procedure, you will need to click the Setup button in the Object-to-Column tab and complete that set up before proceeding. For more information, see External Data Source Wizard.

In this example, external data is being pulled from an Excel spreadsheet.
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Step 8. From the pull-down menu, select the column from the external data source that is used to determine the number of copies that will print.

Step 9. Click Finish.

Step 10. Click the Print Preview button. [image: image200.png]
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Step 11. In the Print Preview box, select Dynamic From Column in Data Source.

The Dynamic From Column in Data Source screen opens.
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Step 12. In the Dynamic From Column in Data Source screen, under Settings, select the column containing the numeric values that will determine how many copies of each label are printed (This should be the same column you selected in the Object-to-Column Mapping tab for Text 1.002). Click OK.

The Print Preview screen displays.
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Step 13. Click the Print Preview button.
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The enumerated labels display. You may now print the labels.

 XE "WPG " \* MERGEFORMAT 

 XE "WMF " \* MERGEFORMAT 

 XE "Windows Metafile Format " \* MERGEFORMAT 

 XE "Width " \* MERGEFORMAT 

 XE "Time " \* MERGEFORMAT 

 XE "TIF " \* MERGEFORMAT 

 XE "TGA " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Static " \* MERGEFORMAT 

 XE "Source Types " \* MERGEFORMAT 

 XE "Sizing " \* MERGEFORMAT 

 XE "Settings Tab " \* MERGEFORMAT 

 XE "Save " \* MERGEFORMAT 

 XE "RAS " \* MERGEFORMAT 

 XE "PSD " \* MERGEFORMAT 

 XE "Prompt at Print Time " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "PNG " \* MERGEFORMAT 

 XE "Placeholder " \* MERGEFORMAT 

 XE "Pixels/inch " \* MERGEFORMAT 

 XE "PCX " \* MERGEFORMAT 

 XE "PCT " \* MERGEFORMAT 

 XE "ODBC " \* MERGEFORMAT 

 XE "Object-to-Column Mappings " \* MERGEFORMAT 

 XE "Object Source " \* MERGEFORMAT 

 XE "Object List " \* MERGEFORMAT 

 XE "MS-Excel " \* MERGEFORMAT 

 XE "Mode " \* MERGEFORMAT 

 XE "Mappings " \* MERGEFORMAT 

 XE "Link " \* MERGEFORMAT 

 XE "LAB file " \* MERGEFORMAT 

 XE "JPG " \* MERGEFORMAT 

 XE "Image File " \* MERGEFORMAT 

 XE "Graphics " \* MERGEFORMAT 

 XE "External Data Source Wizard " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "EPS Encapsulated PostScript " \* MERGEFORMAT 

 XE "EPS " \* MERGEFORMAT 

 XE "DCX " \* MERGEFORMAT 

 XE "Databases " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "C " \* MERGEFORMAT 

 XE "BMP " \* MERGEFORMAT 

 XE "Bitmap " \* MERGEFORMAT 

 XE "BarCode " \* MERGEFORMAT Sources for Picture Objects
There are three possible Source Types for Picture objects:

Static
External Data
Prompt at Print time
The following image file formats may be imported as Picture objects:

 BMP Bitmap Formats

 TIF TIFF Without LZW Compression

 WMF Windows Metafile Format

 PCX, DCX PCX Formats

 JPG, CMP JPEG and LEAD Compressed

 PSD PhotoShop Format

 PNG Portable Network Graphics Format

 TGA Truevision TARGA Format

 EPS Encapsulated PostScript

 RAS SUN Raster Format

 WPG WordPerfect Format

 PCT Macintosh Pict Format

Static
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This label has five text objects, one BarCode object and one Picture object.  Above, the Picture1 object has been given a Static source - the image referred to in Static Settings will be used within every label.

Click Next to proceed to the Static Settings tab:
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A Static object source allows the user to browse to an image file on any drive available at design time.  Once the image file is selected, its path will be displayed as shown above. A copy of the image file will be stored within the .LAB file you are editing when you save the label.  

Note:  The larger the image file, the longer it will take to resize or reposition the Picture Object in design mode and the more drive space it will consume within the .LAB file.  You might want to use an external image editing application to resize an image to something closer to what is necessary for the label you are designing.  There is no limitation to the size of image Labeler can work with other than these issues of speed and drive space.

 If you are certain that the drive on which the file resides will be available in the future, at Print time, you may enable the Link to File option so that only a pointer to the image file is stored in the label's .LAB file, instead of coping the image file itself.

Click Next to proceed to the Sizing form:
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Sizing allows you to access the Stretch original image to fit given size option.  When this is enabled, the selected image will be resized to fit the Picture object dimensions you establish for the label in design mode.  An image smaller than your Picture object will be stretched to fit.  An image larger than your Picture object will be shrunk to fit. 
 If you disable the Stretch original image to fit given size option, the image will retain its original size and aspect ratio on the label.  This requires that you use an external image editing application to adjust the image dimensions as necessary to fit the layout of your label.  
Note:  When resizing an image file with your choice of image editing applications, select a resolution of 300 pixels/inch for optimum print quality, setting the width and height to match the space available on your label design.
Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.



External Data
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External Data can be selected as the source for a Picture object - to extract the path of a  from a field within multiple database records.

Note:  As shown in the following screen, the Wasp Barcode Labeler Special Edition for QuickBooks® Users version can only make use of QuickBooks® data as an External Data Source:
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See Quickbooks® Support for additional information regarding its use as an External Data Source.

Click Next to proceed to the Object-to-Column Mappings form:
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If you  have previously defined a source with the External Data Source Wizard, the columns you selected there will be displayed here in the Object-to-Column Mappings drop list.  Select the column you wish to map to this Picture object.

Note:  With the exception of ODBC sources, the external data source must not contain actual image files in this column.  It must instead contain drive,  path and filename values that point to where the images reside.    For example, a MS-Excel spreadsheet, might contain a column with values like these:

C:\My Documents\Employee Photos\Bill.jpg

C:\My Documents\Employee Photos\Bob. jpg

C:\My Documents\Employee Photos\Mary.jpg

C:\My Documents\Employee Photos\Steve.jpg

etc.

Data Preview can be used prior to printing to confirm that the paths are correct for each image.
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If you  have not yet defined a source with the External Data Source Wizard, you will have to first click the Setup... button here to launch the External Data Source Wizard.  Once the columns have been selected from your External Data Source, you can return here to map one of them to this Picture object.

Click Next to proceed to the Sizing form:
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Sizing allows you to access the Stretch original image to fit given size option.  When this is enabled, the selected image will be resized to fit the Picture object dimensions you establish for the label in design mode.  An image smaller than your Picture object will be stretched to fit.  An image larger than your Picture object will be shrunk to fit. 
 If you disable the Stretch original image to fit given size option, the image will retain its original size and aspect ratio on the label.  This requires that you use an external image editing application to adjust the image dimensions as necessary to fit the layout of your label.  
Note:  When resizing an image file with your choice of image editing applications, select a resolution of 300 pixels/inch for optimum print quality, setting the width and height to match the space available on your label design.
Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.



Prompt at Print Time (See topic here.)
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Character Formatting
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This feature formats a number or string according to instructions contained in a format expression. You can create user-defined formats with standard characters that have special meaning when used in a format expression. The format string is applied to the given Object Source to produce a new resultant string that will appear on the label.
Number Formatting
The following table shows the character you can use to create user-defined number formats and the meaning of each.
Character Meaning
0 Digit placeholder.
 Display a digit or a zero. If there is a digit in the position where the 0 appears in the format string, display it; otherwise display a zero in that position.
 If the number being formatted has fewer digits than there are zeros (on either side of the decimal) in the format expression, leading or trailing zeros are displayed. If the number has more digits to the right of the decimal separator than there are zeros to the right of the decimal separator in the format expression, the number is rounded to as many decimal places as there are zeros. If the number has more digits to the left of the decimal separator than there are zeros to the left of the decimal separator in the format expression, the extra digits are displayed without modification.
# Digit placeholder.
 Display a digit or nothing. If there is a digit in the position where the # appears in the format string, display it; otherwise, display nothing in that position.
 This symbol works like the 0 digit placeholder, except that leading and trailing zeros aren't displayed if the number has the same or fewer digits than there are # characters on either side of the decimal separator in the format expression.
. Decimal placeholder.
 The decimal placeholder determines how many digits are displayed to the left and right of the decimal separator. If the format expression contains only numbers sign to the left of this symbol, numbers smaller than 1 begin with a decimal separator. If you want a leading zero to always be displayed with fractional numbers, use 0 as the first digit placeholder to the left of the decimal separator instead.
% Percentage placeholder.
 The expression is multiplied by 100. The percent character (%) is inserted in the position where it appears in the format string.
, Thousand separator.
 The thousand separator separates thousands from hundreds within a number that has four or more places to the left of the decimal separator. Surround the thousand separator with the digit placeholders (0 or #). Two adjacent commas or a comma immediately to the left of the decimal separator (whether or not a decimal is specified) means "scale the number by dividing it by 1000, rounding as needed." You can scale large numbers using this technique. For example, you can use the format string "##0,," to represent 100 million as 100. Numbers smaller than 1 million are displayed as 0. Two adjacent commas in any position other than immediately to the left of the decimal separator are treated simply as specifying the use of a thousand separator. The actual character used as the thousand separator in the formatted output depends on the Number Format specified in the International section of the Control Panel. For some countries, a period is used as the thousand separator.
E-   E+   e-   e+     Scientific format.
 If the format expression contains at least one digit placeholder (0 or #) to the right of E-, E+, e-, or e+, the number is displayed in scientific format and E or e is inserted between the number and its exponent. The number of digit placeholders to the right determines the number of digits in the exponent. Use E- or e- to place a minus sign next to negative exponents. Use E+ or e+ to place a minus sign next to negative exponents and a plus sign next to positive exponents.
-  +  $  (  )  space Display a literal character.
 To display a character other than one of those listed, precede it with a backslash (\) or enclose it in double quotation marks (" ").
\ Display the next character in the format string.
 Many characters in the format expression have a special meaning and can't be displayed as literal characters unless they are preceded by a backslash. The backslash itself isn't displayed. Using a backslash is the same as enclosing the next character in double quotation marks. To display a backslash, use two backslashes (\\). For example, the numeric-formatting characters (#, 0, %, E, e, comma, and period) and the string-formatting characters (@, &, <, >, and !) can't be displayed.
"ABC" Display the string inside double quotation marks.
A format expression can have from one to four sections separated by semicolons. The first section applies to positive values, the second to negative values, the third to zeros, and the fourth to Null values. The following example has two sections:
"$#,##0;($#,###0)"
If you include semicolons with nothing between them, the missing section is printed using the format of the positive value.
Below are some sample format expressions for numbers. (Note: These examples assume the Country is set to United States in the International section of the Control Panel.) The first column contains the format strings. The other columns contain the output that results if the formatted data has the value given in the column headings.
Format Positive 4 Negative 4 Decimal 4
0 4 -4 1
0.00 4.00 -4.00 0.40
#,##0 4 -4 1
$#,##0;($#,##0) $4 ($4) $1
$#,##0.00;($#,##0.00) $4.00 ($4.00) $0.40
0% 400% -400% 40%
0.00% 400.00% -400.00% 40.00%
0.00E+00 4.00E+00 -4.00E+00 4.00E-01
0.00E-00 4.00E00 -4.00E00 4.00E-01
String Formatting
You can use any of the following characters to create a format expression for strings.
@ Character placeholder.
 Display a character or a space. If there is a character in the string being formatted in the position where the @ appears in the format string, display it; otherwise, display a space in that position. Placeholders are filled from right to left unless there is an ! character in the format string.
& Character placeholder.
 Display a character or nothing. If there is a character in the string being formatted in the position where the & appears in the format string, display it; otherwise, display nothing in that position. Placeholders are filled from right to left unless there is an ! character in the format string.
< Force lowercase. All characters are displayed in lowercase format.
> For uppercase. All characters are displayed in uppercase format.
! Force placeholders to fill from left to right instead of right to left.



Placeholder
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If a Text or Bar Code object is configured for Prompt at Print Time or External Data, the object or print value is unknown until print time. The 'Placeholder' tab is used to temporarily set a default value to assist the designer in alignment and placement of objects when creating a label. When Serialization is configured, the 'Seed value' is used as the placeholder.
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Each Text or Bar Code object supports a Convert to Substring option that allows the user to dynamically build a string of characters using any combination of the different Text or Bar Code Object Values. Substrings can be created using the Convert to Substrings button on the Text Object Source Type or BarCode Object Source Type forms. In essence, substrings concatenate the different values to build what appears to be a single Text or Bar Code object on the label from multiple data sources. This option can be used to (1) customize ("build") the caption of a bar code object, (2) compact or compress two or more text or bar code values from an External Data Source having different lengths, (3) compact or compress multi-line text values to remove blank lines. Note: If a Text Object is called "Text1" and is split into substrings, then the naming convention of the substrings will be Text1.0, Text1.1, Text1.2, etc.

Note: Several of the Substring features can be implemented using Character Formatting option. Please review the Character Formatting topic for further information.

The 'Add' and 'Delete' buttons are used respectively to add and delete substrings from the list of character strings. To convert a substring Text/Bar Code object back to a single Text/Bar Code object, use the 'Delete' button to remove all but the first of the substring components. 

The substring options for Text and Bar Code objects are listed below.

Text Object Substring Details
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 Ignore if previous substring entry is blank
If the External Data Source value of the previous substring is blank or empty, the contents of the substring will be ignored at the time of print. Tip: Use this option to remove a 'Static' substring value such as a comma (,) when it is used to separate two External Data Source values (e.g. Lastname, Firstname). If Lastname is null, then Lastname and the comma (,) will be not be printed on the label.
 Add a Space/Carriage Return before this substring
If checked, a space or carriage return can be automatically added before the substring value.
 Add a Space/Carriage Return after this substring
If checked, a space or carriage return can be automatically added after the substring value.



Bar Code Object Substring Details
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 Include Substring in Bar Code Caption 
If checked, the value will be displayed in the caption of a bar code.
 Include Substring in Bar Code Value
If checked, the substring value will be included in the bar code value.
Example 1:
The caption of a bar code object can be customized. This feature is often used with compliance labeling. For example, if the human readable characters of a bar code must read "(00) 0 0012345 555555555 8", the caption must be customized since the parentheses, spaces, etc. are not represented in the bar code value. (Note: Character strings cannot be split or separated if they are a single field in the database.)
To customize the caption, in the example above, configure the Bar Code object using substrings as below:
Value Bar Code Type BC Caption BC Value
( Static Checked Unchecked
AI Static Checked Checked
) & Space Static Checked Unchecked
Packaging Type External Data Source Checked Checked
Space Static Checked Unchecked
UCC External Data Source Checked Checked
Space Static Checked Unchecked
Supplier No. External Data Source Checked Checked
Space Static Checked Unchecked
Mod10 External Data Source Checked Checked
where the substrings are defined in the database as:
AI - 00
Packaging Type - 0
UCC - 0012345
Supplied No. - 555555555
Mod10 - 8
Example 2:
One common example of using substrings to compact or compress two or more values from an External Data Source is with address labels. If the Name, Address, City, State, and Zip Code are distinct fields of a database, extras spaces between the City and State fields would appear on the print out because the length of the city names differ.
For example, using seven (7) different Text Objects:
John Smith
123 Street Address
City, ST 12345
For example, using one (1) Text Object made up of seven (7) substrings:
John Smith
123 Street Address
City, ST 12345
To remove these spaces, configure the Text object using substrings as below:
Value Text Type Ignore if . . . Add Before Add After
Name External Data Source Checked N/A Carriage Return
Address External Data Source N/A N/A Carriage Return
City External Data Source N/A N/A N/A
Comma & Space Static N/A N/A N/A
State External Data Source N/A N/A N/A
Two Spaces Static N/A N/A N/A
Zip Code External Data Source N/A N/A N/A
The configuration will format the output to print as
John Smith
123 Street Address
City, ST 12345
John Smith
123 Street Address
Long City Name, ST 12345
Note: Using this configuration, if there is no "Name" in the database, the entire object will be skipped.
Example 3:
Another example with address labels is to compact or compress multi-line text values to remove blank lines. This solution can also be applied to text values with one or more address lines supporting apartment numbers, building numbers, suites, etc. As example,
Line 1 ABC Company
Line 2 John Smith
Line 3 123 Street Address
Line 4 City, ST 12345
Line 1 
Line 2 Jane Doe
Line 3 456 Street Address
Line 4 City, ST 12345
Line 1 XYZ Inc.
Line 2 
Line 3 789 Street Address
Line 4 City, ST 12345
To remove these blank lines, configure the Text object using substrings as below:
Value Text Type Ignore if . . . Add Before Add After
Company External Data Source N/A Unchecked Carriage Return
Name External Data Source Unchecked Unchecked Carriage Return
Address External Data Source Unchecked Unchecked Carriage Return
City External Data Source Unchecked Unchecked N/A
Comma & Space Static Unchecked Unchecked N/A
State External Data Source Unchecked Unchecked N/A
Two Spaces Static Unchecked Unchecked N/A
Zip Code External Data Source Unchecked Unchecked N/A
The new configuration will format the output to print as
ABC Company
John Smith
123 Street Address
City, ST 12345
Jane Doe
456 Street Address
Long City Name, ST 12345
XYZ Inc.
789 Street Address
City, ST 12345
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The Prompt at Print Time Object Source Type is used to permit Keyboard Entry of  information onto the label at print time.  Prompt at Print Time should be considered when the label information is available only at the time of print. The Prompt at Print Time information is not stored anywhere; it  is dynamically input by the user when the label is configured to print.   Prompt at Print Time can be used with  Text, Bar Code, or Picture objects.

Note:  Object Source Types other than Prompt at Print Time are discussed in these Help topics:

Object Source - Text
Object Source - BarCode
Object Source - Picture
Skip ahead to Activating the Prompt at Print Time Input Screen.

Keyboard Entry 
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Above, Prompt at Print Time Keyboard Entry  has been selected for a Text object, but the option is handled identically with BarCode and Picture objects, as well, with the exception that Picture objects have a Sizing option instead of Formatting and Placeholder.

Note:  See the Convert to Substrings topic for instruction on concatenating two or more data sources within a single object.

Click Next to proceed to the Prompt Settings tab:
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The Prompt Settings options are shown here for a Text object, but this form is identical for BarCode and Picture objects when Prompt at Print Time has been selected as the object source.
You can customize the Prompt Description and the Text Color that will be seen by the user at print time.  Up to 100 alphanumeric characters can be entered as the prompting message.  The default value for Text Objects is shown above.  An example is shown below:
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Note:  A Text Color other than Black will be more easily noticed by users at print time.

For Text and BarCode objects, click Next to proceed to the Formatting or Placeholder tabs. 

Note:  See the Character Formatting topic for instructions regarding use of the Formatting and Placeholder options.

For Picture objects, click Next to proceed to the Sizing tab:
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Sizing allows you to access the Stretch original image to fit given size option.  When this is enabled, the selected image will be resized to fit the Picture object dimensions you establish for the label in design mode.  An image smaller than your Picture object will be stretched to fit.  An image larger than your Picture object will be shrunk to fit. 
 If you disable the Stretch original image to fit given size option, the image will retain its original size and aspect ratio on the label.  This requires that you use an external image editing application to adjust the image dimensions as necessary to fit the layout of your label.  
Note:  When resizing an image file with your choice of image editing applications, select a resolution of 300 pixels/inch for optimum print quality, setting the width and height to match the space available on your label design.
Click Apply to effect your changes and then select a different Object in the Object List, or just click Finish to exit the Object Source dialog.



Activating the Prompt at Print Time Input Screen

Once the label has been populated with at least one object that has 'Prompt at Print Time' defined (and the label design is complete and ready to print), the user can activate the Keyboard Input window simply by selecting File/Print (Ctrl+P). A Print Screen will appear. From this screen, the number of label copies can be entered. After the Print button is selected, a Keyboard Input window will appear. The Keyboard Input window will automatically cycle through all the 'Prompt at Print Time' objects on the label. Data can be scanned with a bar code reader or typed into the input box. The user can step back and forth through the objects and keyboard input values using the Previous and Next buttons. A list will appear to the right displaying the keyboard enabled Picture, Text and BarCode objects and, once entered, their respective input values.  For informational purposes, all non-promptable Picture, Text and BarCode objects will also appear in a list at the bottom right of the form:
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Above, the Browse button has been used to obtain the image file path for the Picture1 object on a label to be printed. The text color (red) was chosen when the Prompt text itself was defined.   The Prompt Objects area above shows that Picture1 is the first of three objects that require Prompt at Print Time.  The Non-Prompt objects are also shown.  They are either static objects or they obtain their information from an External Data Source.   

Click Next to proceed to the next prompt:
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In response to the second of three prompts expected for this label, the employee's name has been entered for object Text1.

Click Next to advance to the next prompt:
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Here, the employee's ID number has been entered as requested for the BarCode1.1 object, the last of three Prompt at Print Time objects in this label design.

Click OK to proceed:

[image: image224.png]Keyboard Input and External Data Source - Labell.LAl

Fle Options Help
Keyboard Input for Pompt Object:

Eterthe path and il name of the emplayee’s picture:

Browse.

o continue

S | e

Type the value in enty fiekd sbove, then selectthe Next button

Copies of curent label

|- Prompt Dbjects:
Curent Object. 173

Text1- James Schiockley
BaCodet. 1- 100892

~MNon Prompt Dbjects (FYl}————

- Statstios:
Curent Labet
2/6, 0n page number: 1

Foge Setup:

(Iabels across labels down, labels per page]
238

BaCode 0 <EDS» 12100892
Tex2. <EDS> American Herltage Inst
Tex3: <EDS> 2832 Stonecreek Ad.
Textd.0- <EDS> Washingion . DC.
Terd 1. <statc>

Texd 2. <EDS> DC

Texs: Hil My name is: <statc>

Evtemal Data recard: 2/ 30





Having provided the Prompt at Print Time information required for the first of six labels on a page, we are again being prompted for the first of three objects in the second label.  The values most recently entered for each prompt are retained as a default, but can be overwritten, if necessary.

If at least one Text, Bar Code, or Picture object has 'Prompt at Print Time' defined, the labels will print according to the Page Setup. If only one label is defined on the page in the Page Setup screen, then the label will print immediately after the last keyboard input value is entered. If more than one label is defined on the page (e.g. laser sheet of labels), the Labeler software will buffer the input data for each label until the information on the last label is entered before printing. For example, if there are six labels on a page, then the Labeler will print after the last keyboard input value for the tenth label is entered (if copies is equal to one).
Wasp Labeler allows multiple copies of the current label to be printed from the Keyboard Input form. This feature allows the user to specify how many labels are to be printed. In addition, this option allows the user to optimize and specify the number of label copies on a page (e.g. label sheet) without wasting labels. The number of copies on a page is only limited by the number of actual labels defined on the page using Page Setup. For example, if the Page Setup has 10 labels per page, then the user can enter "10" Copies to fill the page and only be prompted once.
Note:  Wasp Labeler allows the user to override the print buffering process by printing immediately. This is performed by selecting the File/Print Now pull down menu on the Input screen. This function is useful at the end of a day or in the middle of a run when a job is unexpectedly halted.

Tools
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The Tools menu includes features which allow the designer to customize the design area. The Tools menu features are summarized below:
 

Units The Units option globally defines the units of measure. Inches, centimeters, and millimeters are supported and are also visibly seen on the rulers. Units effect all options which are related to measurement.
Grid The Grid menu option displays a set of grid points on the label viewing area. The Grid feature is helpful for precise positioning and resizing of objects during label design and editing.
Options Provides general options for the Wasp Labeler application.
 XE "Units " \* MERGEFORMAT 

 XE "Snap " \* MERGEFORMAT 

 XE "Measure " \* MERGEFORMAT 

 XE "Grid " \* MERGEFORMAT Grid
The Grid menu option displays a set of grid points on the label design area. The Grid feature is helpful for precise positioning and resizing of objects during label design and editing. The Grid dialog box provides editing of the divisions per unit of measure. The grid preview screen displays the grid spacing. The Grid can be displayed on the label design area by checking 'Show'.
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The 'Snap' option on the Grid dialog box allows the user to specify whether or not objects will be placed and sized according to the divisions of the grid. When 'Snap' is enabled, the positioning and sizing of objects is constrained by the position of the division marks of the grid. When 'Snap' is disabled, the user can place and size objects anywhere and in any dimension on the label.
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The Option menu selection under the Tools menu provides the general options for Wasp Labeler application. These options include mode configuration, special drawing functions, and trace logging capabilities. The details for each of these options are described below:
PREFERENCES
Show object names when selected
If checked, the Labeler application will display the names of the selected objects on the workspace design area. Tip: If this option is enabled, you can use the Select All (Ctrl+A) feature to quickly identify the names of all the objects placed on the design area.
Show Welcome on startup
If checked, the Labeler application will display the 'Welcome' form when the application is started.
Show Page Setup upon 'File/New'
If checked, the Labeler application will display the 'Page Setup' form when a new file is being created.
Prompt for Label Wizard upon ‘File/New'
If checked, the Labeler application will ask the user if they want assistance from the Label Wizard when a new file is being created.
Show reminder when connecting to QuickBooks®

If checked, the Labeler application will show a reminder message to the user each time that the Labeler is about to connect to QuickBooks®in order to extract data from QuickBooks®as an external data source. This reminder is possibly important since QuickBooks®may be running in the background and appears behind the Labeler window at the time that the Labeler is trying to connect to QuickBooks®. When this connection occurs, QuickBooks® prompts the user to ask permission before allowing the Labeler to connect to it. The QuickBooks®prompt may be in the background and hidden behind the Labeler window, thus the possible need for a reminder to the user.

Show reminder to refresh QuickBooks® data
If checked, when you perform  functions which require  Labeler to have successfully fetched your selected columns from QuickBooks®, a reminder message will suggest that you refresh your QuickBooks®data.  This is likely to occur if you have previously cancelled a fetch before it completed.  This option is enabled as a default.



PRINTING
Always print pictures as DIBs
If checked, Wasp Labeler will override the printer driver to send all Picture objects to the printer using a Device Independent Bitmap (DIB) format. This option should only be used when the manufacturer's printer driver incorrectly supports/processes direct graphic printing. 
Printer does not support multiple copies
Some printers/printer drivers erroneously communicate that they can receive a stream of multiple copies (labels).  When Labeler sends multiple labels to such a printer, only one will print at a time and Labeler will not re-transmit those that were already sent.  If you witness this problem with your printer, try enabling this option so that Labeler will send each label as independent print jobs.

Note: If your picture does not appear on the label after printing, check this option. This can be used to determine whether or not your manufacturer's printer driver supports only DIB graphics.

Send bar code as bitmap to printer

For some printers, sending the bar code directly to the printer as a bitmap is the fastest way to print the label. This option is a default setting for printing. To deselect this option, clear the checkbox.



QUICKBOOKS® SELECTION

For the English version of QuickBooks®, there are two versions - United States and Canada. You can select the version that appropriate for your business. United States is the default.



MODE

There are two modes of operation: Labeler and Print Pack. The Print Pack Mode provides a subset of Wasp Labeler functionality. The purpose of Wasp Print Pack Mode is twofold: (1) to restrict the user's ability of modifying label designs, and (2) to simplify the user interface. As an example, a warehouse manager may be responsible for creating inventory labels while a stocker may be responsible for printing the labels. This configuration can easily be achieved by the warehouse manager designing the label in the Labeler Mode and using the Print Pack Mode to limit the user's authority. In general, only print related functions are supported in the Print Pack Mode. The Labeler Mode is the default mode for the software application. The Labeler Mode is the full-featured version of the product.

Print Pack
If checked, the Print Pack Mode is enabled.
Set Password
This option provides the capability to password protect the Labeler Mode of operation:
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If a password is entered, Wasp Labeler will prompt the user for the password...
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... before allowing the user to change from the Print Pack Mode to Labeler Mode or vice versa. If no password is associated with the Print Pack Mode, then no prompt will appear when changing between modes.

To change the Mode Password, click the Change Password button on the Options dialog:
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Note:  Entering the Old Password and leaving the last two input fields blank allows you to clear the Mode Password.



TRACE
Enabled
If checked, Wasp Labeler will log information to the file shown next to the checkbox. The application will support a maximum history of ten trace log files.
Data
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The Data menu includes the options which allow the designer to import, filter, sort, and view External Data Sources. The Data menu options are summarized below:
External Data Source (F7) Specifies the data source from an external file.
Object to Column Mappings Maps Text , Bar Code, and Picture objects to columns from an external file. At least one Text, Bar Code, or Picture object must be configured to get its value from an External Data Source in order to set any mappings.
View Data Opens the External Data Source - View and Edit form allowing you to display and edit your database file.

Refresh QuickBooks® Data updates Labeler by reading the previously selected columns from QuickBooks® again.   This is available only when QuickBooks® has been selected as an External Data Source.

Filter . . . Filters the entire database table based upon the conditional settings configured by the filter operators. If information in the field(s) meets the condition required by the filter, Wasp Labeler displays only those record(s).
Sort . . . Sorts the entire database table in ascending or descending order based upon a specified number of column(s). The user can quickly sort a single column by clicking a single column header on the grid. Clicking again toggles between the ascending/descending sort order.
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 XE "Excel 4.x " \* MERGEFORMAT 

 XE "Excel 3.x " \* MERGEFORMAT 

 XE "Excel " \* MERGEFORMAT 

 XE "Driver " \* MERGEFORMAT 
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The External Data Source Wizard is used to import any ODBC, Microsoft Access, Paradox, or dBase database. Text files and Microsoft Excel worksheets can also be imported. The Labeler application can also connect to QuickBooks® as an external data source. In most cases, the data Type, data File, and data Table must be specified properly to configure an External Data Source.

For help on this topic in the Labeler for use with QuickBook®s product, skip this section and instead refer to the QuickBooks® Support help topic for more information on using an External Data Source with QuickBooks®.

See the help topic External Data Source - Create New for information on how to use the Labeler to create a new database from scratch that could then be used as an external data source. (This feature is not available in the Labeler for use with QuickBooks® version of the product.)

See the help topic External Data Source - View and Edit for information on viewing and editing the data in an external data source from inside the Labeler application. See QuickBooks Support for additional information on using QuickBooks®as an external data source.

The External Data Source Wizard can be started by pressing F7 or by using the menu to select Data > External Data Source...
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Click the Next button to proceed.
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Here, a MS-Excel spreadsheet has been selected as the source for data that will appear on the labels. Valid file types include:

Access

dBase 5

dBase IV

dBase III

Excel 5.x-7.x

Excel 4.x

Excel 3.x

Paradox 5.x

Paradox 4.x

Paradox 3.x

Quickbooks® 2002/2003

Text file, CSV file (delimited)

ODBC...

Note: Previous versions of the Wasp Labeler included support for FoxPro databases, in this version, FoxPro support is available through ODBC only.

Warning:  You must not use the value "DESC" (in any mix of upper or  lower case characters) as a name for a Table you will be accessing via an ODBC connection.  The table must be renamed to a value other than "DESC" before you can use ODBC to connect Labeler.

When using the Object Source form to create an External Data Source, you can format your database information using the 'Character FormattingCharacter_Formatting' feature.  See the Character Formatting topic for additional information.
 Type Used to specify the type of external data file that is being read.
 File Used to specify the name of the external data file.
 Table Used to select one of the tables of the external data file.  Wasp Labeler lists all of the tables contained in the external database file.

Note: You can optionally make use of the Disable Data Preview option to prevent having to wait for data to be displayed when working with large Data Sources. Disable Data Preview is not selected as a default (Data Preview will be active).

Note:The Advanced button is active only when an ODBC Data Source has been selected:

Note: If you open an existing label file that has filters and then access the External Data Source Wizard,  you will note that an extra checkbox displays on the Data Source Selection screen.
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To retain the filter and sort lists set up for this label file when setting up a new external data source, click this checkbox. Otherwise, all filters will be cleared for the new external data source.
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 When the Advanced button is clicked, the ODBC Options dialog is launched:
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Some ODBC drivers have difficulty handling square brackets [ ] in the query string.  These can be removed by selecting the first option (the default).   Square brackets [ ] can be added to table and column names by selecting the second option shown above.  The third option can be used to accommodate some drivers which require one or more special characters to be bracketed if they occur within the column name.  The default  list of special characters can be edited to include only those required by your database driver.  Click OK to accept any changes you've made or Cancel to close the dialog without making changes.



Special Notes

Access Databases

If a password-protected Microsoft Access database is selected as an External Data Source, the following Database Password prompt will be presented:
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Enter the password expected by the Access database.  This is the same password that's required to open the .mdb file directly, when using Microsoft Access.  Click OK to proceed.  

ODBC Databases

If a named ODBC data source is selected, Wasp Labeler will present a list of installed ODBC drivers read from your system. To activate the ODBC Data Source list, first select "ODBC" in the 'Type' pull down list box and then click the 'Browse' button.
QuickBooks® 2002/2003

For information on using QuickBooks® as an external data source, please see the QuickBooks® Support help topic.
Text Files
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The ability to access text files is also provided so you can import existing text files into the Wasp Labeler application. You can directly open text files that are comma, tab, space, semicolon, or custom delimited. The procedure for retrieving data from text files is similar to those used to access data in other external data sources. However, unlike other database types, text databases have no standard schema or structure that can be determined by inspection. For this reason, a SCHEMA.INI file is required that describes your text file database so that an Indexed Storage Access Method (ISAM) driver can manipulate the data.

Wasp Labeler automatically creates a SCHEMA.INI file in the same directory as the selected external text file. Note: The SCHEMA.INI file does not require any modifications by the user except under unusual circumstances. If the data in the "View and Edit" grid is displayed incorrectly (i.e. in the wrong format) the SCHEMA.INI will need to be customized by the user. 
Special Rules for Using Text Files
Null data is denoted by two consecutive delimiters. For example, if your delimiter is a comma (,), two commas (,,) denote a Null value. Tables are limited to a maximum of 256 columns. Column names are limited to 64 characters, and column widths are limited to 65,500 characters. Rows are limited to 65,543 bytes.
Customizing the SCHEMA.INI File for Text Files
The SCHEMA.INI file can be customized if the data contained in the text file is not displayed properly in the "View and Edit" grid. Since text databases have no standard schema or structure that can be determined by inspection, Wasp Labeler has to assume a data type (Bit, Byte, Short, Long, Currency, Single, Double, Text, etc.) when it is imported. Certain fields (records) may be interpreted improperly, but can be corrected by editing the SCHEMA.INI file associated with the external text file. 
The SCHEMA.INI contains the specifics of the text data source including how the text file is formatted and how it is read at import time. Note: An example of a SCHEMA.INI can be found in the examples directory specified during installation (e.g. C:\WASP\LABELER\EXAMPLES). When opening a text file, Wasp Labeler by default creates a single SCHEMA.INI file for the entire directory. The software creates new [*.TXT] sections for each text file that is opened using Wasp Labeler and stored in the same directory. The .INI file contains the appropriate Text ISAM information for each file. The format for a delimited file is specified at setup time as:
[YOURFILE.TXT]
ColNameHeader=True
Format=CSVDelimited
MaxScanRows=0
CharacterSet=OEM
Col1=username char
Col2=address char
Entry Description
ColNameHeader Can be set to either True (indicating that the first record of data specifies the column names) or False. The default is True.
Format Can be set to one of the following values: CSVDelimited (comma), TabDelimited or Delimited(single character delimiter). The delimiter specified for the Delimited file format can be any single character except a double quotation mark ("). The default is CSVDelimited.
MaxScanRows Indicates the number of rows to be scanned when guessing the column data types. If this is set to 0, the entire file is searched. The default is 0.
CharacterSet Can be set to OEM or ANSI, indicating whether the source file is written using an OEM or ANSI code page. The default is OEM.
Col1, Col2, ... Optional: Lists the columns in the text file to be read. Used to customize the definitions of the columns of the external text file. See example above. The format of this entry should be: 
 Coln=columnName type
 columnName Column names with embedded spaces should be enclosed in quotation marks.
 type Bit, Byte, Short, Long, Currency, Single, Double, Char (i.e. Text).
A 'Coln' entry (Col1, Col2, etc.) can be entered into the SCHEMA.INI file for each column of the database that precisely describes how the column is to be interpreted. If a column is being interpreted improperly, edit the SCHEMA.INI file using a text editor (e.g. Notepad) and specify the 'Coln' entry as 'char' (see table above or SCHEMA.INI file in EXAMPLES directory). The text database driver will then interpret the column as literal and will not reformat the column. A format should be entered for each column.

 XE "Text " \* MERGEFORMAT 

 XE "Table " \* MERGEFORMAT 

 XE "Microsoft Access " \* MERGEFORMAT 

 XE "Mdb file " \* MERGEFORMAT 

 XE "Integer Stores numbers " \* MERGEFORMAT 

 XE "Integer Stores " \* MERGEFORMAT 

 XE "Integer " \* MERGEFORMAT 

 XE "External Data Source - Create New " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "Delete button " \* MERGEFORMAT 

 XE "Delete " \* MERGEFORMAT 

 XE "Decimal " \* MERGEFORMAT 

 XE "Databases " \* MERGEFORMAT 

 XE "Currency " \* MERGEFORMAT 

 XE "Create New button " \* MERGEFORMAT 

 XE "Create Database " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Boolean " \* MERGEFORMAT 

 XE "Add button " \* MERGEFORMAT External Data Source - Create New

Wasp Labeler provides the capability to create an external data file using the Create New button on the External Data Source form. Wasp Labeler generates a Microsoft Access database (*.mdb extension) and provides the capability to create a single database table by entering the Table Name and column(s) associated with the table. Each column has a single data type that specifies the type of data stored in the column fields. The list of data types that can be created by Wasp Labeler are identified below:

Note:  Use this only when you want to create labels that will be composed of one or more variable fields,  for which you do not currently have an external data source from which to pull that variable data.

[image: image237.png]External Data Source Wizard - Label6.LAB x|

Intioduction Sources | 1. Data Source [

m Step 1. Data Source Selection

2 TabesiLinks ()

Source Type: [Access Create o 3.Columns.

Eie Neme: Browse.

pr—

[ %
D am—r——

D e e

I™ Disable Data Previen

b ™ g oo <ok Eatwisd





Click the Create New button to begin...
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Supply a File name and select a location for the .mdb file.  Do not change the file type.
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Supply a Table name.  Note:  Only one table can be created using this feature of Labeler.

[image: image240.png]Create Database Table - Label3.LAB.

~Database

Table

Customers

Name: C:\Program Fies..AMyNewDatabase.mdb

Nare:

Tupe:

~Define New Colum:

Listof Columns:





For each Column  (field) you wish to define in the table, enter a Name, select the appropriate data Type, then click the Add button to add it to the List of Columns.   Continue to add multiple columns and click OK when finished. See the External Data Source - View and Edit topic to update your new database.

Valid data Types include:  

Boolean Contains only one of two values -1 (True/On) or 0 (False/Off). Storage size 1 byte.

Byte Stores numbers from 0 to 255 (no fractions). Storage size 1 byte.
Currency Currency values and numeric data used in mathematical calculations involving data with one to four decimal places. Accurate to 15 digits on the left side of the decimal separator. Storage size 8 bytes.
Double Stores numbers from -1.79769313486232E308 to 1.79769313486232E308. Storage size 8 bytes.
Integer Stores numbers from -32,768 to 32,767 (no fractions). Storage size 2 bytes.
Long Integer Stores numbers from -2,147,483,648 to 2,147,483,647 (no fractions). Storage size 4 bytes.
Single Stores numbers from -3.402823E38 to 3.402823E38. Storage size 4 bytes.
Text Text or combinations of text and numbers, as well as numbers that don't require calculations. Up to 255 characters can be entered.
Use the Delete button to remove a highlighted Column from the List.

Click OK when you are finished defining columns.
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Click the Yes button to proceed to editing your External Data Source:
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See the External Data Source - View and Edit topic for more information on using this dialog.
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The data you've created in your new database will be displayed when you proceed to  the External Data Source Wizard's Table Selection dialog.

 XE "View External Data Source " \* MERGEFORMAT 

 XE "View " \* MERGEFORMAT 

 XE "Unselect " \* MERGEFORMAT 

 XE "Top " \* MERGEFORMAT 

 XE "Toolbar " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Table " \* MERGEFORMAT 

 XE "Specify Number " \* MERGEFORMAT 

 XE "Sort Criteria " \* MERGEFORMAT 

 XE "Sort " \* MERGEFORMAT 

 XE "Row " \* MERGEFORMAT 

 XE "Read Only " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Page Layout " \* MERGEFORMAT 

 XE "ODBC " \* MERGEFORMAT 

 XE "Mappings " \* MERGEFORMAT 

 XE "Help " \* MERGEFORMAT 

 XE "Grid " \* MERGEFORMAT 

 XE "Filter Criteria " \* MERGEFORMAT 

 XE "Filter Applies " \* MERGEFORMAT 

 XE "Filter " \* MERGEFORMAT 

 XE "F9 " \* MERGEFORMAT 

 XE "F5 " \* MERGEFORMAT 

 XE "External Data Source - View and Edit " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "Edit External Data Source " \* MERGEFORMAT 

 XE "Databases " \* MERGEFORMAT 

 XE "Ctrl+P " \* MERGEFORMAT 

 XE "Criteria " \* MERGEFORMAT 

 XE "Column Mappings " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Bar Codes " \* MERGEFORMAT 

 XE "Ascending/descending sort " \* MERGEFORMAT External Data Source - View and Edit

Wasp Labeler provides the capability to view and edit  your database file using the F9 key (Data > View Data).  (Note: ODBC databases and QuickBooks® are  read-only data sources, by default, and can not be made writable unless you have SQL administration privilege.)   The database table is presented in a grid that is 'Read Only' by default.  The database can be updated by unchecking the Read Only checkbox and then typing directly into a grid cell (or row/column). Once the cursor position (focus) is moved off of the grid cell, the record is permanently changed in the database file. The rows and columns of the grid can be resized with your mouse by "stretching" the edge of the column and/or row.
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This view of the External Data Source shows that no Filter or Sort Criteria have been applied.
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Here, the External Data Source is shown with both Filter and Sort Criteria applied.  

Note:  Only those records which satisfy the currently selected  Filter Criteria can be edited until the Filter toolbar button is clicked to alter the Filter Criteria.

To select a record (row), click on the indicator on the left side of the row.  

   Note:  No more than 100 records can be selected at a time.

To sort a column, click on the header at the top of the column.

To use the External File feature to get the data source for Text or Bar Code objects, the column(s) of the database must map to an existing object on the label design. The Object to Column Mapping option is used to display the available Text, Bar Code, or Picture objects that can be mapped to a single database column. Use the 'Data/Object to Column Mapping' menu item or click the 'Mappings' button to activate the form.
Each of the pull down menu options for the 'External Data Source- View and Edit' form are listed below:
File
Object to Column Mappings Maps Text and Bar Code objects to a single column within an external file. At least one Text, Bar Code, or Picture object must be configured to get its value from an External Data Source in order to set any mappings.
Print Preview Provides the preview of the page layout of the database records selected before printing the labels. Three options are supported:
 All Records
 Selected Records
 Unselected Records
Print (Ctrl+P) Specifies the number of labels and copies to print.
 All Records
 Selected Records
 Unselected Records
Close Closes the 'External File -View and Edit' form.


Edit
Unselect All Unselects all records that are currently selected in the database grid.


Records
Sort Sorts the entire database table in ascending or descending order based upon a specified number of column(s)The user can quickly sort a single column by clicking a single column header on the grid. Clicking again toggles between the ascending/descending sort order.

You can also make use of the Sort toolbar button to select previously defined sort criteria or to create a new sort criteria.

Filter . . . Filters the entire database table based upon the conditional settings configured by the filter operators. If information in the field(s) meets the condition required by the filter, Wasp Labeler displays only those record(s).

The Filter toolbar button can be used to select previously defined filter criteria or to create a new filter criteria.

Sort Applies Sort criteria.
Filter Applies Filter criteria.

Refresh (F5) Refreshes the table grid from the original database source.


Help Provides the help topic for the 'View and Edit' form.

 XE "XLS file " \* MERGEFORMAT 

 XE "View " \* MERGEFORMAT 

 XE "Use First Row As Column Header " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Table " \* MERGEFORMAT 

 XE "Right " \* MERGEFORMAT 

 XE "Print Preview " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "ODBC " \* MERGEFORMAT 

 XE "Link " \* MERGEFORMAT 

 XE "External Data Source Wizard " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "Example Labels " \* MERGEFORMAT 

 XE "DESC " \* MERGEFORMAT 

 XE "Delimiter " \* MERGEFORMAT 

 XE "Delimited " \* MERGEFORMAT 

 XE "Delete button " \* MERGEFORMAT 

 XE "Delete " \* MERGEFORMAT 

 XE "Data Preview " \* MERGEFORMAT 

 XE "Customers " \* MERGEFORMAT 

 XE "Customer No " \* MERGEFORMAT 

 XE "CSV file " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Bar Codes " \* MERGEFORMAT 

 XE "Auto Link " \* MERGEFORMAT 

 XE "Advanced button " \* MERGEFORMAT 

 XE "Add Link " \* MERGEFORMAT Tables and Links

After selecting an External Data Source, one or more tables (or spreadsheets) can be selected for use with the label you are designing.

Note:  You can not select more than one External Data Source, but you can select more than one Data Table within a single Data Source.

Warning:  You must not  use the value "DESC" (in any mix of upper or  lower case characters) as a name for a Table you will be accessing via an ODBC connection.  The table must be renamed to a value other than "DESC" before you can use ODBC to connect Labeler.
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Click the Next button to proceed.
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If you have selected more than one Data Table, select the ones containing the fields you wish to use by clicking to put checkmarks in the appropriate boxes.  Text files, like those shown above, require that you specify the character used to delimit fields within each record. 

Note:   Labeler supports the following delimiters for .txt or .csv files:  Comma, Tab, Space, Semi-Colon, or Other.  When Other is selected from the Delimiter drop list, the field to the right of the Delimiter list will allow you to specify the unique character that was used to delimit the data in the selected text file.

The Use First Row as a Column Header option is enabled as a default.  This option allows you to instruct Labeler to assume that the values found in the first data record are column headers, not actual data.  If actual data resides in the first record of the selected .txt or .csv file, you must disable this option.

[image: image248.png]x|
Inroduction. Tables | Links | 1. Data source [
m Step 2.1 Data Table Selection

Cick 3 whitebos to select/dsselect  Data Preview: Sheet2$
atable

2 TabesiLnks ()

L
2 [
: —
0
B

DO sheat3$

Summary

5 4
— s

[CovmoronT

b D Sk nocion e





Here, tables are being selected for a .XLS file that contains three spreadsheets. 
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 In this example, all three spreadsheets (tables) contain data needed to produce the desired labels.  A data preview of the most recently selected table is displayed to the right of the selection list.  Click Next to continue.
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Having selected more than one table, you must now create at least one Link to each.

Note:  This step is not used when only one table has been selected.

Click the Auto Link button to see if the External Data Source Wizard can locate similar fields with which to link the selected tables.
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Here, Auto Link has added two links - one between the Customer No. field in Sheet1$ and a like-named field in Sheet2$; the other between the like-named Discount fields in Sheet2$ and Sheet3$.  To link the fields, their names do not have to be the same as in this example, but the data format must be the same.  More importantly, the data must be related logically.  

Click on the Advanced button to see the selected tables and links displayed graphically, as follows:
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If you want to remove a link, right-click on it to access a Delete button.

To Add a new link, drag a column from one table to the corresponding column in another table

   -or-

Use the Add Link button when not in the Advanced dialog, to access the Add External Data Source Link function:
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Above, the Customer No. fields of Sheet1$ and Sheet2$ are being linked manually (not using Auto Link).  Click Add Link when you have selected a field from each of the two tables being linked.
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The link will be displayed, as shown.  Click the Add Link button again, or use  the Advanced button, as shown below, to add another link:
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Dragging the Discount column from Sheet2$ its counterpart in Sheet3$, a second link is created, as shown below:
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In this example, none of the columns in Sheet2$ will actually be used in the label (see example label, below).  Sheet2$ was included as a selected table for only one purpose - to provide a path to query the Discount Code (D, in the example bar code)  that will be appended to Customer No. (27, in the example bar code).  Normally, you would only select and link tables that contain data intended for use in your label, but it's possible, as shown here, to employ a table for the sole purpose of establishing links to the data you need in tables that could otherwise not be linked for lack of a common field.
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Note: This example label was taken from the Print Preview function after  completing the label design process.

Click OK to exit the Advanced view and then Next to proceed to the External Data Source Wizard's Data Column Selection function.
 XE "Table " \* MERGEFORMAT 

 XE "Selected Column List " \* MERGEFORMAT 

 XE "Select All " \* MERGEFORMAT 

 XE "Right " \* MERGEFORMAT 

 XE "Remove All " \* MERGEFORMAT 

 XE "Delete " \* MERGEFORMAT 

 XE "Data Column Selection " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT Data Column Selection

Data Column Selection is used to define which columns, of all  those within the selected tables,  will be eligible for use in the label you are designing.
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Click Next to proceed...
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Click the check boxes to select the columns you want to use your label.  As Columns are selected on the left side of this dialog, they are added to the Selected Column List on the right.

The Select All button can be used to add every column from every previously selected table to the Selected Column List.

The Remove or Remove All buttons can be used to delete a column from the Selected Column List.

Click the Next button to proceed to the Filter and Sort functions.

 XE "Toolbar " \* MERGEFORMAT 

 XE "Table " \* MERGEFORMAT 

 XE "Row " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Filtering External Data " \* MERGEFORMAT 

 XE "Filter Settings button " \* MERGEFORMAT 

 XE "Filter Criteria " \* MERGEFORMAT 

 XE "Filter " \* MERGEFORMAT 

 XE "F9 " \* MERGEFORMAT 

 XE "F7 " \* MERGEFORMAT 

 XE "Delete " \* MERGEFORMAT 

 XE "Default button " \* MERGEFORMAT 

 XE "Data Preview " \* MERGEFORMAT 

 XE "Customers " \* MERGEFORMAT 

 XE "Criteria " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Add button " \* MERGEFORMAT Filtering External Data

By filtering a table, you can display just the records (rows) that meet the criteria you specify. For example, if the external file contains a list of item numbers, descriptions, and quantity in stock, you can display only the item numbers that are out of stock (QTY=0). This feature is primarily used to select which labels to print.
The software also provides an advanced filtering scheme to group  operations together.  
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Click Next to proceed:
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Here, with no filter applied yet, the Data Preview displays records all the records selected via the Tables/ Links and Data Column selections made previously.  

Click the Filter Settings button to modify the Filter Criteria:
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Click the Add button to create a new filter criteria:
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Use the drop lists to specify which Table and Column value a record must match to pass the filter you are creating.  Use the parentheses at each end of the criteria being created in conjunction with the AND operator to create complex filters. 

You can also use this screen to set up a prompt to allow the user to filter data when Print is selected for the given labels. Click here for information on how to set up a prompt. 
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Above, the newly created criteria named "Customers in Texas" has been selected as the default filter for this label.  Any number of Filter Criteria can be created, but only one can be made the Default. This is done by selecting the desired criteria and clicking the Set as Default button. 

Note:  The default criteria can be overridden just prior to printing via the Filter toolbar button on the View Data form (F9) or by returning to the dialog above (F7).

Click Add to create another Filter Criteria, Delete to remove a Criteria, or Edit to modify a Criteria.  

After defining Filter criteria and setting a default, click Close to return:
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Click Next to proceed to Sort Criteria Creation. 

 XE "Zip Code " \* MERGEFORMAT 

 XE "Toolbar " \* MERGEFORMAT 

 XE "Time " \* MERGEFORMAT 

 XE "Table " \* MERGEFORMAT 

 XE "Sorting External Data " \* MERGEFORMAT 

 XE "Sort Settings button " \* MERGEFORMAT 

 XE "Sort Criteria " \* MERGEFORMAT 

 XE "Sort " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Filter Criteria " \* MERGEFORMAT 

 XE "Filter " \* MERGEFORMAT 

 XE "F9 " \* MERGEFORMAT 

 XE "F7 " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT 

 XE "Descending " \* MERGEFORMAT 

 XE "Delete " \* MERGEFORMAT 

 XE "Default button " \* MERGEFORMAT 

 XE "Data Preview " \* MERGEFORMAT 

 XE "Customers " \* MERGEFORMAT 

 XE "Criteria " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Add button " \* MERGEFORMAT Sorting External Data

Labeler supports the ability to sort data extracted from the external data source. Sorting is used to order the data at print time.  You might, for example,want to print mailing labels in zip code order. For conference badges, you might want to sort by customer name.
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Click the Sort Settings button to modify the Sort Criteria:

[image: image267.png]=lolx|

Cick the Add bt o creale  new st rtra, o selec an eisting so rteia and lck he Delte, Edt or Set as Defaut < |
buton

Instructions:

1]

St Citeria List Data PreviewNo Sort
Name. Staus__[ Citeria [Shest1$] Customer ... | [Shest1s,
£ No Sart Default ‘73 gav‘sw
2 Terence
5 Gerald R

Hep | add Dt Edt Sefs Defeill |





Above, with no sort criteria applied yet, the Data Preview displays records that have passed the filter created previously, but they are shown (and without sorting would print) in the same sequence as they occur within the external data.

Click the Add button to create a new Sort criteria:
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Give the Sort Criteria a Name of your choosing.  Then use the drop lists to specify which Tables and Columns should be used  to control the sort and whether each column should be sorted Ascending or Descending. Use the AND operator to create complex sorts.

In the example shown, those records satisfying the filter criteria, if any, will be sorted Ascending first by Company Name, then by Name (customer name).

Click OK to return:
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Above, the newly created criteria named "Sort by Company then by Name" has been selected as the default sort for this label.  Any number of Sort Criteria can be created, but only one can be made the Default. This is done by selecting the desired criteria and clicking the Set as Default button. 

Note:  The default criteria can be overridden just prior to printing via the Filter toolbar button on the View Data form (F9) or by returning to the dialog above (F7).

Click Add to create another Sort criteria, Delete to remove a criteria or Edit to modify a criteria.  

Click Close to return:
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Click Next to proceed to the External Data Source Wizard Summary.

 XE "Summary " \* MERGEFORMAT 

 XE "External Data Source " \* MERGEFORMAT Configuration Summary

Configuration Summary tracks whether or not you have completed the four steps necessary to configure an External Data Source.
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Click Exit Wizard to return to your label design.

 XE "Text Object Mappings " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Picture Mapping " \* MERGEFORMAT 

 XE "Object-to-Column Mappings " \* MERGEFORMAT 

 XE "Object to Column Mappings " \* MERGEFORMAT 
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 XE "Graphics " \* MERGEFORMAT 
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 XE "Column Mappings " \* MERGEFORMAT 

 XE "Column " \* MERGEFORMAT 

 XE "Bar Codes " \* MERGEFORMAT Object to Column Mappings

 'Object to Column Mappings' is used to map Text, Bar Code and Picture objects to columns within an external file. At least one Text, Bar Code, or Picture object must be configured to get its value from an External Data Source in order to set any mappings. If no objects have the External Data Source value set, then no objects will appear in the 'Object-To-Column-Mapping' list.
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Every Text or Bar Code object that has the 'External Data Source' value set will appear in the 'Object-To-Column-Mappings' list. To configure a mapping, select the label object from the list box and use the drop down box to display the database columns.
Note: For mapping Picture objects, the object can be mapped to (1) a Text column: for the graphic's filename, or (2) Long Binary column: when the column actually contains the raw graphic data in any of the supported graphic formats.

The design shown below evidences the mappings made in the example above.

[image: image273.png]Hi! My name is:
'Text1:[Sheet1$].Name'
Text2:[Sheet1$].[Company Name]"

Text3:[Sheett$].[Address 1]'
Textd.0:[Sheet1$].City", Textd.2:[Sheetl§].State’

1234123





This produces labels formatted as seen in this example taken from a Print Preview:
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Step 1. To add an object to your label, select one of the object types from the ToolBox on the left side of the Main window. For this example, select the ToolBox button that looks like a bar code. Once the bar code button from the ToolBox has been selected, position your mouse over the label design area and click the left mouse button to create a new Object on the design area. At this point, you should see the newly added Object with the Object Name of 'BarCode1'.
Step 2. Now that you have added the 'BarCode1' object to your label, notice that the bar code is 'selected'. This is denoted by the dots that appear on the perimeter of the bar code object. After the initial insertion, you now may type in the entry field to change the static value of the bar code. For this example this is not necessary, as we will be pulling the data for our labels from an external file. 
Step 3. To connect to an 'External Data Source' for a BarCode or Text object, select the object with the left mouse button - notice that the selection dots will now appear to indicate that the object is selected. Keeping the mouse in position over the selected object, use the right mouse button to show a pop up menu for the selected object. Bring up the 'Properties' box for an object by selecting the objects with the left mouse button and using the right mouse pop-up 'Properties' menu choice. (You may also use the 'Format | Properties' menu choice on the Main window to accomplish this as well, or use the F4 accelerator key.)
Step 4. For each object type, the 'Properties' box will contain most of the common attributes and settings for the given selected object. (The 'Properties' box serves as a floating window. You do not need to close it. If you wish, simply move it out of the way or to the side of your screen). Draw Style, size, position, and color are some of the edit properties. To edit any of the attributes, choose the appropriate 'Properties' tab, and then click the mouse in the text area of any one of the property fields. When changing the attributes within the Properties box, notice that you easily see your changes reflected in the label design area.
Step 5. For easy selection of any other object, notice that there is also a dropdown box at the top of the Properties box that allows you to select any object by name.
Step 6. For Text and BarCode objects, advance features exist for setting and/or getting the source value for the object. These features are accessible via the Object Source window. To bring up the 'Object Source' window for an object, select the object with the left mouse button and choose the right mouse pop-up 'Source' menu choice. (You may also use the 'Format | Source' menu choice on the Main window, or the F6 function key).
Step 7. The 'Source Type' window for Text and BarCode objects allows great flexibility in determining what the value for the object is to be at print time. Text and BarCode objects support Static, Serialization, Prompt at print time, Date/Time, Bind to another Object, and External Data Source for creating and placing specific information onto the label. For this example we will be working with the 'External Data Source'.
The External Data Source Wizard is used to import data from any ODBC Compliant Database, Microsoft Access Database, Paradox Database, dBase Database, Text file or Microsoft Excel worksheet to populate fields on your label. Select the 'External Data Source' item from the list and then click on the 'Setup' button.
Step 8. On this screen the File Type, File Name, and Table must be entered. All three of these must be specified to properly configure an External Data Source. 
Note: Previous versions of the Wasp Labeler included support for FoxPro databases, in this version, FoxPro support is available through ODBC only.
The chart below explains all of the 'Setup External Data Source' menu items:
Type: Used to specify the type of external data file that is being read.
File: Used to specify the name/path of the external data file.
Table: Used to select one of the tables of the external data file. Wasp Labeler lists all of the tables contained in your external database file.
Step 9. After filling out the required information and linking to your external file, click the 'View' button at the bottom of the page. This will open your database file and allow you to see all of your data. If your data appears correctly press the 'Mappings' button at the bottom of the window. This will bring up the 'Object to Column Mappings' menu.
Step 10. The 'Object to Column Mappings' menu is used to map Text, Bar Code and Picture objects to columns within an external file. At least one Text, Bar Code, or Picture object must be configured to get its value from an External Data Source in order to set any mappings. Every Text or Bar Code object that has the 'External Data Source' value set will appear in the 'Object-To-Column-Mappings' list. To map a column in your file to an object on the label, select the label object (text, barcode, etc.) from the list box and use the drop down box on the right side of the menu to select the database column you want to pull the data from.
Special Notes
ODBC DATABASES
If a named ODBC data source is selected, Wasp Labeler will present a list of installed ODBC drivers read from your system. To activate the ODBC Data Source list, first select "ODBC" in the 'Type' pull down list box and then click the 'Browse' button.
TEXT FILES
The ability to access text files is also provided so you can import existing text files into the Wasp Labeler application. You can directly open text files that are comma, tab, space, semicolon, or custom delimited. The procedure for retrieving data from text files is similar to those used to access data in other external data sources. However, unlike other database types, text databases have no standard schema or structure that can be determined by inspection. For this reason, a SCHEMA.INI file is required that describes your text file database so that an Indexed Storage Access Method (ISAM) driver can manipulate the data.
Wasp Labeler automatically creates a SCHEMA.INI file in the same directory as the selected external text file. Note: The SCHEMA.INI file does not require any modifications by the user except under unusual circumstances. If the data in the "View and Edit" grid is displayed incorrectly (i.e. in the wrong format) the SCHEMA.INI will need to be customized by the user. 
Special Rules for Using Text Files
Null data is denoted by two consecutive delimiters. For example, if your delimiter is a comma (,), two commas (,,) denote a Null value. Tables are limited to a maximum of 256 columns. Column names are limited to 64 characters, and column widths are limited to 65,500 characters. Rows are limited to 65,543 bytes.
Customizing the SCHEMA.INI File for Text Files
The SCHEMA.INI file can be customized if the data contained in the text file is not displayed properly in the "View and Edit" grid. Since text databases have no standard schema or structure that can be determined by inspection, Wasp Labeler has to assume a data type (Bit, Byte, Short, Long, Currency, Single, Double, Text, etc.) when it is imported. Certain fields (records) may be interpreted improperly, but can be corrected by editing the SCHEMA.INI file associated with the external text file. 
The SCHEMA.INI contains the specifics of the text data source including how the text file is formatted and how it is read at import time. Note: An example of a SCHEMA.INI can be found in the examples directory specified during installation (e.g. C:\WASP\LABELER\EXAMPLES). When opening a text file, Wasp Labeler by default creates a single SCHEMA.INI file for the entire directory. The software creates new [*.TXT] sections for each text file that is opened using Wasp Labeler and stored in the same directory. The .INI file contains the appropriate Text ISAM information for each file. The format for a delimited file is specified at setup time as:
[YOURFILE.TXT]
ColNameHeader=True
Format=CSVDelimited
MaxScanRows=0
CharacterSet=OEM
Col1=username char
Col2=address char
ColNameHeader
Can be set to either True (indicating that the first record of data specifies the column names) or False. The default is True.
Format
Can be set to one of the following values: CSVDelimited (comma), TabDelimited or Delimited(single character delimiter). The delimiter specified for the Delimited file format can be any single character except a double quotation mark ("). The default is CSVDelimited.
MaxScanRows
Indicates the number of rows to be scanned when guessing the column data types. If this is set to 0, the entire file is searched. The default is 0.
CharacterSet
Can be set to OEM or ANSI, indicating whether the source file is written using an OEM or ANSI code page. The default is OEM.
Col1, Col2, ...
Optional: Lists the columns in the text file to be read. Used to customize the definitions of the columns of the external text file. See example above. The format of this entry should be:
Coln=columnName type
ColumnName
Column names with embedded spaces should be enclosed in quotation marks.
type Bit, Byte, Short, Long, Currency, Single, Double, Char (i.e. Text).
A 'Coln' entry (Col1, Col2, etc.) can be entered into the SCHEMA.INI file for each column of the database that precisely describes how the column is to be interpreted. If a column is being interpreted improperly, edit the SCHEMA.INI file using a text editor (e.g. Notepad) and specify the 'Coln' entry as 'char' (see table above or SCHEMA.INI file in EXAMPLES directory). The text database driver will then interpret the column as literal and will not reformat the column. A format should be entered for each column.

Window

 XE "View " \* MERGEFORMAT 

 XE "Save " \* MERGEFORMAT 

 XE "Multiple Document Interface " \* MERGEFORMAT 

 XE "Arrange Icons " \* MERGEFORMAT Window
Wasp Labeler supports the Multiple Document Interface (MDI). MDI provides the capability of editing two or more label files concurrently. The Window menu options provides methods for rearranging MDI windows. Tip: Use this feature to copy objects from one file to another. The Window menu options are summarized below:
Tile Rearranges all open windows so that each window is displayed at an equal size in the label viewing area.
Cascade Stacks and overlaps all open windows so that you can view the title bars for each window.
Arrange Icons Arranges all minimized windows along the bottom of the label viewing area.
Minimize All Minimizes each window from the label viewing area and reduces each window to an icon.
Restore All Restores the position and size of each minimized window.
Close All Closes all windows currently open. A form is displayed allowing you to select which files to save.
Window List Select from the list of open label files.
Help

 XE "Web " \* MERGEFORMAT 

 XE "Update License Allows " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Tech Support " \* MERGEFORMAT 

 XE "Press F1 " \* MERGEFORMAT 

 XE "Index " \* MERGEFORMAT 

 XE "Help " \* MERGEFORMAT 

 XE "F1 " \* MERGEFORMAT 

 XE "Email " \* MERGEFORMAT 

 XE "E-mail " \* MERGEFORMAT Help
The Wasp Labeler Help is all on-line. Click on the 'Help' Toolbar button or pull down 'Help' from the menu item or press F1 to access additional information.

· Contents Displays the Contents of the on-line Help for Wasp Labeler.
· Search Help On Displays a search form for the topics covered in the on-line Help for Wasp Labeler.
· Help on Help Displays the Windows Help for using on-line Help.
· Index Displays the Index of the on-line Help for Wasp Labeler.

· Update License Allows entry of a 19-digit Serial Number (License Key) for upgrade. Can be entered with or without dashes.
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· Visit us on the Web...  Provides a dialog that can launch Internet Explorer to take you to Wasp's web site.
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Click Yes to browse the Wasp Technologies web site.

· About Displays the Wasp Labeler version and copyright information.

Thermal Printers
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 XE "Proprietary Printer Languages " \* MERGEFORMAT 

 XE "Properties " \* MERGEFORMAT 
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 XE "Printer Setup " \* MERGEFORMAT 

 XE "Printer " \* MERGEFORMAT 

 XE "Print spooler " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "NT " \* MERGEFORMAT 

 XE "Mode " \* MERGEFORMAT 

 XE "LPT " \* MERGEFORMAT 

 XE "Generic/Text Only " \* MERGEFORMAT 

 XE "Driver needs " \* MERGEFORMAT 

 XE "Driver " \* MERGEFORMAT 

 XE "COM " \* MERGEFORMAT 

 XE "ASCII " \* MERGEFORMAT Thermal Printers

Note: Thermal Printer support is only available with the Thermal Printer version of the Wasp Labeler.
Wasp Labeler can print directly to many label printers without requiring a Windows driver specific for that printer. The terms "Thermal Printers" or "Non-Windows Printers" refer to this mode, where Wasp Labeler communicates directly with the printer using the printer's proprietary language (i.e. a Windows printer driver is not used). This feature provides a "backward compatibility" for enhancing performance and optimizing the label throughput between Wasp Labeler and your thermal transfer or thermal printers without using vendor-supplied or third-party Windows drivers. (Note: The Thermal Printer feature is optional and should only be used when your printer is not optimized for Windows printing. Please consult with your printer manufacturer to determine the optimal configuration of your printer.)
Spooled, Directly to Port, and File
There are three ways to transfer (i.e. print) Wasp Labeler output natively to your printer: 'Spooled', 'Directly to a Port', and 'File'. Each of these options is automatically enabled and disabled when a 'Port' is selected. For example, if there is no Generic/Text Only printer driver installed for port LPT1, the Windows Print Spooler option will be disabled; or, if the port is set to a network printer, the 'Directly to Port' option is not valid.
Spooled
This option gives the best performance, since Windows can automatically spool the print jobs for you, and you can continue using Wasp Labeler while your labels are printing. Since Wasp Labeler does not use a Windows Driver specific to your printer in this mode, a "Generic/Text Only" driver needs to be loaded. This driver comes standard with Windows, and can be installed from your Windows CD or floppy disks. Note: Even though this option requires a "Generic/Text Only" printer driver, Wasp Labeler will send the printer's proprietary language to achieve maximum performance of the printer while at the same time using the print spooling capabilities of Windows.

This option also supports printing over your network. For example, you can print from your desk to a printer in the warehouse if a "Generic/Text Only" driver exists on the warehouse PC and is shared on your network.
To use this option, follow these steps:
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1. Install a Generic/Text Only Windows driver from your Windows 3.1, 95, or NT CD-ROM or floppy disks. In Windows 95 or NT, go to 'Start', 'Settings', 'Printers'. Double-click 'Add Printer'.
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2. Once the driver is installed, modify the 'Generic/Text Only' properties. Select the appropriate printer path from the 'Print to the following port:' option from the 'Details' tab or button if using Windows 3.1. IMPORTANT: You must share any network printers first before they will become visible in this list box. The 'Print using the following driver:' option should list 'Generic/Text Only'.
3. Modify 'Spool Data Format' so that the 'RAW' option appears in the list box. Select 'OK' to accept the new configuration. Select 'OK' again to close the driver's 'Properties' form.
4. Open the Wasp Labeler application. Select 'Setup Thermal Printers' from the 'File' menu option.
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5. Select 'Add' on the 'Thermal Printers' form. The 'Add a new Thermal Printer' form should appear.
6. Follow the steps as outlined on the 'Add Thermal Printers Wizard' form.
7. Once you have completed the wizard, go to the 'Printer Setup' on the Page Setup form to configure the thermal printer.
Directly to a Port
This option does not require any drivers to be installed on the PC. The PC's serial (COM) or LPT ports are accessed directly by Wasp Labeler. Since Windows is not spooling the print job, you will not be able to continue working with Wasp Labeler while the labels are printing.
Note: Caution needs to be taken to ensure that other applications are not also accessing this port simultaneously, and that the correct settings (e.g. baud, parity, etc.) are set in your Windows operating system. Please consult with your printer manufacturer's documentation.
File
This option redirects the print job's output to an ASCII text file. This file can be sent directly to a printer, edited, etc. as needed. You do not need to have a printer connected to your PC to use this option.
 XE "Width " \* MERGEFORMAT 

 XE "Total Memory " \* MERGEFORMAT 

 XE "Top " \* MERGEFORMAT 

 XE "Time " \* MERGEFORMAT 

 XE "Thermal Transfer " \* MERGEFORMAT 

 XE "Thermal Printers " \* MERGEFORMAT 

 XE "Text File " \* MERGEFORMAT 

 XE "Text " \* MERGEFORMAT 

 XE "Static " \* MERGEFORMAT 

 XE "Settings Tab " \* MERGEFORMAT 

 XE "Send " \* MERGEFORMAT 

 XE "Restore Defaults " \* MERGEFORMAT 

 XE "Rectangle " \* MERGEFORMAT 

 XE "Properties " \* MERGEFORMAT 

 XE "Printer Setup " \* MERGEFORMAT 

 XE "Printer " \* MERGEFORMAT 

 XE "Print spooler " \* MERGEFORMAT 

 XE "Print Speed " \* MERGEFORMAT 

 XE "Print Direction " \* MERGEFORMAT 

 XE "Print Density " \* MERGEFORMAT 

 XE "Print " \* MERGEFORMAT 

 XE "Port Settings " \* MERGEFORMAT 

 XE "PDF417 " \* MERGEFORMAT 

 XE "Orientation " \* MERGEFORMAT 

 XE "Options Tab " \* MERGEFORMAT 

 XE "Offset " \* MERGEFORMAT 

 XE "MSI " \* MERGEFORMAT 

 XE "Mode " \* MERGEFORMAT 

 XE "Memory Settings " \* MERGEFORMAT 

 XE "Measure " \* MERGEFORMAT 

 XE "MaxiCode " \* MERGEFORMAT 

 XE "LPT " \* MERGEFORMAT 

 XE "Line " \* MERGEFORMAT 

 XE "Label Stock Width " \* MERGEFORMAT 

 XE "Label Stock Height " \* MERGEFORMAT 

 XE "Label Size " \* MERGEFORMAT 

 XE "Input " \* MERGEFORMAT 

 XE "Graphics " \* MERGEFORMAT 

 XE "Generic/Text Only " \* MERGEFORMAT 

 XE "Gap Length " \* MERGEFORMAT 

 XE "Form Backup " \* MERGEFORMAT 

 XE "Fore Color " \* MERGEFORMAT 

 XE "Fill Styles " \* MERGEFORMAT 

 XE "Fill Color " \* MERGEFORMAT 

 XE "EPL2 " \* MERGEFORMAT 

 XE "EPL Printer Setup " \* MERGEFORMAT 

 XE "EPL " \* MERGEFORMAT 

 XE "Eltron LP " \* MERGEFORMAT 

 XE "Eltron " \* MERGEFORMAT 

 XE "Ellipse " \* MERGEFORMAT 

 XE "Driver needs " \* MERGEFORMAT 

 XE "Driver " \* MERGEFORMAT 

 XE "DPM " \* MERGEFORMAT 

 XE "DPI " \* MERGEFORMAT 

 XE "Dots Per Millimeter " \* MERGEFORMAT 

 XE "Dots Per Inch " \* MERGEFORMAT 

 XE "Default button " \* MERGEFORMAT 

 XE "Data Matrix " \* MERGEFORMAT 

 XE "Custom Tab " \* MERGEFORMAT 

 XE "COM " \* MERGEFORMAT 

 XE "Bitmap " \* MERGEFORMAT 

 XE "Bar Codes " \* MERGEFORMAT 

 XE "ASCII " \* MERGEFORMAT 

 XE "Align " \* MERGEFORMAT EPL Printer Setup

[image: image280.png]T ]

Priter Preview

Hame: £l

EFL2- ot \networkipiiter

Selwp

Non Windows Printer Setfings-

Native Language - EFL2
Pt label: As Objects
Ofentalion: Porlait

Label Stook Width: =1 (inches)
Label Stock Height: = 1 [inches)
Horizontal esolufon (do) = 203
Vertcal esohtion- (dpi = 203

x|

Select pinter Unis: nches





Note: The EPL Printer Setup option is only available with the Thermal Printer version of the Wasp Labeler.
The printer properties for EPL2 (Eltron Printer Language) are accessible on the Page Setup form by clicking the printer 'Setup' button on the 'Printer Setup' tab. A EPL thermal printer must be selected in order to modify any EPL printer properties. Note: A EPL thermal printer can be added to the Printer pull down list from the File/Setup Thermal Printer menu option. See the Thermal Printers topic for further information regarding installing and configuring non-Windows printers.
The following is a description of EPL printer properties:
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Settings Tab
Maximum number of Copies - This option defines the maximum number of copies a printer can generate internally. If the user requests more copies of a label than the printer can directly support, Wasp Labeler will automatically spool multiple print jobs. Please review your printer manufacturer's documentation for this number.
Resolution - This option provides the printer's resolution in Dots Per Inch (DPI). Most thermal and thermal transfer printers support either 203 DPI or 300 DPI. For example, a Eltron LP+ printer has a 203 DPI resolution. If your printer is specified in Dots Per Millimeter (DPM), multiply that number by 25.4 to obtain the DPI resolution.
Label Stock Width: - The width of each label is displayed in inches. This option should match the label stock loaded into your printer. IMPORTANT: Update this input field when changing labels, otherwise, damage to the printhead is possible.
Label Stock Height: - The height of each label is displayed in inches. This option should match the label stock loaded into your printer. IMPORTANT: Update this input field when changing labels, otherwise, damage to the printhead is possible. Note: You may also need to re-calibrate the printer's gap sensor for your labels so that they are properly aligned. Please review your printer manufacturer's documentation for these instructions.
Set Form Length (through sensor): This option is used to set the form and gap length when using the through sensor.
Gap Length: This option sets the number of measured dots between labels. Please review your printer manufacturer's documentation for more information.
Set Form Length (via black line): This option is used to detect the height of the black line length when using black line sensing.
Height of black line: This option sets the number of measured dots between labels by sensing a "black line" between the labels that is preprinted on the adhesive backing. Please review your printer manufacturer's documentation for more information.
Optional offset length: This option sets the number of measured dots to offset the 'Gap Length' and "Height of black line'. This option is commonly used with butterfly labels since the outer diameter of the label is greater than the inner diameter. Please review your printer manufacturer's documentation for more information.
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'Memory Settings' button: This option is used to allocate or partition the printer memory.
Total Memory: This option defines the total memory available internal to the printer. The default is 128KB of memory. Since the printer cannot be queried to provide this information, this input field must be manually edited if additional memory is added to the printer. If you are unsure of the 'Total Memory' of your Eltron printer, use the 'Print Configuration' button to dump the configuration to the printer. Please review your printer manufacturer's documentation for more information.
Image: This option defines the buffer size of where the active print image (i.e. label size) is temporarily stored. A recommended value for this option is automatically calculated by Wasp Labeler, but the value can be overridden. Please review your printer manufacturer's documentation for more information.
Forms: This option defines the buffer size of the permanent storage for label forms. A recommended value for this option is automatically calculated by Wasp Labeler, but the value can be overridden. Please review your printer manufacturer's documentation for more information.
Graphics: This option defines the buffer size of the permanent storage for the label graphics. A recommended value for this option is automatically calculated by Wasp Labeler, but the value can be overridden. Note: If the value is overridden, use the lower bound identified on the form if at all possible and incrementally increase the value to determine your best performance with your particular label that is being printed. Please review your printer manufacturer's documentation for more information.
'Print Configuration' button: This option sends a command to the Eltron printer to dump out and print the configuration.
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Custom Tab
Print Job: This option optimizes the thermal printer's performance for printing graphic and bar code objects.
As Objects: In general, certain features of the Labeler exceed the capabilities of the EPL2 language. Therefore, some features of the Labeler are not supported when printing EPL2. The Labeler prints EPL2 when a EPL2 Thermal Printer is connected through the Labeler and the label is printed "As Objects" rather than "As Image". Due to the limitations in the EPL2 language, the Labeler provides an "As Image" method for printing labels directly to a Eltron printer. This mode digitizes the entire label and sends it as a bitmap image to the printer. This allows printing of ellipses, shading, diagonal lines etc. Print speed is slightly slower than in "As Objects" mode, where the label is sent via EPL2 commands.
This is the fastest way to print the most common labels. Select this option if your label only uses the Wasp Labeler features supported by the printer's native language (e.g. EPL2 for a Eltron label printers). For small bar codes, especially on low-resolution printers, this option will result in the sharpest bar code, since the printer is optimizing the lines and spaces for its resolution. Since the printer is calculating the bar code spacings, placement and total size may vary slightly from that shown on Wasp Labeler's screen.)
Note: EPL2 does not support many of the properties of rectangles such as Draw Mode, Draw Style, Fill Style, Fill Color, and Fore Color. The Labeler will ignore these properties when printing EPL2.
Note: EPL2 does not support ellipses or circles. The Labeler will display a warning message to the user at the beginning of a print job notifying him that the ellipses will not be printed.
Note: EPL2 does not support MaxiCode modes 4, 5, or 6. It only supports modes 2 and 3. The Labeler will display an error message and will not print the MaxiCode bar code.
Note: EPL2 does not support rotation of MaxiCode bar codes. The Labeler will display a warning and print the MaxiCode bar code at zero degrees.
Note: EPL2 does not support MSI bar codes. The Labeler will display an error message and not print the MSI bar code.
Note: EPL2 does not correctly support PDF417 bar codes with truncation. The Labeler will print the PDF417 bar code without truncation.
Note: EPL2 does not support the showing of the check digit in the caption characters for the Code39 bar code symbology.
Note: EPL2 does not support the capability to not show the start and stop characters within the caption for the Codabar bar code symbology. EPL2 will always print the Codabar start and stop characters in the caption.
Note: EPL2 does not support the check digit capability for the Codabar bar code symbology. EPL2 will always print Codabar bar codes without a check digit.
Note: EPL2 does not support Data Matrix symbols. Wasp Labeler will display a warning message and not print the Data Matrix symbol.
As an Image: This is the most flexible way to print your labels. Wasp Labeler generates the image to be printed, and sends it to the printer in its native format. Print speed may be reduced with this method since a bitmap image of the entire label is transferred to the printer as compared to a few native commands. A decrease in performance will be more noticeable with large labels and also with serial printers. (Note: Parallel printers usually will perform faster than serial printers.) Copies of "static" labels (i.e. objects that do not change on the labels), however, will print at the printer's maximum speed.

Printer Orientation: The option selects the direction of print relative to the paper path of the printer. Both Portrait and Landscape orientations are supported when 'Print Job As an Image' is selected.
Print Direction: This option configures the print orientation to print 'Rightside Up' or 'Upside Down'. Please review your printer manufacturer's documentation for more information.
Print Density: This option controls the amount of heat produced by the print head. More heat will product a darker image. Note: The 'Print Density' and 'Print Speed' options can dramatically effect print quality. Changes in the speed setting typically require a change to the 'Print Density'. Please review your printer manufacturer's documentation for more information. Note: If the bar code is rotated (e.g. 90 or 270 degrees), the bar code may print at a different density.
Error reporting: This option enables the printer's status reporting feature. The 'Error Descriptions' button displays a list of error codes and corresponding error descriptions. If turned on, the printer will print the error number when any errors occur. Please review your printer manufacturer's documentation for more information regarding clearing the errors.
Top of Form Backup: This option is used to slightly roll forward a printed label in order that the label can be peeled off more easily.
'Restore Defaults' button: This option restores the default settings for the EPL printer properties.
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Device Options Tab
Direct to Port: This option sends the print job directly to the PC's serial (COM) or LPT ports and does not require any printer drivers to be installed on the PC. Since Windows is not spooling the print job, you will not be able to continue working with Wasp Labeler while the labels are printing. Note: Caution needs to be taken to ensure that other applications are not also accessing this port simultaneously, and that the correct settings (e.g. baud, parity, etc.) are set in your Windows operating system. These can be set using the 'Port Settings' button. Please consult with your printer manufacturer's documentation.
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Windows print spooler: This option sends the print job to the Windows spooler and provides the best performance since Windows can automatically spool the print jobs so that you can continue using Wasp Labeler or other Windows applications while your labels are printing. Since Wasp Labeler does not use a Windows driver specific to your printer in this mode, a "Generic/Text Only" driver needs to be loaded. This driver comes standard with Windows, and can be installed from your Windows CD or floppy disks. See the Thermal Printers topic for installing a "Generic/Text Only" printer driver. Note: Even though this option requires a "Generic/Text Only" printer driver, Wasp Labeler will send the printer's proprietary language to achieve maximum performance of the printer while at the same time using the print spooling capabilities of Windows.

This option also supports printing over your network. For example, you can print from your desk to a printer in the warehouse if a "Generic/Text Only" driver exists on the warehouse PC and is shared on your network.
File: This option redirects the print job's output to an ASCII text file. This file can be sent directly to a printer, edited, etc. as needed. You do not need to have a printer connected to your PC to use this option.
 XE "WPL " \* MERGEFORMAT 

 XE "Printing " \* MERGEFORMAT 

 XE "Printer Setup " \* MERGEFORMAT 

 XE "Printer " \* MERGEFORMAT WPL Printer Setup
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The printer properties for WPL  are accessible on the Page Setup form by clicking the printer Setup button on the Printer Setup tab. A WPL thermal printer must be selected in order to modify any WPL printer properties.

Note: A WPL thermal printer can be added to the Printer pull down list from the File/Setup Thermal Printer menu option. See the Thermal Printers topic for further information regarding installing and configuring non-Windows printers.

The following is a description of WPL printer properties:
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Custom Tab

Print Label: This option optimizes the thermal printer's performance for printing graphic and bar code objects.

Print Density: Determines the darkness of the print. The higher the number, the darker the print.

Print Speed: Determines the print speed. Measured in inches per second (IPS).

Print Direction: Determines the direction in which the label will print - right-side up or upside-down.

Label Width: The width of each label is displayed in inches. This option should match the label stock loaded into your printer. IMPORTANT: Update this input field when changing labels; otherwise, damage to the printhead is possible.

Label Height: The height of each label is displayed in inches. This option should match the label stock loaded into your printer. IMPORTANT: Update this input field when changing labels; otherwise, damage to the printhead is possible. Note: You may also need to re-calibrate the printer's gap sensor for your labels so that they are properly aligned. Please review your printer's manufacturer's documentation for these instructions.

Use Printer's Native Fonts for Text Printing: Normally, Labeler sends a bitmap of the label caption to the printer. If you need to print the label more quickly, you can choose this option which causes the printer to use the printer's default font when printing the label. Note: When using this option, fonts may not print out the same as they appear on the screen. 
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Device Options Tab

Direct to Port: This option sends the print job directly to the PC's serial (COM) or LPT ports and does not require any printer drivers to be installed on the PC. Since Windows is not spooling the print job, you will not be able to continue working with Wasp Labeler while the labels are printing. Note: Caution needs to be taken to ensure that other applications are not also accessing this port simultaneously, and that the correct settings for the COM port (e.g. baud, parity, etc.) are set in your Windows operating system. These can be set using the Port Settings button. Please consult with your printer manufacturer's documentation.

Windows Print Spooler: This option sends the print job to the Windows spooler and provides the best performance since Windows can automatically spool the print jobs so that you can continue using Wasp Labeler or other Windows applications while your labels are printing. Since Wasp Labeler does not use a Windows driver specific to your printer in this mode, a "Generic/Text Only" driver needs to be loaded. This driver comes standard with Windows, and can be installed from your Windows CD or floppy disks. See the Thermal Printers topic for installing a "Generic/Text Only" printer driver.
Note: Even though this option requires a "Generic/Text Only" printer driver, Wasp Labeler will send the printer's proprietary language to achieve maximum performance of the printer while at the same time using the print spooling capabilities of Windows.
File: This option redirects the print job's output to an ASCII text file. This file can be sent directly to a printer, edited, etc. as needed. You do not need to have a printer connected to your PC to use this option.
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Note: The ZPL Printer Setup option is only available with the Thermal Printer version of the Wasp Labeler.

The printer properties for ZPL (Zebra Printer Language) are accessible on the Page Setup form by clicking the printer Setup button on the Printer Setup tab. A ZPL thermal printer must be selected in order to modify any ZPL printer properties.

Note: A ZPL thermal printer can be added to the Printer pull down list from the File/Setup Thermal Printer menu option. See the Thermal Printers topic for further information regarding installing and configuring non-Windows printers.

The following is a description of ZPL printer properties:
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Settings Tab
Resolution - This option provides the printer's resolution in Dots Per Inch (DPI). Most thermal and thermal transfer printers support either 203 DPI or 300 DPI. For example, a Zebra Stripe 500 printer has a 203 DPI resolution. If your printer is specified in Dots Per Millimeter (DPM), multiply that number by 25.4 to obtain the DPI resolution.
Label Stock Width: - The width of each label is displayed in inches. This option should match the label stock loaded into your printer. IMPORTANT: Update this input field when changing labels, otherwise, damage to the printhead is possible.
Label Stock Height: - The height of each label is displayed in inches. This option should match the label stock loaded into your printer. IMPORTANT: Update this input field when changing labels, otherwise, damage to the printhead is possible. Note: You may also need to re-calibrate the printer's gap sensor for your labels so that they are properly aligned. Please review your printer manufacturer's documentation for these instructions.
Maximum number of Copies - This option defines the maximum number of copies a printer can generate internally. If the user requests more copies of a label than the printer can directly support, Wasp Labeler will automatically spool multiple print jobs.
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Custom Tab
Print Label: This option optimizes the thermal printer's performance for printing graphic and bar code objects.
As Objects: In general, certain features of the Labeler exceed the capabilities of the ZPLII language. Therefore, some features of the Labeler are not supported when printing ZPLII. The Labeler prints ZPLII when a ZPLII Thermal Printer is connected through the Labeler and the label is printed "As Objects" rather than "As Image". Due to the limitations in the ZPLII language, the Labeler provides an "As Image" method for printing labels directly to a Zebra printer. This mode digitizes the entire label and sends it as a bitmap image to the printer. This allows printing of ellipses, shading, diagonal lines, etc. Print speed is slightly slower than in "As Objects" mode, where the label is sent via ZPLII commands.
"As Objects" is the fastest way to print the most common labels. Select this option if your label only uses the Wasp Labeler features supported by the printer's native language (e.g. ZPLII for a Zebra label printers). For small bar codes, especially on low-resolution printers, this option will result in the sharpest bar code, since the printer is optimizing the lines and spaces for its resolution. Since the printer is calculating the bar code spacings, placement and total size may vary slightly from that shown on Wasp Labeler's screen.)
Note: ZPLII does not support all ASCII characters in the secondary message for MaxiCode. ZPLII only supports the following: A-Z,0-9, @%"[&\,](_)*!+'#-$./:;<=>? (space) Lower case letters and some punctuation characters such as the tilde (~) are not supported. The Labeler will replace any invalid characters with a space.
Note: ZPLII does not support many of the properties of rectangles and lines such as Draw Mode, Draw Style, Fill Style, Fill Color, and Fore Color. The Labeler will ignore these properties when printing ZPLII.
Note: ZPLII does not support ellipses (circles). The Labeler will display a warning message to the user at the beginning of a print job notifying him that the ellipses will not be printed.
Note: ZPLII does not support Data Matrix symbols. Wasp Labeler will display a warning message and not print the Data Matrix symbol.
As an Image: This is the most flexible way to print your labels. Wasp Labeler generates the image to be printed, and sends it to the printer in its native format. Print speed may be reduced with this method since a bitmap image of the entire label is transferred to the printer as compared to a few native commands. A decrease in performance will be more noticeable with large labels and also with serial printers. (Note: Parallel printers usually will perform faster than serial printers.) Copies of "static" labels (i.e. objects that do not change on the labels), however, will print at the printer's maximum speed.

Printer Orientation: The option selects the direction of print relative to the paper path of the printer. Both Portrait and Landscape orientations are supported.
User Setup String - Many ZPL printers support commands to set the print darkness, print speed, reverse image printing, etc. for each print job. You can customize a 'User Setup String'. These commands can be found in your manufacturer's printer manual. This string is sent to the printer prior to each batch of labels printed.
'Restore Defaults' button: This option restores the default settings for the ZPL printer properties.
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Device Options Tab
Direct to Port: This option sends the print job directly to the PC's serial (COM) or LPT ports and does not require any printer drivers to be installed on the PC. Since Windows is not spooling the print job, you will not be able to continue working with Wasp Labeler while the labels are printing. Note: Caution needs to be taken to ensure that other applications are not also accessing this port simultaneously, and that the correct settings (e.g. baud, parity, etc.) are set in your Windows operating system. These can be set using the 'Port Settings' button. Please consult with your printer manufacturer's documentation.
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Windows print spooler: This option sends the print job to the Windows spooler and provides the best performance since Windows can automatically spool the print jobs so that you can continue using Wasp Labeler or other Windows applications while your labels are printing. Since Wasp Labeler does not use a Windows driver specific to your printer in this mode, a "Generic/Text Only" driver needs to be loaded. This driver comes standard with Windows, and can be installed from your Windows CD or floppy disks. See the Thermal Printers topic for installing a "Generic/Text Only" printer driver. Note: Even though this option requires a "Generic/Text Only" printer driver, Wasp Labeler will send the printer's proprietary language to achieve maximum performance of the printer while at the same time using the print spooling capabilities of Windows.

This option also supports printing over your network. For example, you can print from your desk to a printer in the warehouse if a "Generic/Text Only" driver exists on the warehouse PC and is shared on your network.
File: This option redirects the print job's output to an ASCII text file. This file can be sent directly to a printer, edited, etc. as needed. You do not need to have a printer connected to your PC to use this option.
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